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Introduction to OLI Studio 
 1997-2023 OLI Systems, Inc. 

The enclosed materials are provided to the lessees, selected individuals and agents of OLI Systems, Inc. The 
material may not be duplicated or otherwise provided to any entity without the expressed permission of OLI 
Systems, Inc. 

 

Version: OLI Studio V11.5 

 

 

 

 

Contact Information 
Visit the Contact OLI Systems page at https://www.olisystems.com/techsupport to submit general inquiries, 
contact Technical Support, or search for an address and phone number. 

 

If you need to contact Support, you can submit an online request via OLI Portal: https://portal.olisystems.com/ 

 

Other useful links and resources are:  

OLI Systems Portal – How to create and account: https://info.olisystems.com/portal-instructions 
Product Downloads: http://downloads.olisystems.com/  
OLI Systems YouTube Channel: https://www.youtube.com/OLISystems 
OLI Systems Wiki page: http://wiki.olisystems.com/wiki/Main_Page  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Disclaimer 
This manual was produced using the OLI Studio 11.5.1 build 5 (11.5.1.5). As time progresses, new data and 
refinements to existing data sets can result in values that you obtain being slightly different than what is 
presented in this manual. This is a natural progress and cannot be avoided. When large systematic changes 
to the software occur, this manual will be updated.  
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About This Manual 

This manual will provide an introductory guide for new OLI Studio Software users. OLI Studio is a software suite 
containing several modules including Stream Analyzer, think simulation | getting the chemistry right and 
Corrosion Analyzer. A client’s license determines which modules are enabled within the OLI Studio Software. 

This introductory manual consists of one chapter showcasing the OLI Studio User Interface, and four main 
chapters showcasing the three main modules of OLI Studio: Stream Analyzer, Corrosion Analyzer, EVS 
Analyzer, and think simulation | getting the chemistry right. 

If you have not yet installed the software, please install it following the instructions given in the Installation and 
Security page on our Wiki page at: http://wiki.olisystems.com/wiki/Installation_and_security. 

 

OLI Studio Components 
 

Stream Analyzer 

Stream Analyzer is standalone software, and it is the main interface of the OLI Studio. Stream Analyzer is a 
comprehensive thermodynamic tool that calculates speciation, phase equilibria, enthalpies, heat capacities and 
densities in mixed-solvent, multicomponent systems. Capabilities and features of Stream Analyzer are: 

Three different thermodynamic frameworks:  
Mixed Solvent Electrolyte (MSE) model (Default) 
Aqueous (AQ) model 
Mixed Solvent Electrolyte and Soave-Redlich-Kwong (MSE-SRK) model 

 
Thermophysical properties: Stream Analyzer has thermophysical models to predict surface tension, interfacial 
tension, viscosity, electrical conductivity, thermal conductivity, diffusivity, and osmotic pressure. 

 
Molecular and ionic inflows: Stream Analyzer accepts molecular inflows, typical of a process stream, and ion 
inflows, typical of a sample water analysis. 

 

Corrosion Analyzer                   

Corrosion Analyzer is a module within the OLI Studio. A separate license enables this module. Corrosion 
Analyzer is a first-principles corrosion prediction tool. It is used to predict the corrosion rates of general 
corrosion, propensity of alloys to undergo localized corrosion, depletion profiles of heat-treated alloys, and 
thermodynamic stability of metals and alloys. It enables users to address the causes of aqueous corrosion by 
identifying its mechanistic reasons. As a result, users take informed action on how to mitigate or eliminate this 
risk.   

Corrosion Analyzer calculates corrosion by quantifying the bulk chemistry, transport phenomena, and surface 
reactions through a thermophysical and electrochemical module. 
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The thermophysical module calculates the aqueous solution speciation and obtains concentrations, activities 
and transport properties of the reacting species.  
The electrochemical module simulates partial oxidation and reduction process on the metal surface.  

The tool reproduces the active-to-passive transition and the effects of solution species on passivity. 

Effects of temperatures, pressure, pH, concentration, and velocity on corrosion are also included. Capabilities 
and features of Corrosion Analyzer are: 

Generation of Pourbaix (E vs pH) diagrams 

Calculation of general corrosion rates  

Localized corrosion susceptibility 

Heat treatment effect 

Generation of polarization curves plots 

 

EVS Analyzer                    

Extreme value statistics (EVS) is a powerful statistical techniques that is used extensively to extrapolate 
damage (maximum pit depth) from small samples in the laboratory to larger area samples in the field. 

 

think simulation | getting the chemistry right 

think simulation | getting the chemistry right is a simulation software tool that predicts scaling problems during 
oil and gas production. think simulation | getting the chemistry right simulates fluid production from the reservoir 
to the sales point, and computes the phase mass balance, scale tendencies, scale mass, and nucleation 
induction times in production fluid at each location in the production line. Capabilities and features of think 
simulation | getting the chemistry right are: 

Brine, gas and oil analysis 

Scaling scenarios 

Compatibility testing of brines using the stream mixing function 

Phase equilibrium calculation for four-phase reservoir saturation, from which as whole fluid reservoir 

composition is determined 

Contour plots to study produced brine properties across a broad temperature and pressure range 
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Chapter I – The OLI Studio Software User Interface 

General View of the User Interface 

The OLI Studio Desktop User Interface provides the environment to create, analyze and interpret the results of 
your application chemistry. In this manual, an overview of the different windows and tools that you will use, as 
well as how to navigate the OLI Studio User Interface, will be provided here.  

 

The screenshot shown above is what you will see when you first start OLI Studio. You can customize the 
desktop to your own needs. The windows can be resized, moved, docked, and detached. 

 

Menu Bar 

The Menu Bar gives access to the following options: File, Edit, Streams, Calculations, Chemistry, Tools, View, 
Window and Help. 

File: Gives access to functionality such as New, Open, Close, and Save a file 

Edit: Cut, Copy, Paste, Delete and Clear calculation results 

Stream: The Streams menu contains actions that can also be performed using the Actions Pane 

Calculations: The calculation menu contains all the calculations found in the Actions Pane 

Chemistry: Advanced changes to the chemistry can be made here.  
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Tools: Gives access to tools such as component search, names manager, units manager and other 
customizations.  

View: Gives the option to customize the view of the interface.  

Window: Allows to arrange the different OLI Studio.  documents in the window.  

Help: Here you can have access to Technical Support or any content that you may need related to OLI 
Software.  

 

Tool Bar 

The Tool Bar gives quick access to different functions and sits below the Menu Bar. Tools within this bar can 
be added, removed or repositioned. When a tool is selected (or turned ON) it is highlighted in light blue. When 
deselected (or turned OFF) it comes back to gray. 

 

They are laid out in the following order: 

Quick access to File:  

Quick access to Edit:  

Quick access to Help:  

Quick access to Chemistry:   

Quick access to Tools:  

 

Icons in the Chemistry section 

In the quick access to Chemistry, you find: Phases, Redox and Databanks.  

Phases: Turns ON/OFF specific phases. Four different phases are available:  

L1: Liquid 1 or water-rich phase 

Va: Vapor phase 
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So: Solid phase 

L2: Usually organic rich phase and sometimes a critical fluid. It is also referred to as Liquid 2 phase. 

Redox: Denoted as Re. Turns ON/OFF Reduction/Oxidation (REDOX) reactions. 

Databanks: Turn ON/OFF a specific thermodynamic databank. There are three thermodynamic databanks 
available: 

 MSE: Mixed Solvent Electrolyte databank (Default) 

 MSE-SRK: Mixed Solvent Electrolyte and Soave-Redlich-Kwong databank 

AQ: Aqueous databank 

 

 

Icons in the Tools section 

A description of each icon in the Tools section is given below: 

Component search:  
 

This tool helps you to look for a component using Formula, CAS number, 
chemical name or using the periodic table. 

 

Names manager: 
 

This tool shows you the name of components in different styles in tables 
and reports. The style options are: Display name, Formula or OLI Name.  

 

Units manager: 
 

This tool allows you to select or change to preferred units for all 
calculations.  

 

Customize toolbars: 
 

This tool allows you to remove or add preferred tools to the Tool Bar. For 
example, you can add or remove Chemistry from the Tool Bar. 

 

General options: 
 

This tool allows you to adjust or change default software settings. 

 

Calculation options: 
 

This tools allows you to include or exclude different types of properties into 
the calculations. 
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Navigator Pane 

The Navigator Pane (or tree level) contains the list of streams and calculations that are active within a file. This 
view contains the icons and names of each action in a hierarchical tree. The Description/Definition pane 
changes depending on the level that is highlighted. A plus sign next to an object in the stream level indicates 
that that stream or object has sub-streams or branches. There are four levels: Global Stream Level, Stream 
Level, Calculation Level, and Calculation Sublevel.  

Global Stream Level: Provides the broadest view of the navigator objects. At this level the user can define 
default units, default components name, and general preferred calculation options for the working file.  

Stream Level: Chemistry options such as phase selection, REDOX reactions, and the thermodynamic 
databanks can be selected as this level. 

Calculation Level: Calculation types such as Single point calculations, Survey calculations, etc., are 
subordinate to streams, and appear in this level. A more detailed explanation of calculation types can be found 
in Chapter II of this manual. 

Calculation Sublevel: Some calculations, such as Survey calculations, have their own calculation sublevels. 
They can be expanded or maximized using the small icon (  or ) next to the calculation type.  

 

Note: A star (*) next to the file name indicates that the file has not been saved. 
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Actions Pane 

This view contains selectable action icons. Each icon represents either a new stream input or new calculation. 
Additional actions will appear depending on what kind of stream we are working with. You can change the view 
of the actions pane by right clicking in the white area. You can show the icons as a List, Small Icons or Large 
Icons. In this case the List option was selected. 

When located at the Global 
Stream Level the following 
action icons appear on the 
Actions Pane. 

 

If you select an action item that 
belongs to Corrosion Analyzer, 
this action item will be located at 
the Stream Level, and only the 
following action icons appear on 
the Actions Pane.  

 

If you select an action item that 
belongs to think simulation | 
getting the chemistry right, this 
action item will be located at the 
Stream Level, and only the 
following action icons appear on 
the Actions pane. 

 

Plot Template Manager 

The default location for the Plot Template Manager 
is in the lower left-hand corner of the main window. 
The Plot Template Manager is a tool that allows the 
user to create, save and use plot templates. This 
tool allows a fast plotting and analysis of the user’s 
results.  
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Description / Definition Pane 

Users work most of the time on the Description / Definition area, which changes depending on which action 
object is being used.  

 

Summary Pane 

The Summary Pane can be viewed in both the Description and Definition Tabs. The Summary Pane shows 
inputs, calculation outputs, warnings, and has hyperlinks to the Units and Databank Managers. This window 
varies with object. 
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Calculation Status Output 

The Calculation Status Output window shows progress, errors, warnings, temporary file locations, and other 
data.  

 

 

Thermodynamic Frameworks and their Databases 

You can access the databanks from the Menu Bar: Chemistry > Model Options… or via the quick access from 
the Tool Bar.  

There are three main thermodynamic frameworks in OLI Studio.  The user can pick the thermodynamic 
framework that is more suitable for their chemistry. These are the AQ (Aqueous), the MSE (Mixed Solvent 
Electrolyte), and the MSE-SRK (Mixed Solvent Electrolyte – Soave Redlich-Kwong) Thermodynamic 
Frameworks. A more detailed description of each framework is given below: 

Aqueous (AQ) Thermodynamic Framework 

The OLI Aqueous (AQ) thermodynamic framework is a mature electrolyte activity coefficient model that predicts 
the properties of solutions up to 30 molal ionic strength. Its accompanying database contains 6,000 species for 
80+ elements (metals and non-metals) across multiple oxidation states.  

This AQ framework is suitable for applications involving electrolytes, gases and hydrocarbons dissolved in 
water. 

The AQ framework utilizes the Bromley-Zemaitis activity model: 

log 𝛾േ ൌ െ
𝐴|𝑍ା𝑍ି|√𝐼

1 ൅ √𝐼
൅
ሺ0.06 ൅ 0.6𝐵ሻ|𝑍ା𝑍ି|√𝐼

൬1 ൅
1.5

|𝑍ା𝑍ି| 𝐼൰
ଶ ൅ 𝐵𝐼 ൅ 𝐶𝐼ଶ ൅ 𝐷𝐼ଷ 

The model can produce valid results in the following ranges: 

Temperature  -50◦C to 300⁰C 
Pressure  0 – 1500 bar 
Ionic Strength  0 – 30 molal 
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The AQ-framework selects the PUBLIC1 database by default. Frequently there is more to the chemistry than 
what is covered in the PUBLIC database. The following is a partial list of additional databases available in the 
AQ framework:  

Aqueous (H+ ion) – Public Database and selected by default 
Geochemical (AQ) 
Ceramics (AQ) 
Corrosion (AQ) 
Low Temperature (AQ) 
Alloys (AQ) 
Ion Exchange (AQ) 
Surface Complexation Double Layer Model (AQ) 

Mixed Solvent Electrolyte (MSE) Thermodynamic Framework 

A system’s thermodynamic properties are calculated from two sources; the first is from the Temperature and 

Pressure dependent standard-state Gibbs energies (i.e., 𝐺పഥ
଴ሺ𝑇,𝑃ሻ ) of each species present. The second is 

from the temperature, pressure and composition dependent excess Gibbs energy ሺ𝑖. 𝑒. , 𝛾௜ሺ𝑚,𝑇ሻሻ for each 
species present. In the combined relationship, the partial molal Gibbs energy of the 𝑖௧௛ species is, 𝐺పഥ ൌ 𝐺ప଴തതതത ൅
𝑅𝑇 ln𝑚௜𝛾௜, where 𝐺ప଴തതതത is the standard-state partial Gibbs energy and 𝛾௜ is the activity coefficient. This activity 
coefficient 𝛾௜, is computed using the MSE theory. A comprehensive explanation of the MSE theory is given in 
Wang et al. [7]. 

The MSE framework utilizes the MSE activity model which contains the extended Debye-Huckel term, that 
accounts for long-range interactions, an UNIQUAC term that accounts for short-range interactions, and a 
middle-range that includes the ionic interactions:  

log 𝛾௜ ൌ log 𝛾௜
ௌோ ൅ log 𝛾௜

ெோ ൅ log 𝛾௜
௅ோ 

The model can produce results for the following ranges: 

Temperature -50⁰C – to 90% Tcrit 
Pressure 0 – 1500 bar 
Ionic Strength no limit  

The MSE framework contains the following databanks: 

MSE (H3O+ ion) – Selected by default 
Corrosion (MSE) 
Geochemical (MSE) 
Urea (MSE) 
Surface Complexation Double Layer Model (MSE)  

 

 

1 The PUBLIC database is the main OLI database, containing nearly 70 percent of the thermodynamic data available from OLI and 100 
percent of the supporting information. 
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Mixed Solvent Electrolyte with Soave-Redlich-Kwong Equation of State (MSE-
SRK) Thermodynamic Framework  

The MSE-SRK model is based on the Mixed-Solvent Electrolyte (MSE) framework, which provides a very 
accurate representation of electrolyte systems in both aqueous and mixed-solvent (e.g., glycol-containing) 
environments. The MSE-SRK framework combines an equation of state for standard-state properties of 
individual species, an excess Gibbs energy model to account for solution non-ideality in the aqueous electrolyte 
phase, and the Soave-Redlich-Kwong equation of state (SRK EOS) to calculate the properties of the gas phase. 
The MSE-SRK framework, however, provides a different treatment of the non-electrolyte-rich second liquid 
phase for liquid-liquid equilibria. MSE-SRK assumes the second (usually organic-rich) liquid phase to be non-
ionic and reproduces its properties using the SRK EOS. This allows the MSE-SRK framework to reproduce the 
critical behavior of nonelectrolyte systems more easily.  

In the MSE-SRK model, the electrolyte-containing (usually aqueous) liquid phase is represented by a 
combination of the Helgeson-Kirkham-Flowers (HKF) equation of state for standard-state properties and the 
MSE activity coefficient model for solution nonideality. Accordingly, the chemical potential of a species 𝑖 in a 
liquid (electrolyte) phase is calculated as: 

𝜇௜
௅ ൌ 𝜇௜

௅,଴,௫ሺ𝑇,𝑃ሻ ൅ 𝑅𝑇 ln 𝑥௜𝛾௜
௫,∗ ሺ𝑇,𝑃, 𝑥ሻ     (1) 

where 𝜇௜
௅,଴,௫ሺ𝑇,𝑃ሻ                    is the standard-state chemical potential from the HKF theory [9], [10], 𝑥௜ is the 

mole fraction, and𝑥௜𝛾௜
௫,∗ሺ𝑇,𝑃, 𝑥ሻis the activity coefficient from the MSE theory of Wang et al. [7], which accounts 

for long-range electrostatic, specific ionic, and short-range intermolecular interactions. 

The second liquid phase is assumed to be non-ionic and is modeled using the Soave-Redlich-Kwong equation 
of state (SRK-EOS) [11]. The chemical potential in the non-ionic liquid phase is then calculated as: 

𝜇௜
ீ ൌ 𝜇௜

ீ,଴ሺ𝑇ሻ ൅ 𝑅𝑇 ln
௉௬೔ఝ೔ሺ்,௉,௬ሻ

௉బ
      (2) 

where 𝜇௜
ீ,଴ሺ𝑇ሻ is the chemical potential of pure component 𝑖 in the ideal gas state, 𝑦௜  is the mole fraction, 

𝜑௜ሺ𝑇,𝑃,𝑦ሻ is the fugacity coefficient from the SRK-EOS, 𝑃 is the total pressure, and 𝑃଴ ൌ 1 𝑎𝑡𝑚. 

The properties of the gas phase are also obtained from the SRK equation according to Equation (2). 

The MSE-SRK framework contains the following databanks: 

MSE (H3O+ ion) – Selected by default 
MSE-SRK (H3O+ ion) – Selected by default 
Corrosion (MSE) 
Geochemical (MSE) 
Urea (MSE) 
Surface Complexation Double Layer Model (MSE)  
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Component Search 

You can access the Component Search from the Menu Bar: Tools > Component Search… or via the quick 

access from the Tool Bar .  

Note: When using the Component Search tool, you should be aware that the tool will only show components 
in the database that you have selected. 

The Component Search option opens a new window where you can search for the component of interest by 
typing the component name or look up components using the Periodic Table option. In the periodic table option, 
you have 3 search options: 

Any of selected: Will show elements that you have selected 
All of selected  
Only selected  

     

In any of the two options for component search, you can click on the Add to Stream button to add the 
component in your chemistry. 
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Names Manager 

You can access the Names Manager from the Menu Bar: Tools > Names Manager… or via the quick access 

from the Tool Bar .  

The Names Manager option opens a new window where you can select the component name style. There are 
three different styles: 

Display name: This is the name that is commonly displayed when a species is entered. This is the default 

display. For example, Benzene, Cyclohexane, Sodium Chloride 

Formula: This is the chemical formula name. For example, C6H6, C6H12, NaCl 

OLI Name (TAG): This is the traditional name for the species stored internally in the OLI software. For example: 

BENZENE, CYCLOHEXAN, NACL (Note: These names are usually for OLI internal use). 

Additionally, you can select if you prefer the mineral name to appear after the solids. For example, NaCl (halite), 
KCl (sylvite), etc.  
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Units Manager 

You can access the Units Manager from the Menu Bar: Tools > Units Manager… or via the quick access from 

the Tool Bar .  

If you are changing units at the Global Stream Level, the Units Manager tool will open a new window where 
you can change the default units for the whole document. You can also select the default units of the different 
calculation objects.  

 

At the Stream Level, the Units Manager tool will open a slightly different window and will change the units only 
at the Stream Level and Calculation Level. 

 

The default units are Metric, Batch and Moles, but you can change to any of the following default options: 
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You can customize specific units, by clicking on the Customize… button. This will open a new window where 
you can customize composition units, parameters units, and corrosion units. You can also select units for a 
Batch system or a flowing system. 
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Another option to access the Units Manager tool is by clicking on the units highlighted in blue. This is a 
hyperlink to the Units Manager tool, and there you can make changes to the units. 

 

 

Customize Toolbars 

You can access the Customize Toolbars from the Menu Bar: Tools > Customize… or via the quick access 

from the Tool Bar . This will open a new window where you can disable or enable toolbars under Toolbars 
tab. 

Under the Commands tab, you can also add your preferred buttons in the tool bar. If you click on any of them, 
it will give you a description of the actions the selected button will perform.  
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Calculation Options 

You can access the Calculation Options from the Menu Bar: Tools > Options… or via the quick access from 

the Tool Bar . This will open a new window. Under the Calculation Options tab you can enable or disable 
the following options: 

General 

Allows you to disable or enable the status dialog (a popup window that appears after pressing the calculate 

button) 

Diagnostics 

Enable trace.  This is a file containing the detailed solver output.  It is generally used to diagnose why a 

calculation may have failed. 

Optional Properties 

Diffusivities, electrical conductivity, heat capacity, activities, fugacities, and K-values, Gibbs free energy, 

entropy, thermal conductivity, surface tension, interfacial tension, Total Dissolved Solids, Scaling Induction 

Time, and pre-scaling tendencies. 
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Object Library 

You can access the Object Library from the Menu Bar: View > Toolbars > Object Library.  

This option will create a new window (to the right). You can find commonly used objects like standard sea water, 
dry air, etc.  

My Objects – save your own objects, such as a commonly used stream. You can drag an object and save it 
here for your future use. 

 

Tip: If by accident we lose a tool bar, we can go to View > Toolbars >… and select the toolbar that is missing. 
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Chapter II – OLI Studio: Stream Analyzer 

For all calculations we will create one or more objects, referred to as a Streams, which are used to define a 
particular chemistry, temperature, and pressure.   

There are five different types of calculations that can be carried out in OLI Studio: Stream Analyzer: Single 
point, Survey (multiple point), Water Analysis, Mixer, and Chemical Diagram calculations. A brief definition of 
each type of calculation is given below. 

 

Add Stream is used to add a New Stream as a molecular input and define a specific 
chemistry. 

 

Single Point Calculations are used to find information (pH, volume, speciation, etc.) 
at one specific equilibrium state. 

 

Survey Calculations are useful for plotting changes in stream parameters against 
temperature, pressure, or composition. 

 

Water Analysis allows you to enter ionic inflows, i.e., allows you to enter anions and 
cations.  

 

Mixer Calculations are useful for mixing different streams. You will familiarize 
yourselves with its four different mixing options, Single Point Mix, Multiplier, Ratio, and 
Volume. 

 

Chemical Diagram Calculation allows you to create a stability map for species 
based on concentration and other parameters such as pH. A contour map is created 
showing the user where some solids are stable and where others are not. 

In this chapter several examples will be provided to cover all these calculation types.  
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Section 1. Single Point Calculations 

Single point calculations are the simplest set of calculations in the software. There are 13 different single-point 
calculation types, and a brief explanation of each single point calculation is provided below. 

 

 

Isothermal: The software computes solution properties based on a known chemical composition at a constant 

temperature and pressure. 

Isenthalpic: A constant enthalpychange (loss/gain) is specified, and temperature or pressure is adjusted to 

meet the heat requirements.  

Bubble Point: The temperature or pressure is adjusted to reach a condition where a small amount of vapor 

(bubble) begins to appear (a.k.a. boiling point). 

Dew Point: The temperature or pressure is adjusted to reach a condition where a small amount of aqueous 

liquid (dew) begins to appear. 

Vapor Amount: The temperature or pressure is adjusted to produce a user-specified amount (in moles) of 

vapor in the system. 
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Vapor Fraction: The temperature or pressure is adjusted to produce a user-specified amount of vapor as a 

fraction of the total quantity of moles in the system. 

Isochoric: The temperature or pressure is adjusted to produce the user-specified total volume (constant 

volume calculation). 

Set pH: The software adjusts the flowrate of an acid or base titrant to maintain an aqueous solution at a user-

specified pH.  

Precipitation Point: The software adjusts the flowrate of a species until a small amount of solid precipitates. 

This can also be interpreted as the solid’s solubility point. 

Composition Point: The composition point calculation is used to fix a species value. The software adjusts the 

flowrate of a species until it reaches the user - specified/fixed species value.   

Reconcile Alkalinity: The software calculates or reconciles the alkalinity of a solution. There are several 

reconciliation types within this option: Reconcile pH, Reconcile Alkalinity and pH, and Reconcile Alkalinity, pH 

and TIC. 

Autoclave: The software simulates a constant volume vessel (autoclave) in which mass, pressure and 

temperature are allowed to vary in order to reach a user-specified mole fraction or partial pressure of key gases 

in the vapor phase.  

Custom: With the calculations stated so far, variables are predefined. For instance, we must select either 

temperature or pressure as a variable in the dew point calculation. With Custom single point calculations, we 

can manipulate a wider variety of variables; for example, you can set up a custom calculation to determine the 

solubility of a gas in solution. 

In this section, we will learn how to set up each one of these single point calculations, and will also introduce 
how to use custom units, the names manager, modify the report, and other useful tips to get the most out of 
your simulation results.  
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Isothermal 

The default and most basic single point calculation is the Isothermal calculation. The software computes 
solution properties based on a known composition, pressure, and temperature.  

Example 1: Speciation and its importance for pH calculations 

After completing this example, you will learn how to set up an Isothermal calculation and will also get a better 
understanding of the importance of full speciation on the calculation of pH. Let’s calculate the pH of a 1 m FeCl3 
solution at 25 ⁰C and 1 atm. 

Starting the Simulation 

To start the software, double-click the OLI Studio  icon on the desktop, which will take you to the OLI 
Studio interface where you can start creating your calculations.  

Let’s create a new stream. Click on the Add Stream located in the Action Pane. When a stream is created 

only H2O is present in the grid. Its cell is yellow because it cannot be removed, it is a permanent inflow. 

For this example, we are going to use the MSE-Databank (The default databank) 

Type FeCl3 in the white cell below H2O inflows grid, and press <Tab> or <Enter>  

Enter the value 1.0 mol in the next cell.  
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Note: By default, the software populates the stream parameters table with 25⁰C, 1 atm, and 55.5082 moles of water. This amount of water 
is 1 kg of water. All of OLI’s internal aqueous concentrations are based on the molal concentration scale. You will see this value frequently 
throughout this manual. This effectively makes any component concentration a molal concentration. 

Also, notice that the stream amount will be automatically calculated from the sum of the component inflows. To indicate that the summation 
has occurred, the grid will highlight the stream amount cell in green. 

Click the Description tab to change the name of the Stream. You can also 
change the name using the <F2> key or by right-mouse clicking on the object 
and selecting rename. 

Change the generic name Stream to pH of 1 m FeCl3 

Add the following Description: Isothermal calculation - calculating the pH of 
FeCl3 1 molal solution 

Go back to the Definition Tab 
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Now, we are ready to perform a calculation 

Go to the Add Calculation button 

Select Single Point 

 

Note: By default, the software selects the Isothermal type of calculation 
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All the required variables have been entered, and the Calculate button has turned green. Click on the 

 button. You can also press the <F9> key to run the calculation. 

 

Note: The calculation button has three colors depending upon the specifications: 

Red – Insufficient specifications for a calculation 

Yellow – Incomplete specifications but calculation can continue 

Green – Completed specifications, the calculation is ready 
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Please save the file (File >Save as…) and type an appropriate name, for example Single Point Calculations. 
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When the “Calculation is complete” a check mark appears on the calculation object . Now, let us analyze 
the results of the simulation. 

 

Analyzing the Results 

The summary box displays a partial set of results including pH, density, and volume, as well as the total 
calculation time. 

The pH is calculated to be approximately 1.49 
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Let’s analyze the simulation results in more detail 

Click on the Report Tab 

Scroll down and find Species Output (True Species). You will find a list of all the different species present in 

the aqueous phase. 

 

Why is the pH so low? 

The aqueous iron species complexes the hydroxide ions. The water dissociation reaction shifts in the direction 
that replenishes the hydroxide ions2. 

This equilibrium is always present: 

 

2 Le Châtelier’s principle. P.W.Atkins. Physical Chemistry. W.H. Freeman and Company, San Francisco (1982) p 269. 
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𝐻ଶ𝑂 ൌ  𝐻ା ൅  𝑂𝐻ି3 

Speciation Reactions 

First iron (III) chloride dissociates: 

𝐹𝑒𝐶𝑙₃ →  𝐹𝑒³⁺ ൅ 3𝐶𝑙⁻ 

Then the Fe³⁺ interacts with water; hydrolysis reaction: 

𝐹𝑒³⁺ ൅  Н₂О →  𝐹𝑒𝑂𝐻²⁺ ൅  2𝐻⁺ 

Then another water molecule enters into the reaction: 

𝐹𝑒𝑂𝐻²⁺ ൅  Н₂О  ↔  𝐹𝑒ሺ𝑂𝐻ሻ₂⁺ ൅  𝐻⁺ 

These last two reactions take up the OH- from solution, and release H+ into the solution. 

More speciation reactions occur, but the reactions above were shown as an illustration. The following is a list 
of all the species that are formed in the aqueous phase: 

Fe+3 

FeCl+2 

FeOH+2 

Cl-1 

FeCl2+1 

Fe(OH)2
+1 

H+1 

FeCl30 

Fe(OH)3
0 

OH-1 

FeCl4-1 

Fe(OH)4
-1 

H2O0 

HCl0 

Fe2(OH)2
+4 

 

pH Calculation 

The pH is calculated using the following formula: 

𝑝𝐻 ൌ െ logሺ𝑚ுశ𝛾ுశሻ 

For the pH calculation the molality and the activity coefficient of the 𝐻ା species is needed. To reveal the activity 
coefficients calculated by software follow the steps below.   

 

3 This hydrolysis reaction is the generic form found in most aquatic textbooks.  OLI uses this reaction in the AQ 
framework.  In the MSE framework, a more advanced reaction is used: 2H2O=H3O+ + OH- 



 

think simulation | getting the chemistry right 36 

 

Click on the Customize Button 

Select Species Activity Coefficients 

Click OK 
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Go to the Report and scroll down or use the Jump to option and select Species Activities/Fugacity 

Coefficients. 

 

Thus, the pH is: 

𝑝𝐻 ൌ െ logሺ𝑚ுశ𝛾ுశሻ 

𝑝𝐻 ൌ െ logሾሺ0.049012ሻሺ0.660195ሻሿ 

𝑝𝐻 ൌ െ logሾ0.032357ሿ 

𝒑𝑯 ൌ 𝟏.𝟒𝟗 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. We save this example initially 
as Single Point Calculations. 
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Example 2: Calculating the pH of an acetic acid solution 

In this example, we will explore an isothermal calculation, and how to set up the right units before you start your 
calculation. Let us calculate the pH of a 10 wt% acetic acid solution. The temperature and pressure will be 75oC 
and 1 atm, respectively.  

Starting the Simulation 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Isothermal – acetic acid 

Select the MSE thermodynamic Framework (selected by default) 

Click on the Units Manager Icon, and the Units Manger window opens 
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Click on the Customize Button 

 

Let’s change only the Inflows units. Click on the white box, select the drop-down arrow next to the unit, and 

select Mass Fraction.  Click OK, to exit the Units Manager and go back to the Definition tab. 
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Note: The default unit is mass%, however you can change it to other to ppm (mass) or g/g. 

 

 

We are now ready to enter the information to set up the single point calculation. 

Go to the Add Calculation button and select Single Point. Select the default calculation type – Isothermal 

Change the name to pH using the <F2> key or by right-mouse click on the object and selecting rename 

Change the temperature to 75⁰C and pressure to 1 atm 

Type Acetic Acid in the white cell below H2O inflows grid, and press <Tab> or <Enter>  

 

Note: If the name Acetic Acid changed to the formula type i.e., CH3COOH, or the OLI TAG name, i.e., ACETACID, you can change 

the name style to Display Name by clicking on the Names Manager icon  

 

Enter the value 10 mass% in the next cell. 

 

Note: When using mass-fraction units, it is assumed that the amount of water will be the difference of the components entered.  In 

this case, the value field is highlighted in yellow to inform you that the value will be determined from the values of the other components. 

 

Click on the Calculate button  
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Analyzing the Results 

After the calculation is complete, another way of analyzing the results is using the Output mini-tab.  

Click on the Output mini-tab at the bottom of the grid 

Right-click on the gray area and select Sections 

Select Additional Stream Parameters 

 

The Sections section offer more results such as Thermodynamic Properties, Scaling Tendencies, Equilibrium constants (K-
values), etc., that you can further explore.  
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So, the calculated pH of this acetic acid solution is approximately 2.3.  

 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 
same file that we created in Example 1 named as Single Point Calculations. 
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Bubble Point 

Liquid boils when its vapor pressure exceeds its confining pressure. Boiling occurs by adding heat (isobaric 
boiling) or reducing confining pressure (isothermal boiling). Either way, the effect is the same: a vapor phase 
forms. Stream Analyzer calculates this phenomenon using a calculation type called Bubble Point. Since the 
OLI software does not assume an air phase, the confining pressure acts like a plunger on a liquid’s surface. 
The pressure the plunger exerts is the pressure specified in the software. 

With the software, the temperature or pressure is adjusted such that a very small amount of vapor will form (i.e. 
110-10 of the total stream amount in gmoles). This is another way of saying that the bubble point calculation is 
a determination of the boiling point. Usually, we determine the temperature at which a solution will boil. If the 
pressure is set to 1 atm, then we calculate the Normal Boiling Point. If we set a constant temperature, then 
we determine the bubble point pressure. 

Example 3: Calculating the Bubble Point of a 1 M Acetone Solution 

In this example, we are going to compute the bubble point of a 1 M Acetone solution by changing the 
temperature (isobaric) and then the pressure (isothermal). Additionally, you will learn how to change the Inflows 
units from moles to moles/L (M).  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Bubble Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount 1 L 
Calculation Sub-type Bubble Point Temperature 25 ⁰C 
Stream Name Acetone Bubble Point Pressure 1 atm 
Name Style Display Name Water Calculated 
Unit Set Custom Acetone 1 mol/L 
Framework  MSE   

 

Calculating the Bubble Point Temperature (Isobaric) 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Acetone Bubble Point 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon, and select the Display Name option, and click OK 
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Click on the hyperlink mol next to Stream Amount 

 

 

This will open the Units Manager.  Under Inflows, select the option of Molar Concentration. It will 

automatically set the Stream amount as Volume in Liters. Then click OK. 

 

Type Acetone in the white cell below H2O inflows grid, and press <Tab> or hit <Enter>, and then enter the 

value 1.0 mol/L in the next cell. 

Go to the Add Calculation button and select Single Point calculation 
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Change the SinglePoint name to Bubble Point Temperature using the <F2> key  

Select Bubble point as Type of Calculation. 

A new section appears in the grid, called Calculation Parameters. By default, the Temperature Bubble Point 

calculation is selected. For this calculation leave the default calculation: Temperature  

 

Note: In the drop-down arrow you have the option to select Bubble Point Temperature or Bubble Point Pressure. 

 

Note: There are also two dots to the left of the Temperature and Pressure rows. The yellow dot represents the “dependent” 
variable. The temperature value, 25.000 is colored green. This value is now an initial guess, since the final value will be 
computed. The brown dot adjacent to the Pressure variable indicates that this potentially dependent variable is “fixed”. 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key. 

It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save under the same file that we created before named as Single 
Point Calculations. 
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Analyzing the Results 

Review the Summary Box. The temperature at the bubble point is computed to be 87.48⁰C at 1 atm. Also notice 
that the Vapor amount is 5.27e-9 moles out of the total Aqueous amount of 52.79 moles. This is by design; 
the software sets the amount of vapor at 1/10th the moles of the stream amount.  

 

Calculating the Bubble Point Pressure (Isothermal) 

This next calculation computes the bubble point pressure for the same stream. 

Select the Stream named Acetone Bubble point 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Bubble Point Pressure using the <F2> key  

Select Bubble point as Type of Calculation. 

Change the Calculate-Temperature row to Calculate-Pressure 

 

 

Click on the Calculate button or press the <F9> key. 
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It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. 

 

Analyzing the Results 

Review the Summary Box. The bubble point pressure is computed to be 0.0700550 at 25 ⁰C. Also notice that 
the Vapor amount is 5.27e-9 moles out of the total Aqueous amount of 52.78 moles.  

 

Dew Point 

The Dew Point is defined as the temperature at which a condensable component of a gas, for example water 
vapor in the air, starts to condensate into a liquid. OLI Studio: Stream Analyzer calculates this phenomenon 
using a calculation type called Dew Point. With the software, the temperature or pressure is adjusted such that 
a very small amount of liquid will form.   

It is frequently useful to determine the temperature or pressure at which a gas will condense. If the pressure is 
set constant, we calculate the dew point temperature; if the temperature is constant, then we determine the 
dew point pressure.  

Example 4: Calculating the Dew Point of a Simple Sour Natural Gas 

In this example, we are going to compute the dew point of a simple sour natural gas, by changing the 
temperature (isobaric) and then the pressure (isothermal).  
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Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Dew Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 55.5082 moles 
Calculation Sub-type Dew Point Temperature 120 ⁰C 
Stream Name Sour Natural Gas Dew Point Pressure 100 atm 
Name Style Display Formula H2O Calculated 
Unit Set Metric, Mole Fraction CO2 1 mole % 
Framework  MSE CH4 95 mole % 
  H2S 3 mole % 

 

Calculating the Dew Point Temperature (Isobaric) 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Sour Natural Gas Dew Point 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon, and select the Formula option, and click OK 

 

Click on the Units Manager Icon, and select Metric, Batch, Mole Frac. This will change all inflows to mole %. 
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Enter the composition of the gas given in the table above 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Dew Point Temperature using the <F2> key  

Select Dew point as Type of Calculation 

Keep the Calculate-Temperature option 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

Create a new SinglePoint and name it Dew Point Pressure. Repeat the steps above, and select the Calculate-

Pressure option 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations.  
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Analyzing the Results 

Review the Summary Box. The calculated dew point temperature is 94.9154 oC . The calculated dew point 
pressure is 472.561 
 

 
 
Note: The software sets the amount of liquid to 1/106 of the stream amount for the dew point calculation. 

 
You can study the composition of the acid gases such as CO2 and H2S dissolved in the Aqueous phase. 
After you have calculated the Dew Point Pressure, click on the Report Tab. Scroll down or use the Jump to 
option to go to the Species Output (True Species). 

 

Note: This image is for the “Dew Point Pressure” calculation 
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The aqueous phase, also known as Liquid-1 in the MSE framework, is shown in the center column. The 
dissolved CH4, H2S, and CO2 are 0.347, 0.305, and 0.043 mole % respectively.  

Isochoric (constant volume)  

The Isochoric calculation fixes the total system volume and adjusts the temperature or pressure. This can 
be understood in a gas-phase from the basis of the Ideal Gas Law: 

 𝑃𝑉 ൌ 𝑛𝑅𝑇 

If temperature is the free variable, then the above equation becomes 𝑇 ൌ
௉௏

௡ோ
, meaning that for a given volume, 

pressure, and gas moles, temperature can be obtained. 

You will run a calculation, in which the system moles, temperature and volume are defined.  

Example 5: Calculating the Total Pressure of a 10 L Vessel Containing Water and Air 

In this example, you will add 1 kg water to a 10 L vessel and then fill the void (head space) with Air. The 
temperature is 25 ⁰C. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Autoclave Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 55.5082 
Calculation Sub-type Isochoric  Ambient Temperature 25 ⁰C 
Stream Name Isochoric H2O Calculated 
Name Style Display Formula N2 77 moles 
Unit Set Metric, Moles O2 21 moles 
Framework  MSE CO2 1 mol 
Calculate Pressure  Ar 0.04 moles 
Vessel Volume 10 L   

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Isochoric 

Select the MSE (default) thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the gas composition in the table above 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to 10L Vessel using the <F2> key  

Select Isochoric as Type of Calculation 



 

think simulation | getting the chemistry right 53 

 

In the Calculation Parameters section set Total Volume to 10 L and Calculate Pressure. (To select 

Pressure, click on the drop-down arrow). 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the Results. 
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 About 304.9 atm of pressure are needed to compress the 154.55 moles of gas and liquid into a 10-L volume 
vessel at 25 ⁰C.  

Go to the Report tab and view the Total and Phase Flows (Amount) table. 
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The system is 10 L as defined (within the 1/106 tolerance). The water phase makes up slightly more than 1 L 
and the balance is vapor. At this pressure, about 0.1527 moles of water evaporates, and contributes to the total 
moles of vapor. 

Vapor Amount and Vapor Fraction 

The vapor amount and vapor fraction calculations are identical in nature to the Bubble Point calculation, 
except that instead of the software defining the vapor amount as 110-10 of the total stream amount, the user 
defines the vapor size in either mole fraction units (vapor fraction) or mole units (vapor amount). To create a 
specified amount of vapor (or vapor fraction) the software can adjust the temperature (or pressure).  

Example 6: Evaporating a Brine  

In this example, you will concentrate a brine via evaporation adjusting the temperature, until reaching a vapor 
fraction amount of 95 mole %.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Vapor Fraction / Vapor Amount Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default - 1 kg 
Calculation Sub-type Vapor Fraction Temperature 25 ⁰C 
Stream Name Brine Evaporation – Vapor Fraction Pressure 1 atm 
Name Style Display Formula H2O Calculated 
Unit Set Metric, Mass Fraction NaCl 9 mass % 
Framework  MSE CaSO4 1 mass % 

 

Calculating the Vapor Fraction Temperature (Isobaric) 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Brine Evaporation – Vapor Fraction 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to mass 
%. 
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Enter the gas composition given in the table above. 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Vapor Fraction Temperature using the <F2> key  

Select Vapor Fraction as Type of Calculation 

Enter 95 as the Vapor Fraction amount. 

Note: The software will convert the 1 kg to mole units and will put 95% of this in the vapor phase. 

Keep the Calculate-Temperature option 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box. The calculated temperature to put 95% (mole based) of the total stream amount in 
the vapor phase is 109°C, however the results in the summary box are given in mass. Let’s go to the Report. 
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Select the Report tab and scroll down to Total and Phase Flow (Amounts) 
Table.  

 

The apparent moles (Mole (App)) are the molecular representation of the system. There is a total of 51.5708 
moles in this system, and exactly 95% of this system is in the vapor phase with a total of 48.9923 moles. 
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Set pH  

The Set pH calculation is a useful tool in analyzing or designing a process. It allows you to create a solution 
that conforms to a premeasured pH. Other applications include designing a system to meet an operational pH 
or testing the impact of adding an acid or base to a system. 

Example 7: Neutralizing Acetic Acid 

In this example, you will compute the amount of base titrant required to neutralize a 1 molal acetic acid solution. 
You will assume a neutral system at 7 pH and 25°C. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Set pH Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default  
Calculation Sub-type Set pH Temperature 25 ⁰C 
Stream Name Neutralizing Acid Pressure 1 atm 
Name Style Display Formula H2O Calculated 
Unit Set Metric, Moles CH3COOH 1 mol 
Framework  MSE   

 

Setting the pH 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Neutralizing Acid 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles (default units). Click OK. 
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Enter 1 mol of CH3COOH as an inflow 

Go to the Add Calculation button and select Single Point calculation 

Select Set pH as Type of Calculation 

Change the SinglePoint name to Neutralizing acetic acid using the <F2> key 

A new grid section named Calculation Parameters appears. In this grid the Target pH can be defined, as well 
as the Acid and Basic titrants. The default titrants are HCl and NaOH (common) and so no additional 
specifications are required except to set the pH. 

 

Note: The default titrants can be changed by other acids or bases by adding the desired titrant as an inflow. 
The titrants in the Set pH calculation can be also set using the Specs button. 

 

The default acid and base are already set, so no additional work is required. If a different acid/base is desired, then the New 
Inflow button can be used to find additional components.  
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Enter 7 as the Target pH value 

Use the default titrants: HCL and NAOH 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the Results. About 0.996 moles of NaOH is 
needed to neutralize 1 mole of acetic acid to 7 pH. 
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Precipitation Point  

The precipitation point calculation computes the amount of material held in solution at given conditions and 
forces a very small amount of solid to exist. This calculation could be also called a solubility calculation. 

Example 8: Determining the Solubility of Calcite (CaCO3) 

Equilibrium based simulators suffer from a potential problem, that the most stable solid will tend to be included 
over less stable (meta-stable) solids.  Such is the case of calcium carbonate. Calcium Carbonate (CaCO3) is 
found in nature in many forms. Two common forms are the more thermodynamically stable solids, Calcite and 
the less stable form Aragonite. 

In this example, we will compute the solubility of CaCO3 as Calcite in a solution containing Ca+2, Mg+2, and Cl- 
as well as dissolved CO2. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Precipitation Point Calculation 

Calculation Settings 
Stream Composition and 

Conditions 
Calculation Type Single Point Calculation Stream 

Amount 
Default - 1 kg 

Calculation Sub-type Precipitation Point Temperature 25 ⁰C 
Stream Name Solubility of CaCO3 – Precipitation Point Pressure 1 atm 
Name Style Display Formula H2O Calculated 
Unit Set Metric, Mass Fraction (ppm (mass)) CaCl2 10870 ppm (mass) 
Framework  MSE MgCl2 9325 ppm (mass) 
  CO2 431 ppm (mass) 
  CaCO3 0 ppm(mass) 

 

Calculating the Precipitation of Calcite (CaCO3) 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Solubility of CaCO3 – Precipitation Point 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to mass%. 

However, you need to change the units to ppm (mass), to do this Click on the Customize button. 
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This will open the Edit Units window. Change the units from mass% to ppm (mass).  

 

 

Enter the stream composition given in the table above. 

Go to the Add Calculation button and select Single Point calculation 

Select Precipitation Point as Type of Calculation 

Change the SinglePoint name to Calcite Precipitation using the <F2> key 
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At this point you may have noticed that the Calculate button is red, and that there is a red text in the Summary 
Box with instruction that additional specs are needed. The specifications need to be defined in the Calculation 
Parameters grid section.  

 

Select the CaCO3 (Calcite) as the Precipitant 

 Select CaCO3 as the Adjusted Inflow 

 

The Precipitant refers to the independent variable – in this calculation, the solid phase selected will 
precipitate at amount of 1.0x10-10 times the stream amount.  
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The Adjusted Variable is the variable to be changed by the software until the solid target amount is 
achieved.  

Note: The precipitation point parameters can be also set using the Specs button.  

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the Results.  

The software calculated that the solubility of CaCO3 as Calcite in the solution under study is around ~313.1 
ppm (mass). The pH of this solution is ~6.07. 
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You can also check the results in the Report Tab. Click the Customize button and Select Stream Inflows.  
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Notice that the concentrations have changed slightly. This is to accommodate the additional 313.1 ppm CaCO3 
needed to meet the calculation specifications. 
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Example 9: Determining the Solubility of Aragonite (CaCO3) 

Calcite is the thermodynamically stable phase of calcium carbonate. Aragonite, calcite's orthorhombic 
polymorph, is about 1.5 times more soluble than calcite4. At surface conditions, aragonite spontaneously turns 
into calcite over geologic time, but at higher pressures aragonite, the denser of the two, is the preferred 
structure.  

In this example, we wish to determine the solubility of the less thermodynamically stable solid, Aragonite, 
independently of the more stable solid Calcite. To do this, we need to modify the solid phases in the chemistry 
model. 

Starting the Simulation 

Calculating the Precipitation of Aragonite (CaCO3) 

Under the Stream Solubility of CaCO3 – Precipitation Point, Add a Single Point calculation 

Select Precipitation Point as Type of Calculation 

Change the SinglePoint name to Aragonite Precipitation using the <F2> key 

Select the CaCO3 (Calcite) as the Precipitant 

Select CaCO3 as the Adjusted Inflow 

  

 

4 https://www.sciencedirect.com/topics/earth-and-planetary-sciences/calcite 
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Click on Chemistry > Model Options 
 

 
 

Select the Phases tab 

Click on the “+” next to the Ca(+2) box to display all the calcium containing solids 

Scroll down to find CaCO3 (Calcite) and uncheck this solid 

Click OK continue. 

 

Note: The Include Solid Phases box lists the solids in the chemistry model. Unchecking these solids will mathematically 
eliminate the solid from consideration. The Scaling Tendency, however, will still be calculated. 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations.  
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the Results.  

The software calculated that the solubility of CaCO3 as Aragonite in the solution under study is around ~353.8 
ppm (mass). The pH of this solution is ~6.15. You can see that the solubility of Aragonite is higher than the 
solubility of Calcite (313.1 ppm (mass)). 

 

  



 

think simulation | getting the chemistry right 70 

 

Example 10: Determining the Solubility of Dolomite (CaMg(CO3)2) 

The third carbonate mineral to mention is Dolomite, which is something like calcite with a very high 
concentration of magnesium in it. Under some conditions there can be much more magnesium added in, and 
when the amount of magnesium becomes roughly the same as the calcium, the resulting mineral is called 
Dolomite with the following chemical formula: CaMg(CO3)2. The formation of Dolomite is believed to occur in 
geological time frames.  

The species Dolomite is not present in the standard MSE database. However, it does exist in one of the specialty 
databases. This database is called Geochemical (MSE). 

Starting the Simulation 

Calculating the Precipitation of Dolomite (CaMg(CO3)2) 

Under the Stream Solubility of CaCO3 – Precipitation Point, Add a Single Point calculation 

Change the SinglePoint name to Dolomite Precipitation using the <F2> key  

Select Precipitation Point as Type of Calculation 

Click on Chemistry > Model Options 
 

 
 

In the Databanks Tab, select the Geochemical (MSE) #1Databank. You can double click or use the right arrow 
#2 to add the databank. Then Click OK. 
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You may have additional or fewer databases depending on previous installations and imported databases. 
Some are from OLI and some may be private (user) databases. 

 

Select the Phases tab 

Click on the “+” next to the Ca(+2) box to display all the calcium containing solids 

Scroll down to find CaCO3 (Calcite) and CaCO3 (Aragonite) and uncheck these solids. The MSE model also 

has ordered and disordered dolomite. These also should be unchecked.  See the figure below. Make sure to 

keep the second dolomite species checked.  

Click OK continue. 

 

Note: The Include Solid Phases box lists the solids in the chemistry model. Unchecking these solids will mathematically 
eliminate the solid from consideration. The Scaling Tendency, however, will still be calculated. 

 

Select the CaMg(CO3)2 (Dolomite) as the Precipitant 

Select CaCO3 as the Adjusted Inflow 

 

 
We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations.  
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the Results.  

The software calculated that the solubility of Dolomite in the solution under study is around 257.7 ppm (mass). 
The pH of this solution is 5.95. 

So far, we know that the solubilities of Calcite, Aragonite, and Dolomite in a MgCl2, CaCl2 and CO2 containing 
solution were 413.15, 552.87 and, 246.84 ppm (mass) respectively.  
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Composition Point 

The composition point calculation is used to fix a species value. This calculation is useful when, for example, 
you want a target amount of a desired component or to fix an impurity or undesired component below a certain 
value. 

Example 11: Targeting dissolved H2S in water below 0.001 m 

In this example, you will use the composition point calculation to target the amount of molecular H2S dissolved 
in water below 0.001 m.   

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Composition Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 55.5082 
Calculation Sub-type Composition Point Temperature 25 ⁰C 
Stream Name Composition Point Pressure 1 atm 
Name Style Display Formula H2O 55.5082 (default) 
Unit Set Metric, Moles H2S 0 moles 
Framework  MSE Target H2S-Aq value 0.001 moles 

 

Calculating the Vapor Fraction Temperature (Isobaric) 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Composition Point 

Select the MSE thermodynamic Framework (this is the default) 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the gas given in the table above 

Go to the Add Calculation button and select Single Point calculation 

Select Composition Point as Type of Calculation 

Change the SinglePoint name to H2S dissolved in water using the <F2> key 

Set the Target Species to H2S-Liq1 (i.e. the molecular H2S dissolved in the Aqueous phase) 

Set the Target H2S value to 0.001 moles 

Set the Adjusted Inflow to H2S 
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We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  
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According to the calculation, 0.00101 moles of H2S were required to create a solution with 0.001 moles of 
H2S-aq. The pH of this solution is 5.0.  

You can also go to the Report to see the distribution of species under the Species Output (True Species) 
table. 

 

You can see that the molecular H2S is the value that was specified as a target. Notice that the concentration of 
H3O+ and HS- are nearly identical. This is because the following reactions: 

H2S + H2O ⇌ H3O൅ ൅ HS- 

H3O+ is slightly higher because a second reaction, the dissociation of water also contributes to the H3O+ 
formation. 

2H2O ⇌ H3O൅ ൅ OH- 

Autoclave 

An autoclave is a high pressure, high temperature hydrometallurgy unit with carefully controlled conditions. 
From an OLI Software perspective, it is an isochoric (constant volume) calculation in which mass, pressure 
and temperature are allowed to vary. 

Autoclave calculations are widely used in the upstream oil and gas applications. When performing corrosion 
testing, autoclave experiments are essential for simulating downstream conditions, i.e. conditions at high 
temperatures and pressures. Additionally, it is important to evaluate the corrosivity of production fluids by 
measuring solution properties, such as pH, and the concentration of aggressive species such as CO2, H2S, and 
chlorides. An autoclave, however, has a constant volume, so it is imperative to know how much material (NaCl 
solution, CO2 and H2S gases) is necessary to add at charging conditions (e.g. at room temperature) in order to 
reach the desired final specifications, such as partial pressure of CO2 and H2S gases.  

We will use the Autoclave calculation to calculate partial pressures, fugacities and the final composition of key 
gases in the aqueous and vapor phases.  
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For the autoclave calculation 2 examples will be shown: 

Using an Inert Gas  

Calculating results at ambient conditions 

Increasing the volume of the vessel and its implications 

Increasing the final temperature and its implications 

Increasing the final pressure and its implications 

Using a Reactive Gas 

Calculating results at final conditions 

Using a Reactive Gas and a NaOH solution 
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Example 12: Using an Inert Gas 

Calculating Results at Ambient Conditions 

In this example, you will add 1 kg water to a 2 L autoclave and then fill the void (head space) with N2. The 
ambient temperature is 25 ⁰C. The N2 is presumed to be the gas that remains in the autoclave headspace after 
sparging (O2 removal) is completed. 

The amount of N2 added is the combination of N2 vapor filling the headspace, and N2 that dissolves in the water 
(N2 aqueous). Since N2 has a low water solubility, this second amount is negligible. H2O also evaporates, so 
the headspace will be a mixed gas, N2 and H2O. 

We can use the Ideal Gas Law to estimate the amount of N2 needed to fill the headspace: 

 𝑃𝑉 ൌ 𝑛𝑅𝑇 

1 𝑎𝑡𝑚 ൈ 1 𝐿 ൌ 𝑛 ൈ 0.082057
𝐿 െ 𝑎𝑡𝑚
𝐾 െ𝑚𝑜𝑙

ൈ 298.15 𝐾 

𝑛 ൌ 0.040874 𝑚𝑜𝑙𝑒𝑠 

Although this estimate does not consider the H2O that is in the 1 L headspace or the amount of N2 dissolved in 
water, it is still an easy approach to get a reasonable estimate. 

You will review the results in greater detail here, because part of the goal of this first example it to show where 
the important variables and properties are. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Autoclave Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 55.5082 
Calculation Sub-type Autoclave Ambient Temperature 25 ⁰C 
Stream Name Autoclave Final Temperature 25 ⁰C 
Name Style Display Formula Final Pressure 1 atm 
Unit Set Metric, Moles Vessel Volume 2 L 
Framework  MSE-SRK H2O Calculated 
Results for Ambient conditions  N2 0 moles 

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Autoclave 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the N2 as an inflow 

Go to the Add Calculation button and select Single Point calculation 
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Change the SinglePoint name to Autoclave – Inert Gas using the <F2> key  

Select Autoclave as Type of Calculation 

 

Note: At this point you may have noticed that the Calculate button is red, and that there is a red text in the Summary Box with 

instructions that additional specs are needed. The specifications need to be defined in the Calculation Parameters grid section. 

 

Click on the Specs button.  
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This will open the Calculation Options window to set up the target gas. Select N2-Vap and make sure to 

select the specification type Partial Pressure (default). Click OK. 

 

Set the Final Temperature to 25⁰C, the Final Pressure to 1 atm and the Vessel Volume to 2 L 

Set the Compute results at which Conditions to Ambient  

 

At this point the system is defined as 1 kg H2O (55.5082 moles) at an ambient temperature of 25 ⁰C. The partial 
pressure of N2 will be calculated at a final temperature, 25 ⁰C and pressure, 1 atm in a 2 L vessel. 
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Note: The Autoclave calculation pathway 

When performing an autoclave calculation, the software will perform two computations: First, at the final 
conditions, and the second one at ambient (initial) conditions. It will compute the amount (in moles) of N2 needed 
to create a 1 atm pressure at final conditions. It will then use this N2 to compute the pressure at ambient 
conditions. The calculation pathway is shown in the image below. 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  
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The calculated ambient pressure is 1 atm. It is identical to the final pressure, which is not surprising, since the 
ambient and final temperatures are the same, and by design, the autoclave calculation uses the identical inflows 
for ambient and final conditions. 

The amount of N2 added is 0.0400808 moles, which produces a 0.9686 atm partial pressure. The computed 
N2 inflow compares to the Ideal Gas value of 0.040874 moles, a 2% deviation. 

Let’s review the distribution of N2 in the liquid and vapor phase in the Report tab. Scroll down to the last table 
named Element Distribution.  

The last row is N (N is molecular nitrogen). The distribution is 98.5% in the vapor phase and 1.5% in the liquid 
phase. Also notice that around 0.0023% of the water has evaporated (see the H(+1) and O(-2) rows). 

 

These results infer two effects: 

As the final pressure (PT) increases, additional N2 will dissolve in the water, shifting the fraction of nitrogen to 
the liquid. 
As the total autoclave volume (VT) increases relative to the input liquid (which stays constant), additional water 
will evaporate, shifting the water to the vapor. This case will be shown next. 
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Increasing the Vessel Volume to 5 L 

You are going to use the same case that you built up in the example above, with the only difference that you 
will change the Vessel Volume. 

Right click on the Autoclave – Inert Gas single point calculation and select copy 

Selecting the stream named Autoclave, right click on it and select paste 

Rename the copied stream Autoclave – Inert Gas Vessel Vol 5L 

 

Change the Vessel Volume to 5 L and Calculate <F9> 

 

At this point the system is defined as 1 kg H2O (55.5082 moles) at an ambient temperature of 25 ⁰C. The partial 
pressure of N2 will be calculated at a final temperature, 25 ⁰C and pressure, 1 atm in a 5 L vessel. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.  
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

The moles of liquid are now 55.5037. The reduction of 0.0039 moles (compared to the case of 2 L which was 
55.5076 moles) is because this amount of H2O evaporated into the larger headspace. This phase distribution 
is important to modeling the autoclave system properly, especially at elevated conditions as will be seen in the 
next example. 

The amount of N2 required to fill the 4-L headspace is 0.1589 moles; this amount is 4-times greater than the 
first case, which is expected for gas with a low water solubility.  



 

think simulation | getting the chemistry right 84 

 

Increasing the Final Temperature 

In this example, you will add 1 kg water to a 5 L autoclave and then fill the void (head space) with N2. The 
ambient temperature is 25 ⁰C, and the final conditions will be 1 atm and 100 ⁰C. 

The purpose of this example is to raise the H2O partial pressure relative to N2. In the 5 L case above, the N2 
inflow is 0.1634 moles. As temperature increases, the H2O vapor pressure increases, and the amount of N2 
required to fill the vapor void will decrease. 

You are going to use the same case that you built up in the example above, with the only difference that you 
will change the Final Temperature to 25 ⁰C. 

Copy the Autoclave – Inert Gas Vessel Vol 5L single point calculation and paste under the Autoclave Stream. 

Name the new calculation object Autoclave – Inert Gas Tf=100C 

Change the Final Temperature to 100⁰C and Calculate <F9> 

 

At this point the system is defined as 1 kg H2O (55.5082 moles) at an ambient temperature of 25 ⁰C. The partial 
pressure of N2 will be calculated at a final temperature, 100 ⁰C and pressure, 50 atm in a 5 L vessel. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.   
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

The amount of N2 added is very small (0.0004 moles). This is to be expected, because the vapor pressure of 
pure water at 100 ⁰C is 1 atm. Therefore, a negligible amount of N2 is needed to raise the pressure. Notice also 
that the calculated ambient pressure is 0.0339 atm. The vapor pressure of pure water at 25⁰ C is 0.0313. 

The results above imply that the autoclave will have a vacuum pressure at the ambient temperature, and when 
heated to 100 ⁰C will reach atmospheric pressure. 

In autoclave testing, it is also of utmost importance to study and understand the partial pressures and fugacities 
of key gases at the final conditions. You need to enable these properties to be shown in the Report.  

Go to the Customize button and enable both the Species Fugacities and the Partial Pressures options, and 
then click OK.  
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Notice that the Fugacity and Partial Pressure of N2 are nearly identical. This is expected since at low pressure 

the fugacity approaches its partial pressure.  
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Increasing the Final Pressure 

In this example, you will add 1 kg water to a 5 L autoclave and then fill the void (head space) with N2. The 
ambient temperature is 25 ⁰C, and the final conditions will be 100 atm and 100 ⁰C. 

You are going to use the same case that you built up in the example above, with the only difference that you 
will change the Final Pressure to 100 atm. 

Copy the Autoclave – Inert Gas Tf=100C single point calculation and paste under the Autoclave Stream. 

Name it Autoclave – Inert Gas Pf=100 atm 

Change the Final Pressure to 100 atm and Calculate <F9> 

 

At this point the system is defined as 1 kg H2O (55.5082 moles) at an initial temperature of 25 ⁰C. The partial 
pressure of N2 will be calculated at a final temperature of 100 ⁰C and a final pressure of 100 atm in a 5 L vessel. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.   
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

The computed ambient pressure PT,A is 75.672 atm. Of this total, 75.68 atm is N2 (PN2=75.68 atm) and 0.0377 
atm is H2O (PH2O=0.0377 atm). Thus, to create a 100 atm final pressure, the autoclave would need to be charged 
with N2 at a regulator pressure of 75.68 atm. 

According to the calculation, the amount of N2 in the autoclave is 12.397 moles. This amount of N2 plus the 
55.5082 moles of H2O produces a final pressure of 100 atm in a 5 L autoclave at 100 ⁰C. 

Let’s study the partial pressure and fugacity of N2 at these final conditions. Remember, you need to enable 
these properties to be shown in the Report.  

Go to the Customize button and select both the Species Fugacities and the Partial Pressures tables, and 
then click OK.  

For comparison purposes, the Species Fugacities and the Partial Pressures for 100 ⁰C and 1 atm, and 100 
⁰C and 100 atm are shown.  
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100 ⁰C and 1 atm 100 ⁰C and 100 atm 

  
 

Notice that at low pressures, the partial pressures and fugacities values of both H2O and N2 are nearly identical. 
At the higher pressure, i.e., 100 atm, the partial pressures and fugacities of H2O and N2 start to differ. 
 
The cause of this deviation is the non-ideal effects of high pressures on gas molecules as they are forced closer 
together. At low pressures, gas molecules are too far apart to interact. As pressure increases, the average 
distance between two molecules decreases until at short range, intermolecular forces begin to impact the 
molecular properties. The impact of these forces is quantified in the fugacity term. Notice that fugacity and 
partial pressure have the same units, atm. 
 
Thus, when reviewing these two tables, the partial pressure can be seen as the idealized gas property at high 
pressures (which does not take into account intermolecular forces). The fugacity is the real gas property at this 
pressure. The non-ideal effect of pressure is therefore encapsulated in the following relationship: 
 

𝜑 ൌ
𝐹𝑢𝑔𝑎𝑐𝑖𝑡𝑦

𝑃𝑎𝑟𝑡𝑖𝑎𝑙 𝑃𝑟𝑒𝑠𝑠𝑢𝑟𝑒
ൌ
𝑓
𝑝௜

 

Where,  
𝜑 is the fugacity coefficient 
 
At low pressures, a gas molecule fugacity ሺ𝑓ሻ approaches its partial pressure ሺ𝑝௜ሻ, i.e. 𝑓 → 𝑝௜ or 𝜑 ൌ 1.
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Example 13: Using Reactive Gases 

Calculating Results at Final Conditions 

In this example, you will add 1 kg water to a 2 L autoclave and then fill the void (head space) with CO2. The 
ambient temperature is 25 ⁰C. 

You will then modify the case further by adding NaOH so that additional CO2 dissolves in water to form 
bicarbonate.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Autoclave Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 55.5082 
Calculation Sub-type Autoclave Ambient Temperature 25 ⁰C 
Stream Name Autoclave – Reactive Gas Final Temperature 25 ⁰C 
Name Style Display Formula Final Pressure 1 atm 
Unit Set Metric, Moles Vessel Volume 2 L 
Framework  MSE-SRK H2O Calculated 
Results for Final Conditions  CO2 0 moles 
  NaOH 0 moles 

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Autoclave Reactive Gas 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the CO2 and NaOH as inflows 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Autoclave – CO2 using the <F2> key  

Select Autoclave as Type of Calculation 

Click on the Specs button. This will open the Calculation Options window to set up the target gas. 

Select CO2 and make sure to select the specification type Partial Pressure (default). Click OK. 
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Set the Final Temperature to 25⁰C, the Final Pressure to 1 atm and the Vessel Volume to 2 L 

Set the Compute results at which Condition to Final.  
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At this point the system is defined as 1 kg H2O (55.508 moles) at an ambient temperature of 25 ⁰C. The partial 
pressure of CO2 will be calculated at a final temperature, 25 ⁰C and pressure, 1 atm in a 2 L vessel. 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

A total amount of 0.0725 moles of CO2 added was computed by the software to set the autoclave total pressure 
to 1 atm. For comparison, the same scenario in Example 12-1_Analyzing_the_Results required 0.04 moles of 
N2. The difference is the amount of CO2 that dissolved in the water. CO2 is more soluble than N2 in water.  

To analyze the CO2 distribution in more detail, go to the Report Tab, and Scroll down until you find the Element 
Distribution table. 
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The Element Distribution table contains three rows, H(+), O(-2), and C(+4). These are the elements of H2O 
and CO2. If you compare the C(+4) in the liquid and vapor phases, you will see that about 45.3% of the CO2 
dissolved in the water phase. By comparison, 1.5% of the added N2 dissolved in water at the same condition 
(see Example 12-1).  
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Using Reactive Gas and NaOH solution 

In this example, you will further modify the chemistry by adding NaOH so that additional CO2 dissolves in water 
to form bicarbonate. This will increase the gas requirement. 

Starting the Simulation 

You are going to use the same case that you built up in the example above, with the only difference that you 
will add the 0.1 moles or NaOH.  

Copy the Autoclave – CO2 single point calculation and paste under the Autoclave Stream. 

Name it Autoclave – CO2  – NaOH 

Change the composition of NaOH to 0.1 moles and Calculate <F9> 

 

At this point the system is defined as 1 kg H2O (55.508 moles) and 0.1 moles of NaOH at an ambient 
temperature of 25 ⁰C. The partial pressure of CO2 will be calculated at a final temperature, 25 ⁰C and final 
pressure, 1 atm in a 2 L vessel. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.  

 

Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

The CO2 inflow is calculated to be 0.1716 moles. This is exactly 0.1 moles more than the calculation with only 
CO2 (Example 13-1).  The difference results from the acid-base reaction with the 0.1 moles of NaOH. 
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To see the different species that have formed in solution go to the Report tab and select the Species Output 
(True Species). 

 

You can see that 0.1 moles of bicarbonate (𝐻𝐶𝑂ଷ
ି ) is formed. This reaction is increasing the CO2 gas 

requirement to reach a total final pressure of 1 atm.  
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Custom 

In the calculations that we have seen so far, variables were predefined. For instance, we selected either 
temperature or pressure as a fixed value in order to find the dew point pressure or dew point temperature. With 
the Custom calculation, however, you have the option to choose which parameters to set at fixed values and 
which parameters to keep as variables, to calculate the desired information, such as, for example, to investigate 
the solubility of gases in solution.  

Example 14: Solubility of Oxygen in Water 

With a custom calculation, we are going to calculate the solubility of O2 in water at 25°C and 1 atm. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Custom Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Default – 1kg 
Calculation Sub-type Custom Temperature 30 ⁰C 
Stream Name Custom Calculation Pressure 4 atm 
Name Style Display Formula H2O Calculated 
Unit Set Metric, Mass fraction – ppm (mass) O2 0 mol 
Framework  MSE   

 

Setting the pH 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Custom Calculation 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Mass Frac. This will change all inflows to mass 
%. 
Click on the Customize button. This opens the Edit Units window. 

Under Basis Options change mass fraction from mass % to ppm (mass) 

Enter O2 as an inflow and 0 moles 

Change the T to 30 ⁰C and P to 4 atm 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Oxygen Solubility using the <F2> key  

Select Custom as Type of Calculation 

Select the Specs button. This will open the Calculation Options window 
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Note: In the Calculation Options window, you have the option to select the Variables to Fix and the Variables 
to Free. In this example, the Variable to Fix is the number of Moles (True) of Vapor which will be given a small 
value of 1 ൈ 10ି଻ 𝑚𝑜𝑙𝑒𝑠. You can interpret this as the first bubble of vapor formed, indicating that the aqueous 
phase is saturated. The Variable to Free is the inflow of oxygen, in order to achieve saturation. 

 

In the Variables to Fix section, select Moles (True) Vapor, by double clicking or using the >> button. 

In the Variables to Free section, select O2 as the inflow. Then click OK.   
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This will add a Calculation Parameters section, where the Target (Variable to Fix) and the Adjusted Inflow 
(Variable to Free) are shown. The Target has a brown dot in front of it indicating that the Target: Moles (True) 
- Vapor is fix value.  The Adjusted Inflow value font is green indicating that the software will adjust this value. 

 

Fix the Moles (True) Vapor to 1𝑒ି଻ 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations. 
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Analyzing the Results 

Review the Summary Box or Click on the Output-Minitab to see the results.  

 

At 30⁰C and 4 atm the solubility of O2 in water is 146.94 ppm (mass)  

To get an estimate of the Henry’s constant, you can study the K-values reported by the software.  

Right click on the gray area, go to Sections>K-values>m-based. 
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The reciprocal of KO2VAP: O2VAP=O2AQ will give you an estimate of the Henry’s constant.  
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Reaction Kinetics 

Most of the chemistry and calculations that we have presented so far assume equilibrium. However, chemical 
reactions vary in speed as they occur. Some can occur instantaneously, while others can take years to reach 
equilibrium. The speed of a chemical reaction is given by the Reaction Rate, which is a measure of the change 
in concentration of the reactants or the change in concentration of the products per unit time.  

For the stoichiometric reaction below:  

𝑎𝐴 ൅ 𝑏𝐵 ൅⋯ → 𝑐𝐶 ൅ 𝑑𝐷 ൅⋯ 

The reaction rate is defined as: 

𝑟𝑎𝑡𝑒 ൌ  െ
1
𝑎
ቆ
𝑑ሾ𝐴ሿ

𝑑𝑡
ቇ ൌ െ

1
𝑏
ቆ
𝑑ሾ𝐵ሿ

𝑑𝑡
ቇ ൌ

1
𝐶
ቆ
𝑑ሾ𝐶ሿ

𝑑𝑡
ቇ ൌ

1
𝑑
ቆ
𝑑ሾ𝐷ሿ

𝑑𝑡
ቇ 

We can describe the kinetics of a chemical reaction by using a Rate Law, which is an expression that relates the 
concentration of each reactant raised to an exponent that reflects the reaction order (which is determined 
experimentally) and the rate constant, 𝒌, (a proportionality constate between reaction rate and concentration).  

The general rate law is generally expressed as: 

𝑅𝑎𝑡𝑒 ൌ 𝑘 ሾ𝐴ሿ௦ሾ𝐵ሿ௧ 

Where, 𝑠 ൅ 𝑡 gives us the reaction order of the reaction. 𝑠 and 𝑡 are not the same as the stoichiometric coefficients 
𝑎 and 𝑏. 

The reaction rate constant units are specific for the overall reaction order, since we always want the units of the 
rate to be concentration units per unit of time, e.g., M/s. 

Reaction order  Units 
0 M/s 
1 1/s 
2 1/(M•s) 

The rate constant, 𝑘, is dependent on the temperature at which the reaction takes place. Its temperature 
dependence can be studied using the Arrhenius Equation, as shown below. 

𝑘 ൌ 𝐴 exp ൬െ
𝐸௔
𝑅𝑇

൰ 

where: 𝑘= Reaction rate constant ሺ𝑢𝑛𝑖𝑡𝑠 𝑑𝑒𝑝𝑒𝑛𝑑 𝑜𝑛 𝑟𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑜𝑟𝑑𝑒𝑟ሻ 
 𝐴 = Arrhenius frequency factor ሺℎ𝑎𝑠 𝑠𝑎𝑚𝑒 𝑢𝑛𝑖𝑡𝑠 𝑎𝑠 𝑘ሻ 

𝐸௔ = Activation energy ቀ
௝௢௨௟௘

௚௠௢௟௘
ቁ 

𝑅 = Universal gas constant ቀ8.314
௝௢௨௟௘

௚௠௢௟௘ ௄
ቁ 

𝑇 = Temperature ሺ𝐾ሻ 

There are two different ways to enter rate laws reaction kinetics in OLI Studio: Stream Analyzer 

Standard Rate Law which uses the Arrhenius equation for the reaction rate constant 𝑘, referred to as STD 
type within the software. 
Non-Standard Rate Law, referred to as SPEC type within the software.   
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In this section, we will show you how to set up both types of reaction kinetics. 

The reaction kinetics is enabled Under the Chemistry menu > Model Options > Phases > Kinetics 

 

Standard Rate Law 

The Standard Rate Law (STD) considers both the forward and reverse reaction rates, the individual species 
reaction orders, and the forward and reverse reaction constants (determined using the Arrhenius Equation). 

For the reaction below:  

𝑎𝐴 ൅ 𝑏𝐵 ൅⋯ ↔  𝑐𝐶 ൅ 𝑑𝐷 ൅⋯ 

where:  𝑎, 𝑏, …  𝑐,𝑑 are stoichiometric coefficients 
 𝐴,𝐵, …  are reactant species 
 𝐶,𝐷, …  are product species 
 
The rate law is of the form: 

𝑅𝑎𝑡𝑒 ൌ ൫𝑘௙𝑎஺
௥ଵ𝑎஻

௥ଶ …െ 𝑘௥𝑎஼
௣ଵ𝑎஽

௣ଶ൯ 

where: 

𝑅𝑎𝑡𝑒 = Reaction rate 
௠௢௟

௛
 

𝑘௙ = Forward reaction rate constant ሺ𝑢𝑛𝑖𝑡𝑠 𝑑𝑒𝑝𝑒𝑛𝑑 𝑜𝑛 𝑟𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑜𝑟𝑑𝑒𝑟ሻ 

𝑘௥   = Reverse reaction rate constant ሺ𝑢𝑛𝑖𝑡𝑠 𝑑𝑒𝑝𝑒𝑛𝑑 𝑜𝑛 𝑟𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑜𝑟𝑑𝑒𝑟ሻ 

𝑎஺,𝑎஻, … = Activities of reactant species ቀ
௠௢௟

௠య ቁ 

𝑟ଵ, 𝑟ଶ …    = Reaction order of individual reactant species 
ሺ𝑛𝑜𝑟𝑚𝑎𝑙𝑙𝑦 𝑓𝑟𝑜𝑚 𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑙 𝑑𝑎𝑡𝑎.𝐷𝑒𝑓𝑎𝑢𝑙𝑡 𝑖𝑠 𝑠𝑡𝑜𝑖𝑐ℎ𝑖𝑜𝑚𝑒𝑡𝑟𝑖𝑐 𝑐𝑜𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑡𝑠: 𝑎, 𝑏, . . . ሻ 

𝑎஼ ,𝑎஽, … = Activities of product species ቀ
௠௢௟

௠య ቁ 

𝑝ଵ,𝑝ଶ, …  = Reaction order of individual product species  
ሺ𝑛𝑜𝑟𝑚𝑎𝑙𝑙𝑦 𝑓𝑟𝑜𝑚 𝑒𝑥𝑝𝑒𝑟𝑖𝑚𝑒𝑛𝑡𝑎𝑙 𝑑𝑎𝑡𝑎.𝐷𝑒𝑓𝑎𝑢𝑙𝑡 𝑖𝑠 𝑠𝑡𝑜𝑖𝑐ℎ𝑖𝑜𝑚𝑒𝑡𝑟𝑖𝑐 𝑐𝑜𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑡𝑠: 𝑐,𝑑, . . . ሻ 

Within the software the naming of the constants defined above is the following: 

OLI Keyword   Description 
𝐾𝐹    Forward reaction rate constant  
𝐾𝑅   Reverse reaction rate constant  
𝐴𝐹   Forward reaction Arrhenius factor  
𝐴𝑅   Reverse reaction Arrhenius factor  
𝐵𝐹   Forward reaction activation energy divided by the universal gas constant ሺ𝐾ሻ 
𝐵𝑅   Reverse reaction activation energy divided by the universal gas constant ሺ𝐾ሻ  
𝐸𝑅௜   Reaction order of reactant species 𝑖 
𝐸𝑃௜   Reaction order of product species 𝑖 

Thus, when specifying a standard rate expression, the user must define one of the following: (1) The Arrhenius 
frequency factors (𝐴𝐹 and 𝐴𝑅), and reaction activation energies divided by the universal gas constant (𝐵𝐹 and 
𝐵𝑅) or, (2) the reaction rate constants (𝐾𝐹 and 𝐾𝑅) directly. In addition, the user can specify the individual 
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species order coefficients for the forward and reverse reactions if these differ from the stoichiometric coefficients 
(which are the default). 

When defining the reaction order for a species, the order in which the species appears in the reaction equation 
must be defined (i.e., subscript i) with a sequential number, for either the reactant or product species. Hence, 
the first reactant is identified with the number 1, the second, 2 and so on.  Similarly, the product species are 
identified with the integers 1, 2, 3, etc.  

If any of the keywords are not defined, the software assumes a default value for that variable.  These default 
values are assumed to be zero for the reaction rate constants, For the species reaction order coefficients, the 
reaction stoichiometric values are assumed. To complete the standard rate expression definition, the reaction 
temperature and initial reactant molality are included in the process stream composition definition.   

Example 15: Reaction of Ammonia and Carbon Dioxide 

In this example, we are going to consider the reaction of ammonia and carbon dioxide to form urea and water, 
according to the following reaction: 

2𝑁𝐻ଷሺ௔௤ሻ ൅ 𝐶𝑂ଶሺ௔௤ሻ ↔ 𝑁𝐻ଶ𝐶𝑂𝑁𝐻ଶሺ௔௤ሻ ൅ 𝐻ଶ𝑂 

This reaction will take place in a plug flow reactor at 200⁰C and 100 atm, with a total residence time of 100 
hours.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Single Point Calculation with Reaction Kinetics Enabled 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Calculated  
Calculation Sub-type Isothermal Temperature 200 ⁰C 
Stream Name Standard Rxn Kinetics Pressure 100 atm 
Single Point Name Rxn Ammonia/CO2 Water 55.5082 
Name Style Display OLI Name (TAG) CO2 2 moles 
Unit Set Metric, Moles NH3 2 moles 
Framework  AQ UREA 0 moles 
Kinetics Enabled   
Kinetics Holdup Time 100 hours   
Number of Kinetic Steps 10   

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Standard Rxn Kinetics 

Select the AQ thermodynamic Framework  
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Click on the Names Manager Icon, and select the OLI Name (TAG) option, and click OK. 

 

Click on the Units Manager Icon, and select Metric, Batch, Moles. 

Enter the stream composition, temperature and pressure given in the table above. 

Go to the Add Calculation button and select Single Point calculation 

Select Isothermal (default) as Type of Calculation. 

Change the SinglePoint name to Rxn Ammonia/CO2 using the <F2> key 

So far, we have created an Isothermal calculation. Now, we are going to enable the Reaction Kinetics option 
at the Single Point Level. 

To enable reaction kinetics, make sure that you are at the Single Point Level by clicking on the Single Point 
Icon, and then go to Chemistry menu > Model Options. This will open the Chemistry Model window.  
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Select the Phases tab and check the Kinetics box. Then click OK. 

 

A new grid section named Calculation Parameters appears. In this grid the Kinetics Holdup Time, and the 
Number of Kinetic Steps can be defined. The default values are 2 h and 2 steps respectively.  

Change the Kinetics Holdup Time to 100 hours and the Number of Kinetic Steps to 10. 

 

Kinetics Holdup time is equivalent to Residence Time. The Number of Kinetic Steps is equivalent to Δt. Thus Kinetics 

Holdup time = Δt. 

Note: Kinetics Holdup Time vs Number of Kinetic Steps 
For processes that have reaction kinetics, the software needs to know how the concentration of the reactants (or products) change over 
time during the reaction, which is given by the rate law. It is necessary to divide the total residence time into small steps. Adding more 
steps decreases the error; however, as you increase the number of stages, the computational time increases. 
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Now, our next step is to define the reaction kinetics.  

Click on the Specs button. This will open the Survey Options Window.  

Select Kinetics under the Category window 

Click the Add button to add a new reaction. This will open the Select a Reaction Window.  

 

You will be given a list of reactions which are already in the chemistry model. For our example, we need to 
create a new reaction. 

Select the option Create a New Reaction, and then click OK. 

 

This enables the option to enter a new reaction.  
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Type the following reaction: 2NH3AQ+CO2AQ=UREAAQ+H2O and then hit Enter. The window will update. 

 
Note: You must use the OLI Tag Name for this step, and additionally specify the phase of the reactants and products. Water is a 

special case; it is written only as H2O.  

 

As a general rule: 

For an aqueous phase: AQ 

For a vapor/gas phase: VAP 

For a solid phase: PPT 

For a hydrated solid: SOLIDNAME.nH2O, where n is the hydration number 

For an ion: ION 

You can find the OLI TAG Name of your specific species using the Component Search Tool. 

 
Select the STD (Standard Rate Reaction Kinetics) as the Rate Specification 

 

Now, let’s start entering the rate constants. 

Remember, the forward and reverse reactions have the same format. The rate is the following: 

𝑅 ൌ 𝑘௙ሾ𝑁𝐻ଷሿଶሾ𝐶𝑂ଶሿ െ 𝑘𝑟ሾ𝑁𝐻ଶ𝐶𝑂𝑁𝐻ଶሿ 

For this example, the forward rate constant (𝐾𝐹) is a constant value equal to 2000. 

And, the reverse rate constant (𝐾𝑅) is defined as follows: 
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𝐾𝑅 ൌ 𝐴𝑅 𝑒
ି஻ோ
்  

𝐾𝑅 ൌ 1.2 ൈ 10ିଵ଴ 𝑒
ିଷସ଼଴.଻଼

்  

A summary of the Reaction Rate Parameters is given in the table below (These parameters where created for 
illustration purposes, do not use them for any real design work). 

Parameters Value Comment 
KF 2000 Forward Rate Constant 
KR Calculated Reverse Rate Constant 
AF  Not needed 
AR  1.2 ൈ 10ିଵ଴ 
BF  Not needed 

BR 3480.78 Determined from 𝐵𝑅 ൌ
ாೌ
ோ்
ൌ

ଶ଼ଽଷଽ.ଽ

଼.ଷଵସଶ
 

ER1 2 This is the exponent of reactant 1 [NH3]2 
ER2 1 This is the exponent of reactant 2 [CO2] 

EP1 1 
This is the exponent of product 1 in the 
mechanism. In this case [NH2CONH2] 

EP2 0 H2O does not participate in the reaction 

Now that we have identified the parameters needed, we can add them. 

Click on the Add button and select the parameters needed.  
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Type the constant values, and then click OK.  

  

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Single Point Calculations.  
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Analyzing the Results 

Click on the Output-Minitab to see the Results.  

Right click on the gray area and select Sections> Molecular Apparent - Aqueous 

 

About 0.002 moles of Urea had been formed with a total residence time of 100 hours.  

 

You can make changes on the residence time, reaction conditions or the rate of reaction to maximize the 
production of urea.   
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Non-standard Rate Law 

Non-Standard Rate Law, also referred to as SPEC type within the software. These reactions do not follow the 
Arrhenius kinetics. 

Example 16: Ammonia Hydrolysis 

In this example we are using simpler chemistry. We are going to study the hydrolysis of ammonia.  

𝑁𝐻ଷሺ௔௤ሻ ൅ 𝐻ଶ𝑂 ⇌ 𝑁𝐻ସ
ା ൅ 𝑂𝐻ି 

For this reaction we know the forward rate constant ሺ𝑘௙ሻ but need to constrain the reverse reaction to the 

thermodynamic equilibrium constant. This implies that we are going to replace an existing equation within the 
software. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Single Point Calculation with Reaction Kinetics Enabled 
Calculation Settings Stream Composition and Conditions 

Calculation Type Single Point Calculation Stream Amount Calculated  
Calculation Sub-type Isothermal Temperature 25 ⁰C 
Stream Name Non-Standard Rxn Kinetics Pressure 1 atm 
Single Point Name Ammonia Hydrolysis Water 55.5082 
Name Style Display OLI Name (TAG) NH3 0.1 moles 
Unit Set Metric, Moles   
Framework  AQ   
Kinetics Enabled   

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Non-Standard Rxn Kinetics 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon, and select the OLI Name (TAG) option, and click OK. 

Click on the Units Manager Icon, and select Metric, Batch, Moles. 

Enter the stream composition, temperature and pressure given in the table above. 

Go to the Add Calculation button and select Single Point calculation 

Change the SinglePoint name to Ammonia Hydrolysis using the <F2> key  

Select Isothermal (default) as Type of Calculation. 
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To enable reaction kinetics, make sure that you are at the Single Point Level by clicking on the Single Point 

Icon, and then go to Chemistry menu > Model Options. This will open the Chemistry Model window. 

Select the Phases tab and check the Kinetics box. Then click OK. 

 

 

Now, our next step is to define the reaction kinetics.  

Click on the Specs button. This will open the Survey Options Window.  

Select Kinetics under the Category window 

Click the Add button to add a new reaction. This will open the Select a Reaction Window.  

Select the first reaction: NH3AQ+H2O=NH4ION+OHION, and then click OK. 
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Select the SPEC as the Rate Specification. 

 

 

For this example, the forward and reverse reaction rates are the following: 

𝑅𝑎𝑡𝑒௙ ൌ 𝑘௙ ∙ 𝛾ேுయ,ೌ೜ൣ𝑁𝐻ଷ,௔௤൧ ∙ 𝛾ுమைሾ𝐻ଶ𝑂ሿ          𝑤ℎ𝑒𝑟𝑒  𝑘௙ ൌ 3     

𝑅𝑎𝑡𝑒௥ ൌ 𝑘௥ ∙ 𝛾ேுరశሾ𝑁𝐻ସ
ାሿ ∙ 𝛾ைுషሾ𝑂𝐻ିሿ          𝑤ℎ𝑒𝑟𝑒 𝑘௥ ൌ

𝑘௙
𝐾௘௤

 

Thus, the total rate is given by:  

𝑅𝑎𝑡𝑒 ൌ 𝑅𝑎𝑡𝑒௙ െ 𝑅𝑎𝑡𝑒௥ 

𝑅𝑎𝑡𝑒 ൌ 𝑘௙ ∙ 𝛾ேுయ,ೌ೜ൣ𝑁𝐻ଷ,௔௤൧ ∙ 𝛾ுమைሾ𝐻ଶ𝑂ሿ െ 𝑘௥ ∙ 𝛾ேுరశሾ𝑁𝐻ସ
ାሿ ∙ 𝛾ைுషሾ𝑂𝐻ିሿ  

This is where things get difficult. You now need to speak “OLI”. We have some rules for SPEC type equations.  

We now need to turn these values into “OLI” terms5. 

 

5 Commonly referred to as ASAP variables. 
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We can define any variable we want. We have some variables that you will need to use.  Any concentration 
variable such as [NH3aq] is defined as the natural log and is designated with the letter “L”. So [NH3aq] is used as 
LNH3AQ. 

Similarly, activity coefficients 𝛾 are also taken as the natural log. So,  𝛾ைுష is written as Loge γOH- = AOHION. 

KEQ is the thermodynamic equilibrium constant for the equation. AH2O is special in the Aqueous 
thermodynamic framework in that it is the variable 𝐿𝑛൫𝑎ுమை൯. 

We now need to add these variables to the kinetics window6: 

Variable Expression 

FXRATE LNH3AQ+ANH3AQ+LH2O+AH2O 

RXRATE LNH4ION+ANH4ION+LOHION+AOHION 

KF1 3 

KR1 KF1/KEQ 

RATE1 (KF1*EXP(FXRATE)-KR1*EXP(RXRATE))*VOLLIQ/1000 

Note: For a reaction rate to be considered in the program, your set of variables should include a RATEn 
statement where the “n” is the reaction rate equation number.  

Note: The variable VOLLIQ is the volume of the liquid phase in Liters.  OLI requires the rate to be in mol/m3 we 
need to divide by 1000. 

Change the Kinetics Holdup Time to 100 hours and the Number of Kinetic Steps to 10. 

 

 

 

6 Copy and paste from this document can make this step easier 
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You will notice in the image above that we have scrolled to the end. That is ok.  Click the Add button to continue 
with the equations. It is important that you keep the order correct. You see what we are using previously defined 
variables in subsequent equations. 

Complete the remainder of the variables. 

 

The completed equations 

 

Click the OK button. 

Like the previous example, this is a plug-flow reactor with a holdup time of 100 hours and 10 steps.  

Now Calculate 

Once the calculation is complete you can click the Output mini tab and add the Aqueous section (not molecular 
aqueous): 
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You can see that some ammonium ions have been created.  It is interesting to see what the equilibrium condition 
would be.  

Create another single point isothermal calculation and run it without any reaction kinetics.  Here are the results 
below: 

 

The reaction kinetics have forced the back reaction to be dominant.  In the equilibrium case, approximately  

1.3x10-3 moles of NH4
+ have been created.  By limiting the forward reactions, we allow the back reaction to take 

place and that only formed 5.4x10-4 moles of NH4
+.  
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Section 2. Survey Calculations 

Survey calculations are single point calculations strung together in series. They are also referred to as multiple 
point calculations. 

There are three different ways to set up surveys: 

Single Survey: These calculations allow the user to designate one independent variable. The predefined single 

surveys include surveys by Temperature, Pressure, Composition, pH, Vapor Fraction and Vapor Amount. 

Dual Survey: These calculations allow the user to designate two independent variables. 

Survey by changing the single point calculation type: By default, the isothermal calculation is selected for 

survey calculations. If the user wants to study the solubility of a salt in solution, it is possible to change the 

survey from Isothermal to another calculation type like Precipitation Point .  

In this section, you will learn how to set up survey types and introduce some additional features to get the 
most out of your simulation results.  
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Single Surveys 

An introduction to single surveys is given here. We will illustrate, in detail, the steps necessary to conduct this 
type of calculation. The example below was designed to be used as a guide for future reference.  

Example 17: Removal of Nickel from Wastewater  

This case study is a typical wastewater treatment problem, the removal of a trace heavy metal ion (nickel) from 
a water stream in which the presence of another chemical (cyanide) significantly alters the treatment strategy.  
In this case, we are considering precipitation as an approach to removal of the nickel. 

The wastewater in this case study contains nickel ions at a concentration of 0.002 m (or moles/ 1 kg H2O). The 
existing treatment strategy is to precipitate the nickel ions as Nickel Hydroxide (Ni(OH)2). The soluble nickel 
remaining after precipitation needs to be less than 1 ppm, which is the maximum contaminant level allowed. 

During the course of the plant operation, some cyanide ion is inadvertently added to the waste stream. The 
soluble nickel is now more than 1ppm. Sulfide salts were then added to hopefully precipitate the nickel and 
once again achieve the design specification.  

This example will be divided into three different scenarios: 

Scenario 1: Wastewater without Additives 
Scenario 2: Wastewater with Cyanide Content 
Scenario 3: Wastewater with Sulfide Salts 

The power of the Stream Analyzer becomes apparent when we are seeking to study the chemistry of individual 
streams. For this specific example a Survey by pH will be used. We will also be using the AQ thermodynamic 
model instead of the default MSE model. 
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Scenario 1: Wastewater without Additives 

We begin by starting the Stream Analyzer Program. This may be accomplished by clicking on the OLI Studio 
icon or by using the Start button and finding OLI Studio  under Programs, which will take you to the New window 
where you start creating your calculations.  

Select the AQ-Databank (The default databank) 

Click on Add Stream icon (in the actions panel). This will display the Definition window. We should add some 

descriptive information about this stream, so we can later identify the stream 

Click on the Description tab. This will display the description information 

Replace the name Stream with the name Nickel Waste. It is advisable to change the name of the stream from 

the default name. You may be entering many streams and will need to sort them out later 

Add the following text to the Description box: “Nickel wastewater for the OLI Aqueous Modeling Course” 

Note: The summary box will contain additional information as the calculations proceed. This information may be the name of additional 
databases or chemistry models imported from other OLI software packages. The filled-out window should look like the figure below. 
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Click on the Definition tab to start defining the wastewater stream 

Click in the white box in the grid below the Inflows line. Add the formula Ni(OH)2 

Click in the white box next to the species you just entered and enter the value 0.002. Press <Enter> to update 

the list 

Note: Stream Analyzer will automatically change the name of the species to the selected display name. In this instance, the name 
you entered was Ni(OH)2 but it may have changed to a different form. If it changed you can specify which display name to use in the 

Names Manager icon  

For the output results, we want output units in ppm. To change the output 
units, click on the Units Manager icon . This will open a new window. 

Change moles to Mass Frac. Using the drop-down arrow 

Click on the Customize button. The Units Manager window will appear. 
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Make sure you are on the Composition tab 

Change the Mass Fraction Units to ppm (mass)  

Click OK 

 

Our primary interest in this application is finding the optimum pH for nickel removal. To create a plot of Ni+2 as 
function of pH, we will need to run a pH survey.  
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Creating a pH Survey to find the optimum pH for nickel removal 

Click on the Nickel Waste stream icon in the tree view on the left-hand side of the window. This will bring you 

back to the top of the series of calculations by displaying just the stream information.  

Click on the Add Calculation button 

Select Survey 
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You can now add descriptive information about this calculation. 

Enter a new Survey name: Base Survey. You can also double click on 

‘Survey’ to change the name  

Enter a Description: Base pH survey without additives.  

Since we do not want a temperature survey which is the default, we will need to change the survey type. 

Click on the Definition tab to do the survey calculation. 

Click on the Survey by button 

Select pH 

Note: The default acid titrant and the base titrant are already defined (HCl and NaOH). We are now ready to begin the calculations. 
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We should now save our work. It is very frustrating to work for a long period of time and forget to save our work. 
So please save.  

Select File 

Select Save As from the menu. Give the name Removing nickel from 

wastewater 

Click on the Calculate button 
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The program will run for a short time. When the orbit disappears, check the summary box to see if the calculation 
is complete. In the tree-view, you can expand the survey to see if all the points converged. 
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We can now obtain some graphical results. 

Click on the Plot tab 

Click on the Variables button 
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This will open a new window. The NaOH and HCl variables in the Y-Axis box should be displayed. 

Select them and then Click on the left double-arrow (<<) button which will 
remove NaOH and HCl from the list. You can also select and double click to 
remove them.  

Scroll down the left-hand window to find MBG Totals - Aqueous and expand 
the list by clicking the  box.  

Note: MGB is an abbreviation for Material Balance Groups. The MGB variable is a sum of all the species for that material in the phase 
requested. 

 

The grid updates to show the MGB totals available to display. In this case we desire the Nickel(+2) species. in 
this case all the Ni(+2) Aq variable is a sum of all nickel containing ions in the aqueous phase in solution. Any 
solids are excluded from the summation.  
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Double-Click the Ni(+2) item or select it and use the >> button. 

Click on the OK button. 
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You will see the new plot.  

For many calculations, the values on the plot extend over a very large range of numbers. The default linear axis 
may not capture all the details we require. 

Above the plot window locate and select the Options button. This opens a new window. 
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Select Y-Axis from the Category List 

Check the Logarithmic Scale Box 

Click on the OK box 

 

The modified plot is then displayed. The limit of 1 ppm for Ni+2 is approximately 2 x 10-5 moles. Above pH=9, 
we are several orders of magnitude below this limit. Additionally, you can see that a minimum amount of Ni2+ in 
the aqueous phase seems to occur in the pH=11 range. This is the result of nickel solids forming and leaving 
the aqueous phase. 

 
Note: The red line was put as a reference. it was not plot with the software. 

Let’s make the plot shown above the default plot. To do that we are going to use the Plot Template Manager 
Tool.  
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Save the description in the left-hand corner panel named Plot Template 
Manager. Type MBG Aqueous Ni(+2) as the name in this case. 

Click Save  

 

Now there will be two plots on that list now. The first is the default plot, and the second is MBG Aqueous Ni(+2). 
You are now able to see these plot conditions for any other analyzer object in this case when you add survey 
for that object. 
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What else is important in this solution? 

Click once more on the Variables button 

Add the following Aqueous species to the plot. (You may need to scroll up or 
down to find all the species): 

Ni(OH)2 

NiOH+1 

Ni+2 

Ni(OH)3-1 

Add the following Solids species to the plot: 

Ni(OH)2 

Click on the OK button when done 
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You can see that the soluble nickel (Ni(+2) Aq) is a summation of the other species. The large drop in the value 
is because most of the nickel leaves the aqueous solution as Ni(OH)2-Solid at pH values greater than 7.0 with 
a maximum near pH=11. 

Let’s save this as a default plot as well in the Plot Template Manager as 
Aqueous and Solids 
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Scenario 2: Wastewater with Cyanide Content 

The real importance of aqueous speciation modeling of this treatment is only really appreciated if we introduce 
cyanides, which brings us to the real waste treatment problem. 

For this scenario, you will repeat many of the same steps as in Scenario 1. We recommend that you create new 
calculations below the Nickel Waste stream. This will keep the core composition the same without affecting the 
results of other calculations. 

Please follow these steps for this scenario. Please note that we will only show the screens that are substantially 
different from those that you have already seen. 

Creating a pH Survey to find the optimum pH for nickel removal 

Click on the Nickel Waste stream in the tree view in the left-hand window 

This will display the Actions pane in the bottom left corner of the Stream Analyzer window. Click on the Add 

Survey icon in the Actions pane 
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Click on the Description Tab, and change the Name and Description in the 
Description tab. 

Name: Waste Survey with CN 

Description: pH survey with both Nickel and CN 

Click on the Definition Tab 

Add NaCN to the grid with a value of 490 ppm 

Click on the Survey By button and select pH. Note that HCl and NaOH are 
the default titrants and are automatically added 

Click on the Calculate button. 
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Let’s review the results.  

Click on the Plot tab 

Go to the Plot Template Manager tool, and click on MGB Aqueous Ni(+2) 

 

The results have changed very dramatically. The new optimum pH for Ni removal is around 4.0, rather than 11. 
However, the lowest total Ni remaining in solution is now around 4 ppm which is well over 1 ppm. 
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Let’s analyze why this is happening. We can now modify the plot to display more variables. Select the Aqueous 
and Solids plot saved in the Plot Template Manager. 

Click on Variables 

Add the following new Aqueous species: Ni(CN)4-2  

Add the following new Solid species: NiNi(CN)4-Solid 

Click OK 
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Let’s analyze the results. 

The culprit is the Ni(CN)4
-2 complex of nickel and cyanide. Basically, the plot of the total Ni in solution and the 

Ni(CN)4
-2 complex overlap over the interval pH=5 to 12. This means that virtually all nickel in solution is in the 

form of this complex.   

This complex thus holds the Ni in solution and does not allow the nickel hydroxide to even form. Instead, a 
much weaker precipitate, the NiNi(CN)4 salt forms over a narrow range of pH with 4.0 being the optimum. 

 

 

Scenario 3: Wastewater with Sulfide Salts 

We can now try to influence nature by introducing a source of sulfide. We do this because many metal sulfide 
salts are highly insoluble. 

Create a new single point calculation and a survey as you did in the previous two scenarios. 

Add 490 ppm of NaCN 

Add 340 ppm of H2S 

For the survey case, use the plot template manager to start off with the MBG– Aqueous (Ni+2) and then add 
the following variables: 

Aqueous Species: Ni(CN)4-2  

Aqueous Species: Ni+2 
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Solid Species: NiS-Solid 

 

The results reflect a "power struggle" between the Ni(CN)-2 which is holding the nickel in solution and the NiS 
solid which clearly has a greater tendency to form than the NiNi(CN)4 solid.  As a result, our optimum pH is still 
around 4.0 and we are now around 10-5 ppm total nickel in solution which is a bit below 1 ppm. 

This would be a good time to save your work. You may use the File/Save As… menu item or use the Save icon 
on the toolbar. 

 

Final Thoughts… 

Aqueous speciation modeling can teach us a great deal about complex chemical systems and the interactions 
of individual species. 

The actual removal achieved with sulfide may not be quite enough to satisfy the regulations. This is useful 
information to have. In addition, with the power of OLI Studio: Stream Analyzer, one could now explore alternative 
treatment methods such as ion exchange. 

Although such a simulation is beyond the scope of this demonstration, consider how vital it is to know that the 
dominant species to be exchanged (removed from solution) is an anion Ni(CN)-2 and not the cation (Ni+2) as the 
conventional wisdom might dictate.  
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Temperature Survey 

The default single survey calculation is the Survey by Temperature. The software computes solution properties 
based on a known composition and pressure at different temperatures.  

Example 18: Studying a Four-phase mixture and its Partitioning 

The purpose of this first example is to present the basic Temperature survey. You will study how a four-phase 
mixture partitions with temperature. The system composition will be basic, containing one primary phase 
component, H2O (liquid), CH4 (gas), Decane (organic), and NaCl (solid). Each component will partition each of 
the other three phases. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Temperature Survey Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name Temperature Survey Temperature Range 25-100 ⁰C (Default) 
Survey Name 4-Phase Partioning Step Size Increment by 5 ⁰C (Default) 
Name Style Display Formula Pressure 1 atm 
Unit Set Metric, Moles H2O 50 moles 
Framework  MSE-SRK CH4 10 moles 
  C10H22 10 moles 
  NaCl 10 moles 

 
 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Temperature Survey 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Change the Survey name to 4-Phase Partitioning using the <F2> key  

Select Temperature as Type of Survey - Default 
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Click on the Specs button. This will open the Survey Options Window 

 

 

The Temperature Range is entered in the End Points section. The default values for the Temperature Range 

are 25⁰C (Start) to 100⁰C (End). Leave the default values.  

The Step Size can be given as Increments or Number of Steps. By default, in the Temperature Survey the 

Step Size by 5 increments is selected. Leave the default values. Then click OK. 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations.  
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Analyzing the Results 

Click on the Plot tab (  ).  

The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase), Liquid-2 (Organic Phase), Solid 
and Vapor. 

The plot below shows that as temperature increases, the mass of Liquid-1 and Liquid-2 (organic) decreases, 
as they evaporate, and hence the Vapor phase increases. The solid phase mass remains constant up to 80⁰C, 
and then increases at higher temperatures.  

 

Note: When the mouse-pointer is positioned over a point on one of the curves, the message box at the top of the plot indicates 
the variable and the coordinates of that point.  
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Pressure Survey 

In the Survey by Pressure, the software computes solution properties based on a known composition and 
temperature at different pressures.  

Example 19: Dissolution of CO2 in water as a Function of Pressure 

Many thermodynamic properties are less dependent on pressure than they are on temperature. Vapor-Liquid-
Equilibrium (VLE) is affected by pressure. 

In this example, the dissolution of CO2 in water (which is a direct reflection of VLE) will be studied as a function 
of pressure.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Pressure Survey Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name Pressure Survey Pressure Range 5-100 atm 
Survey Name CO2 dissolved in water Step Size Increment by 5 atm 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Moles H2O 55.5082 moles 
Framework  MSE-SRK CO2 10 moles 

 
 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Pressure Survey 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Change the Survey name to CO2 dissolved in water using the <F2> key  

Select Pressure as Type of Survey 

Click on the Specs button. This will open the Survey Options Window 
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The default pressure range is from 1-10 atm with an increment of 1 atm. Change the Pressure Range to 5-100 

atm. Set the Step Size to 5 atm increments. Then click OK. 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 

 

Analyzing the Results 

Click on the Plot tab (  ). The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase), 
Liquid-2 (Organic Phase), Solid and Vapor. 

You can see that the Liquid-1 phase increases up to around 60 atm, and then it follows a constant trend as the 
pressure continues to increase. Regarding the Vapor phase, you can see that it shows a sudden decrease in 
mass from around 400 g at 60 atm to 0 g at 65 atm. The pressure of the system has increased in such a way 
that causes a phase change from vapor phase to Liquid-2 phase.  

We are interested in the solubility of CO2 in water, i.e. in the Liquid-1 phase. We can change the default plot to 
show the molecular CO2 dissolved in water (CO2-Liq1). 

Click on the Variables button. This will open the Select Data to Plot window.  

 

Double click or use the << button to remove the Phase Amount variables. 
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Look for Liquid-1 and click on the  box to show all the available variables. 
Select CO2-Liq1 and put it in the Y1 Axis using the >> button. 

Look for Additional Stream Parameters section and click on the  box to 
show all the available variables. Select pH and put it in the Y2 Axis using the 
>> button. Then click OK. 

 

The default plot now shows the selected variables: The dissolved CO2 in the water (Liquid-1 Phase) in the Y1 
Axis, and the pH in the Y2 Axis. Both variables are presented as a function of pressure. 
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The dissolved CO2 in solution increases as the pressure increases. When the pressure goes above 65 atm, the 
dissolved CO2 remains nearly constant. 

A similar behavior is seen in the pH. As the pressure increases, a decrease in pH is observed. This is attributed 
to the following equilibria dissociation reactions: 

𝐶𝑂ଶ,௩௔௣  ⇆  𝐶𝑂ଶ,௔௤ 

𝐶𝑂ଶ,௔௤  ൅  2𝐻ଶ𝑂 ⇆  𝐻ଷ𝑂ା  ൅  𝐻𝐶𝑂ଷ
ି 

 𝐻𝐶𝑂ଷ
ି ൅ 𝐻ଶ𝑂 ⇆  𝐻ଷ𝑂ା  ൅  𝐶𝑂ଷ

ଶି 

Thus, as the amount of CO2 in the aqueous phase increases, the dissociation reactions create more hydrogen 
ions ሺ𝐻ାሻ available in solution, subsequently decreasing the pH. As the pressure reaches values above 65 atm, 
the pH value remains constant. Hence, the pH is a direct reflection of the dissolved CO2 in solution. 
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Composition Survey 

In the Survey by Composition, the software computes solution properties based on a given composition of 
species (or set of species) at a specific temperature and pressure.  

Example 20: Dissolution of Calcite (CaCO3) as a function of CO2 

Calcite is a scale that forms very easily in the production of oil and gas. It is known that adding CO2 to water 
dissolves Calcite. Likewise, removing CO2 from water precipitates calcite.  In this example, you are going to 
evaluate the effect of different CO2 concentrations on the dissolution of Calcite. 

 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Composition Survey Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name Composition Survey Temperature 25 ⁰C 
Survey Name Calcite Dissolution Pressure 75 atm 
Name Style Display Formula H2O 55.5082 moles 
Unit Set Metric, Moles CaCO3 0.05 moles 
Framework  MSE CO2 concentration range 0 - 1 moles 
  Step Size Increment by 0.05 moles 

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Composition Survey 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Change the Survey name to Calcite Dissolution using the <F2> key 

Select Composition as Type of Survey. 

Note: In the summary box a message in red appears: ‘Component not selected for composition survey 

variable’. This means that we need to select the component that we want to vary. In this example CO2.  

To specify the component, click on the Specs button. This will open the Survey Options Window. 
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Under the Component tab, select CO2 

 

Now, click on the Survey Range tab. Enter the CO2 composition range from 0 to 1 mol, by increments of 

0.05 moles. Then click OK. 
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We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 

 

Analyzing the Results 

Click on the Plot tab (  ). The default plot is the pH as a function of total CO2 in moles. As the 
concentration of CO2 increases, the pH decreases (as it was explained in the example above).  

We are interested in understanding the dissolution of Calcite as a function of CO2. To see these results, we 
need to study how the moles of solid calcite change as the concentration of CO2 increases.  

Click on the Variables button. This will open the Select Data to Plot window.  
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Double click or use the << button to remove the pH variable 

Look for Solid section and click on the  box to show all the available 
variables. Select CaCO3 (Calcite) – Sol and put it in the Y1 Axis using the >> 
button. Click OK. 

The default plot now shows the selected variable: CaCO3 (Calcite) – Sol as a function of CO2.  

 

As expected, the amount of CaCO3 (Calcite) decreases with increasing CO2. In an oil production setting, when 
there is a significant pressure drop, CO2 will be lost. This will decrease the solubility of CaCO3 and will increase 
the likelihood of scale formation.  
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pH Survey 

In the Survey by pH, the software adjusts the flowrate of acid or basic titrants to at a predefined set of pH values 
and computes the solution properties of a solution based on a given composition of species (or set of species) 
at a specific temperature and pressure.  

Example 21: A Speciation Diagram for the Carbonic Acid System as a Function of pH 

In this survey calculation, a 0.001 molal CO2 solution is titrated with HCl and NaOH. Instead of defining the 
amount of acid/base to add, the pH will be specified, and the software will compute the amounts of HCl and 
NaOH needed. 
 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

pH Survey Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name pH Survey Temperature 25 ⁰C 
Survey Name Carbonic Acid System Pressure 1 atm 
Name Style Display Formula H2O 55.5082 moles 
Unit Set Metric, Moles CO2 0.001 moles 
Framework  AQ pH range 4-12 
  Step Size Increment by 0.1 

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to pH Survey 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Select pH as Type of Survey 

Change the Survey name to Carbonic Acid System using the <F2> key 

The calculation can be run without modification. The default titrants are HCl and NaOH, and the default pH 
range is set from 0 to 14 with a step size of 1 increment. However, this pH range is too broad for the carbonate 
system, in which most of the speciation occurs between pH=4 and 12. Additionally, it is ideal to specify finer 
increments to see a smoother curve.    
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Click on the Specs button. This will open the Survey Options Window 

In the pH Titrants tab, leave the default pH Titrants: HCl and NaOH 

 

Now, click on the Survey Range tab. Enter the pH range from 4 to 12, with increments of 0.1. Then click OK. 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations.  
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Analyzing the Results 

Click on the Plot tab (  ). The default plot is the moles of added HCl and NaOH vs Target pH. This is not 
the target variable and you will change it to display the carbonate-containing species. 

Click on the Variables button 

Remove the NaOH and HCl from the Y1 axis (double click or use the << button) 

Look for Aqueous section and click on the   box to show all the available species. Select the following 

species: CO2-Aq, HCO3-1, CO3-2, and H+ and put them in the Y1 Axis using the >> button or by double 

clicking. When you are done, click OK. 
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You can also present this plot on a semi-log scale. 

Click on the Options button. This will bring the Customize Plot window 

Select Y Axis in the Category window 

Check the Logarithmic scale box, and then click OK. 

 

Before analyzing the plot, let’s add the OH- species. 

Click on the Variables button, look for OH-1 in the Aqueous section, add it to the Y1 Axis, and then click 

OK. Now we are ready to analyze the plot. 
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At lower pH, CO2-Aq dominates the system, and notice how the HCO3-1 slope is 1 and the CO3-2 slope is 2. 
Likewise, in the pH region where CO3-2 dominates (high pH), the HCO3-1 slope is -1 and the CO2-Aq slope is 

-2. These 
௠௢௟௘

௣ு
 slopes are based on the number of H+ ions added or removed in the chemical reactions. See 

reactions below. 

𝐶𝑂ଶ,௔௤  ൅  𝐻ଶ𝑂 ↔  𝐻ା  ൅  𝐻𝐶𝑂ଷ
ି 

 𝐻𝐶𝑂ଷ
ି  ↔  𝐻ା  ൅  𝐶𝑂ଷ

ଶି 

Note the pH where the CO2-Aq and HCO3-1 lines intersect (pH~6.3), and where the HCO3-1 and CO3-2 lines 
intersect (pH10.3). These pH values are the same as the pKa values (the equilibrium equations the specific 
equilibrium reactions).  

As NaOH is added to convert HCO3- to CO3-2, a portion of the NaOH remains as free base, OH-1. This fraction 
increases at higher pH values, and its concentration is reflected in the calculated pH. A similar pattern is seen 
at pH below ~3 for HCl and H+.  
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Vapor Fraction / Vapor Amount Survey 

The purpose of the Vapor Fraction/Vapor Amount Survey calculation is to set a specific fraction of the stream 
to the vapor phase, and compute the temperature or pressure required to achieve the specified Vapor 
Fraction/Vapor amount. 

Example 22: Seawater Evaporation 

Seawater contains a variety of salts, and when seawater evaporates, these solids are left behind. The most 
abundant salt in seawater is sodium chloride (NaCl) which is commonly referred to by its mineral name halite. 
 
You will evaporate seawater to dryness and look at the solids that form. What is interesting is the number of 
phases that can be produced when seawater evaporates, giving you a sense of how certain natural systems 
build up sediment of a particular nature. 
 
In this example we will also introduce the Object Library tool. 
 

Starting the Simulation 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Open the Object Library window – from the menu, View > Toolbar > 
Object Library. The Object Library appears on the right-hand side of the window. 
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냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Drag the Seawater (Molecular inflows) stream to the navigation 

panel (in the white space below the other streams and calculation objects) (Note: This object is in the AQ 

thermodynamic framework) 

 

The inputs and parameters are automatically populated when selecting the Seawater (molecular inflows) from 
the Object Library.   

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Click on the new Stream and press <F2> to change the name to 
Vapor Fraction Survey 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Go to the Add Calculation button and select Survey calculation 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Change the Survey name to Seawater Evaporation using the <F2> 
key  

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Select Vapor Fraction as Type of Survey 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 Click on the Specs button. This will open the Survey Options 
Window 
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냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 The default Vapor Fraction range is from 0-1 with an increment of 0.1. 
Change the Vapor Fraction Range to Survey End to 0.95. Set the Step Size to 0.05 increments. Then click 
OK. 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 We are ready to perform the calculation. Click on the Calculate button 
or press the <F9> key 

냮냰냴냷냸냺냽넁넄넇너넊넍넎넗 It is time to save your file (File >Save as…) or using the save icon in 
the tool bar. You can save under the same file that we created before named as Survey Calculations. 
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Analyzing the Results 

Click on the Plot tab (  ). The default plot is the Vapor Fraction plot (as the dependent variable) vs 
Temperature. It shows that seawater boils initially at 100⁰C, and at near complete evaporation (95%) the 
temperature is 109.4⁰C. 

 

We are also interested to know which solid phases precipitate as the water evaporates.  

Click on the Variables button 
Remove Temperature from the Y1 axis (double click or use the << button) 
Look for Solid section and click on the   box to show all the available species. Select the option Dominant 
Solids and put it in the Y1 Axis using the >> button or by double clicking. When you are done, click OK. 
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The default plot is not very easy to read because halite dominates the solids and because the units are in mg/l 

and the liquid volume decreases from left-to-right on the plot. To see the plot more clearly, right click on any 

number in the Y axis, and select the Logarithmic Scale option. 

 

Plot in semilogarithmic scale 
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As the water evaporates CaSO4, Mg(OH)2 and SrSO4 salts precipitate at all temperatures. NaCl and a 
Mg/SO4/OH double salt starts to precipitate at 95% vapor fraction.  
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Dual Surveys 

Dual Surveys allow you to study the effect of two independent variables on your system under study.  

The option for the dual survey is highlighted in the red box in the image below. There are three options available 
in the optional survey, Temperature, Pressure and Composition.  

You also have the option of varying the selected variables independently or together. We will explore this in 
more detail in upcoming examples.  
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Temperature and Pressure Survey 

In this type of survey two variables are adjusted simultaneously, temperature and pressure. This type of survey 
creates a matrix of results, which can then be interpreted using the plot function in different ways. 

Example 23: Dissolution of CO2 in water as a Function of Temperature and Pressure 

In Example 19, the dissolution of CO2 in water was studied only as a function of pressure. In this case, we are 
going to study the effect of both temperature and pressure on the CO2 dissolution.  

In this example the Contour Plot will be used to analyze the results. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Temperature and Pressure Survey Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name T/P Survey Pressure Range 5-100 atm 
Survey Name CO2 dissolution – T/P Step Size Increment by 5 atm 
Name Style Display Formula Temperature Range 5-100 ⁰C 
Unit Set Metric, Moles Step Size Increment by 5 ⁰C 
Framework  MSE-SRK Vary Independently 
  H2O 55.5082 moles 
  CO2 10 moles 

 
 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to T/P Survey 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Change the Survey name to CO2 dissolution T/P using the <F2> key  

Select Temperature and then by Pressure  

Click on the Temperature Specs button. This will open the Survey Options Window  
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Change the Temperature Range to 5-100 ⁰C. Set the Step Size to 5 ⁰C increments. 

Click on Var. 2 – Pressure, in the Category Window to define the Pressure Range.  

Change the Pressure Range to 5-100 atm. Set the Step Size to 5 atm increments. Then click OK. 

 

In the summary box, notice that a total of 400 points will be calculated. We are ready to perform the calculation. 

Click on the Calculate button or press the <F9> key 
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It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 

 

Analyzing the Results 

Click on the Plot tab (  ). The default plot is the phase amounts in grams of Liquid-1 (Aqueous Phase), 
Liquid-2 (Organic Phase), Solid and Vapor. 

We are interested in the solubility of CO2 in water, i.e., in the Liquid-1 phase. We can change the default plot to 
show the molecular CO2 dissolved in water (CO2-Liq1). 

Click on the Variables button. This will open the Select Data to Plot window.  

Double click or use the << button to remove the Phase Amount variables. 

Look for Liquid-1 and click on the  box to show all the available variables. 
Select CO2-Liq1 and put it in the Y1 Axis using the >> button. Then click OK. 
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The default plot now is showing the dissolved CO2 in the water (Liquid-1 Phase) in the Y1 Axis as function of 
pressure. Unfortunately, the legend is covering the plot.  

To move the legend to the side without interfering with the results, right click on any white space within the plot 

and Allow Layout Changes. This option allows you to select and reposition the plot.  

 

Resize the plot to make it smaller and create space for the legend. Drag the legend to the right.   
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As the temperature increases (at a fixed pressure) the solubility of CO2 decreases.  This is to be expected since 
at higher temperatures it is easy to overcome the vapor pressure and CO2 is released as gas. As the pressure 
increases (at a fixed temperature) the solubility of CO2 in solution increases. 

The plot above can be represented better using a Contour Plot. To convert the results into a contour plot view, 

simply click on the contour plot icon ( ).  

The resulting plot is now a pixilated color plot showing the moles of molecular CO2 dissolved in the Liquid-1 
(Aqueous) phase, at each T and P value. 

The number of moles of CO2 is characterized by a different color that is shown in the legend (maximum value 
is given in red, and minimum value is given in blue). You can mouse over any location in the plot and the moles 
of CO2 dissolved in the Liquid-1 phase at each T and P value will be shown in the left corner box. 

 

Note: The legend scale can also be optimized by either right-mouse-clicking on the Legend and selecting Options>Plot 
Options>Contour or clicking on the Options button in the upper right and selecting Contour. Both open to the Contour 

options window, where the color and range can be modified. 

In the contour plot, you can see the effect of both Temperature (x-axis) and Pressure (y-axis) on the solubility 
of CO2 in water. Higher solubilities are obtained at high pressures and low temperatures, while lower solubilities 
are obtained at high temperatures and low pressures. 
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Survey by changing the single point calculation type 

The sections presented so far have presented single and dual surveys. In addition to adjusting these survey 
variables, you can select one of several single point calculations embedded within the survey. The embedded 
single point calculations include Isothermal (default), bubble point, dew point, vapor amount, vapor fraction, set 
pH, precipitation point, composition point, and isochoric.  

 

Temperature Survey with a Precipitation Point Calculation 

In this Temperature Survey, the Calculation Type will be changed from Isothermal Calculation to Precipitation 
Point. This will allow us to model the solid solubility vs temperature. 

Example 24: Solubility of Halite as a Function of Temperature 

In this example, we are going to study the solubility of NaCl (halite) as a function of temperature.   

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Temperature Survey with a Precipitation Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Calculated 
Stream Name Solubility vs T Pressure 1 atm 
Survey Name Halite Solubility vs T Temperature Range 5-100 ⁰C 
Calculation Type Precipitation Point Step Size Increment by 5 ⁰C 
Name Style Display Formula H2O 55.5082 moles 
Unit Set Metric, Moles NaCl 0 moles 
Framework  MSE   

Add a new Stream 
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Click on the new Stream and press <F2> to change the name to Halite Solubility vs T and P 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Change the Survey name to Halite Solubility vs T using the <F2> key  

Select Temperature as the type of survey  

Click on the Temperature Specs button. This will open the Survey Options Window 

Change the Temperature Range to 0-100 ⁰C. Set the Step Size to 5 ⁰C increments. 

Click on Calculation Type, in the Category Window to define the Type of Calculation 

Under Type of Calculation Change the Default Isothermal to Precipitation Point (use the drop-down arrow) 

Select NaCl (Halite)-Sol as the Solid Precipitate and NaCl as the Adjusted Inflow. Then click OK. 
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The Calculation Parameters section is now shown in the Definition Tab, highlighting the Precipitant (NaCl 
(Halite)) and the Adjusted Inflow (NaCl). 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 

 

Analyzing the Results 

Click on the Plot tab (  ). The default plot is the amount of NaCl in moles added to 1 kg of water before 
Halite precipitates as a function of Temperature.  

 

Halite solubility increases slightly with temperature, from 6.16 moles/1kg H2O at 25⁰C to 6.68 moles/1kg H2O 
at 100⁰C.   
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Example 25: Solubility of Halite as a Function of Temperature and Pressure 

The effects of pressure on mineral solubility is generally less important than temperature. There is still an effect 
that can be observed. The same stream created on Example 24 will be used. 

Starting the Simulation 

 

Under the Solubility vs T stream add a new Survey (see Stream information in Example 24) 

Change the Survey name to Halite Solubility vs T and P using the <F2> key 

Select Survey by Temperature and then by Pressure (This is a dual survey) 

Click on the Temperature Specs button. This will open the Survey Options Window 

Change the Temperature Range to 0-100 ⁰C. Set the Step Size to 5 ⁰C increments. 

Click on Var. 2 – Pressure, in the Category Window to define the Pressure Range. 

Change the Scale to Log, change the Pressure Range from 1 to 1000 atm, and set the Number of Steps to 

3 (i.e. it will plot the following pressures: 1, 10, 100 and 1000 atm). Then click OK. 

 

Click on Calculation Type, in the Category Window to define the Type of Calculation 

Under Type of Calculation Change the Default Isothermal to Precipitation Point (use the drop-down arrow) 

Select NaCl (Halite)-Sol as the Solid Precipitate and NaCl as the Adjusted Inflow. Then click OK. 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 
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Analyzing the Results 

Click on the Plot tab (  ). The default plot is the amount of NaCl in moles added to 1 kg of water before 
Halite precipitates as a function of Temperature.  

 

The effect of pressure is significant between 100 and 1000 atm relative to the effects between 1 and 100 atm.  

We can also present the Halite Solubility using a Contour Diagram. It would be ideal to define a finer range of 
temperature and pressure.  

Return to the Definition Tab 

Click on the Temperature Specs button.  

Change the Temperature Range to 0-150 ⁰C. Set the Step Size to 2 ⁰C increments. 

Click on Var. 2 – Pressure, in the Category Window to define the Pressure Range. 

Change the survey to Linear scale, change the Pressure Range from 20 to 1000 atm, and set the Step Size 

to 20 atm increments. Then click OK. 

Note: In the Summary box we can see that survey creates a matrix of 75 steps x 49 steps for a total of 76 
temperature and 50 pressure points, or 3800 points in total. 

Click the Calculate button. This calculation will take a few minutes to compute. 

Click on the Plot tab and change the Plot to contour ( ). 
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The solubility is shown to increase as temperature and pressure increase. The increase is up to 50% from the 
low values. A few of the points failed to converge at the low temperature and high-pressure conditions (shown 
in gray). 
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Composition Survey with a Bubble and Dew Point Calculation 

In this Composition Survey, the Calculation Type will be changed from Isothermal Calculation to Bubble and 
Dew Point calculations. This will allow us to model the vapor liquid equilibria (VLE) of mixtures.  

Example 26: Ethanol-Water Azeotrope 

In this example, you are going to calculate both the bubble point and dew points as a function of Ethanol-Water 
composition. 

The two data sets will then be transferred to a spreadsheet where the curves will be plotted together to locate 
the azeotrope. You will need a spreadsheet/plotting software to complete this case. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Composition Survey with a Bubble and Dew Point Calculation 
Calculation Settings Stream Composition and Conditions 

Calculation Type Survey Stream Amount Default – 1kg 
Stream Name Composition survey - Azeotrope Pressure 1 atm 
Survey Name Ethanol-Water Azeotrope Temperature It will be calculated 
Calculation(s) Type Bubble Point / Dew Point H2O 100 mass % - default 
Name Style Display Name Ethanol 0 mass% 
Unit Set Metric, Mass Frac. Composition Range 0 -100 mass% 
Framework  MSE Step Size Increment by 2 mass%  

 

Calculating the Bubble Point  

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Composition survey - Azeotrope 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Display Name option 

Click on the Units Manager Icon, and select Metric, Batch, Mass Frac.  

Enter the composition of the stream given in the table above 

Go to the Add Calculation button and select Survey calculation 

Select Composition as the type of survey  

Change the Survey name to Ethanol-Water Azeotrope using the <F2> key 

Click on the Composition Specs button. This will open the Survey Options Window  
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Under the Component tab, select Ethanol  

Click on the Survey Range tab. Change the Composition Range to 0-100 mass%. Set the Step Size to 2 

mass% increments. 

  

Click on Calculation Type, in the Category Window to define the Type of Calculation 

Under Type of Calculation Change the Default Isothermal to Bubble Point (use the drop-down arrow). Then 

click OK.  
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We are ready to perform the calculation. Click on the Calculate button or press the <F9> key. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named as Survey Calculations. 

 

Analyzing the Results  

Click on the Plot tab ( ). The default plot is the bubble point temperature vs the mass fraction ethanol. 
As the mass% of ethanol increases the bubble point temperature decreases.  

 

You have 3 different options to retrieve this data to use in your preferred plotting software. 

Option 1: Right-click on the white region of the plot to open the drop-down menu and select Copy. 
 
Option 2: Right-click on the white region of the plot to open the drop-down menu and select Export CSV. 
 
Option 3: Click on the View Data button, select all data by clicking on the upper left corner of the table, and 

copy the data using Ctrl+C. 
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In this case let’s use Option 1. Right click and Copy the data, then open your preferred plotting tool and Paste 
the data. 

Calculating the Dew Point  

Return to the Definition tab 

Click on the Composition Specs button. This will open the Survey Options Window 

Click on Calculation Type, in the Category Window to define the Type of Calculation 

Change the calculation type to Dew Point (use the drop-down arrow). Then click OK.  

Recalculate, and click on the Plot tab 

Right click and Copy the data, then open your preferred plotting tool and Paste the data 

Plot the two temperature curves vs mass% of ethanol and format as needed 

 

 

The azeotrope occurs at about 95% ethanol where the two curves intersect, at 78.15 ⁰C. 
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Section 3. Water Analysis (Ionic Inputs) 

OLI Studio: Stream Analyzer can accept two input types: molecular inflows and ionic inflows. 

Sections 2 and 3 focused on molecular inflows. In this section, we will focus on ionic inflows, and we will learn 
how to enter cations and anions using the object called Water Analysis. Additionally, we will show how the 
reconciled sample can be converted into a molecular representation. 
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Basic Terminology 

When reviewing laboratory analysis of water samples, it is quite common for the positive ions (cations) and the 
negatively charged ions (anions) in solution to not balance. This may be due to the precision limits of the various 
experimental procedures used to measure the ions - i.e., some ions may not have been analyzed. These 
solutions must have a neutral charge. Stream Analyzer will adjust/modify inflows in order to balance the charges 
and make the solution neutral. This adjusting procedure is referred to as Reconciliation.   

The pH and the alkalinity of the solution are frequently measured.  However, since the analysis is experimental 
and subject to errors, the pH and alkalinity values that are calculated by the Water Analysis tool may be different 
from what is measured experimentally. Stream Analyzer can also reconcile this difference. 

Scaling  

Scaling is the deposition of a mineral salt on processing equipment. Scaling is a result of supersaturation of 
mineral ions in the process fluid. Through changes in temperature, or solvent evaporation or degasification, the 
concentration of salts may exceed the saturation, leading to a precipitation of solids (usually crystals). The 
saturation level of a salt in water is a good indicator of the potential for scaling. 
 
The potential for scaling is calculated using the solubility product constant ሺ𝐾௦௣ሻ and Ion Activity Product ሺ𝐼𝐴𝑃ሻ 
definitions.  
 
Solubility Product Constant, 𝑲𝒔𝒑 

The solubility of ionic compounds of salts and minerals in water are governed by a solubility equilibrium 
expression and a solubility product constant known as 𝐾௦௣. It is important to note that the solubility product, 𝐾௦௣ 
is a function of both temperature and pressure. Consider the general dissolution reaction below (in aqueous 
solutions): 
 

𝑎𝐴ሺ௦ሻ ⇌ 𝑏𝐵ሺ௔௤ሻ ൅ 𝑑𝐷ሺ௔௤ሻ 
 
With equilibrium constant 𝐾௦௣ defined as: 

𝐾௦௣ ൌ ሺ𝑎஻ሻ௕  ∙ ሺ𝑎஽ሻௗ 
 
Where, 𝑎஻ and 𝑎஽ are the activities of the aqueous species. The activity of any species 𝑖 is defined as the 
product of its concentration in molality by its corresponding activity coefficient:  
 

𝑎௜ ൌ 𝑚௜𝛾௜ 
 
Ion Activity Product, 𝑰𝑨𝑷 

A real solution may not be in the state of equilibrium. This non-equilibrium state is described by the ion activity 
product ሺ𝐼𝐴𝑃ሻ. It has the same form as the equilibrium constant 𝐾௦௣, but involves the actual activities of the 
species in solution.  

𝐼𝐴𝑃 ൌ ሺ𝑎஻ሻ௔௖௧௨௔௟
௕ ∙  ሺ𝑎஽ሻ௔௖௧௨௔௟

ௗ  
 
Scaling Tendency and Scale Index 

The Scaling Tendency ሺ𝑆𝑇ሻ is defined as the ratio of the Ion Activity Product ሺ𝐼𝐴𝑃ሻ divided by the equilibrium 
constant ሺ𝐾௦௣ሻ.  
 

𝑆𝑇 ൌ
𝐼𝐴𝑃
𝐾௦௣

                                                  𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 ሺ1ሻ 
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Scaling tendencies are essentially saturation ratios. Thus, if  
 

𝑆𝑇 ൏  1 Indicates sub-saturation, and the solid is not expected to form 
𝑆𝑇 ൌ  1 Indicates saturation, and the solid is in equilibrium with water 
𝑆𝑇 ൐  1 Indicates supersaturation, and solids will form 

 
The Scale Index (SI) (aka: Saturation Index in the literature), is given by the following relationship: 
 

𝑆𝐼 ൌ logଵ଴ ቆ
𝐼𝐴𝑃
𝐾௦௣

ቇ                                                   𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 ሺ2ሻ 

Thus, if 
𝑆𝐼 ൏  0 Indicates sub-saturation, and the solid is not expected to form 
𝑆𝐼 ൌ  0 Indicates saturation, and the solid is in equilibrium with water 
𝑆𝐼 ൐  0 Indicates supersaturation, and solids will form 

 

Pre-scaling Tendency and Scale Index 

Pre-Scaling tendency is defined as the scaling tendency before any solids are formed (this can be seen as all 
the species suspended in solution). The same equations (Equations 1 and 2) are used for calculating ST and 
SI. 

The Pre-Scaling tendency is reported in the software as Pre-Scale, with its respective SI, index.  

Difference between Post-scale and Pre-scale 

Pre-Scale: The saturation ratio before solids precipitate.  

Post-Scale: The saturation ratio after solids precipitate (if solids are selected).  

Another way to interpret these two definitions is: 

Pre-Scale represents the condition before any solids are allowed to form. This is a non-equilibrium condition 
and can be viewed as the condition where 𝑡𝑖𝑚𝑒 ൌ 0. 

Post-Scale Tendency is the saturation ratio after all potential solids come to equilibrium with water. This is the 
true equilibrium condition ሺ𝑡𝑖𝑚𝑒 ൌ ∞ሻ.  

 

Example 27: Calculation the Scaling Tendency and the Scale Index of 𝑪𝒂𝑺𝑶𝟒 ∙ 𝟐𝑯𝟐𝑶 

Let’s calculate the Scaling Tendency and the Scale Index of 0.01 moles of gypsum ሺ𝐶𝑎𝑆𝑂ସ ∙ 2𝐻ଶ𝑂ሻ dissolved in 
1 kg of water at 25⁰C and 1 atm.  

The equilibrium expression for the dissolution reaction is: 

𝐶𝑎𝑆𝑂ସ ∙ 2𝐻ଶ𝑂 ⇌  𝐶𝑎ଶା  ൅  𝑆𝑂ସଶି  ൅  2𝐻ଶ𝑂 

Where, 𝐾௦௣ ൌ 3.2 ൈ 10ିହ 
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The molal concentration and the activity coefficients for each one of the species are:  

ሾ𝐶𝑎ାଶሿ ൌ 0.0093 𝑚 𝛾஼௔శమ ൌ 0.4663  

ሾ𝑆𝑂ସିଶሿ ൌ 0.0093 𝑚 𝛾ௌைరషమ ൌ 0.4663 

𝑎ுమை ൌ 0.9997 

 

Calculating the IAP 

With the information given above, we can calculate the IAP as follows: 

𝐼𝐴𝑃 ൌ 𝑎஼௔శమ ∙ 𝑎ௌைరషమ ∙ ൫𝑎ுమை൯
ଶ
 

𝐼𝐴𝑃 ൌ ሺ𝑚஼௔శమ  𝛾஼௔శమሻ ∙ ቀ𝑚ௌைర
షమ  𝛾ௌைరషమቁ ∙ ൫𝑎ுమை൯

ଶ
 

𝐼𝐴𝑃 ൌ ሺ0.0093 ൈ 0.4663ሻ ∙ ሺ0.0093 ൈ  0.4663ሻ ∙ ሺ0.9997ሻଶ 

𝐼𝐴𝑃 ൌ 1.879 ൈ 10ିହ 

Calculating the Scaling Tendency 

𝑆𝑇 ൌ
1.879 ൈ 10ିହ

3.2 ൈ 10ିହ
 

 
𝑆𝑇 ൎ 0.587 

This result indicates that the solution is under-saturated with respect to calcium sulfate. 

Calculating the Scaling Index 

𝑆𝐼 ൌ logଵ଴
𝐼𝐴𝑃
𝐾௦௣

ൌ logଵ଴ 𝑆𝑇 

 
𝑆𝐼 ൌ logଵ଴ሺ0.587ሻ 

 
𝑆𝐼 ൎ െ0.231 

 

Entering Data for Water Analysis 

The grid for water analysis has 5 different grids where we need to enter information: Analysis Parameters, 
Recorded Properties, and Neutrals, Total Ions, Cations and Anions concentration in solution. 

The Analysis Parameters grid is where you enter the conditions at which the sample properties were 
measured. The default values are 1 L, 25oC and 1 atm. 
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The Recorded Properties grid is where you enter the laboratory measured properties of the solution. These 
are: Total Dissolved Solids (TDS), Measured pH, Measured Alkalinity, Measured Total Inorganic Carbon (TIC), 
Density, and Specific Electrical Conductivity. You can always change the units of these properties by clicking 
on the units highlighted in blue. This action will open the Units Manager Window.  

 

The concentration of Neutrals, Total Ions, Cations and Anions is entered in the section. The Water Analysis 
grid comes already prepopulated with some of the most common cations, anions, and neutrals species found 
in laboratory water analyses. If your species is not present in the prepopulated grid, simply click on the white 
grid and type the ion or neutral of interest. If it is a cation, type the element followed by a plus (+) sign and the 
corresponding oxidation state, e.g. Cu+2. If it is an anion, type the element followed by a minus (-) sign and 
the corresponding oxidation state, e.g. Br-1. If it is a neutral, simple type the species either using the formula 
name or its name, as has been shown in the previous sections. 

 

The Water Analysis grid also contains search aids to find a specific cation or anion. The first search aid is the 
drop list located in each the cation, anion, and neutral grid sections. The list is alphabetic and is activated using 
the drop-down arrow within the cell, after the first few letters of the ion is typed. 



 

think simulation | getting the chemistry right 183 

 

 

If a name is misspelled or if the text is unrecognized, then a red ‘X’ appears to the left of the name. This name 
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry 
(which will turn black) and hit the key <Delete>.  

 

 

Water Analyses - Reported Elements as Total Ions 

Water analysis data obtained from ICP measurements will contain concentrations for B, P, S, and Si. These 
elements do not exist in the water, rather they exist as dissolved ions. If they are part of your analysis, then you 
should convert them to the following before entering them into the Water Analyses object. Some of these ions 
are already entered into the Total Ions section, and the software will do the conversion automatically. 

Converting element concentration to species for Brine or Water Analysis 

ICP data Aqueous Species Formula to enter Formula weight multiplier 

B, boron Boric Acid H3BO3 B (mg/l)  5.72 = H3BO3 (mg/l) 

Si, Silicon Silica SiO2 Si (mg/l)  2.14 = SiO2 (mg/l) 

P, Phosphorus Dihydrogen Phosphate H2PO4-1 P (mg/l)  3.13 = H2PO4 (mg/l) 

S, Sulfur Sulfate or Sulfide 
HS-1 or SO4-2 

(Cannot tell from total S only) 

S (mg/l)  1.03 for HS-1 (mg/l) 

or 

S (mg/l)  3.0 for SO4-2 (mg/l) 

A Basic Water Analysis 

A brief introduction to the water analysis tool will be shown in the example below. As we go through the example, 
the basic definitions, functionalities, and reporting for the Water Analysis tool will be introduced.  
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Example 28: Ground Water Analysis 

Will calculate the pH and density of a Ground Water sample based upon its measured composition at 1 atm 
and 25 ⁰C. Then we will create a molecular stream based on the ionic inflows.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the water analysis. Certain inputs, such as the 
name style, units, etc. will require further adjustments, and will be described as necessary.  

Ground Water Analysis 
Analysis Parameters/Settings Recorded Properties 

Stream Amount 1 L (Default) Total Dissolved Solids Not recorded 
Temperature 25 ⁰C Measured pH 6.7 
Pressure 1 atm Measured Alkalinity Not recorded 
Name Style Display Formula Density Not recorded 
Unit Set Metric, Batch, 

Concentration 
Specific Electrical 
Conductivity 

Not recorded 

Framework  MSE   
Calculation Type Water Analysis   
Analysis Name Basic Water Analysis   

Composition 
Neutrals (mg/L) Cations (mg/L) Anions (mg/L) 

CO2 150 Na+1 1060 Cl-1 3896 
H2S 15 K+1 50 SO4-2 54 
NH3 5 Ca+2 773   
  Mg+2 177   
  Sr+2 0.18   
  Ba+2 0.46   
  Fe+2 62.1   
  Mn+2 2.80   
  Al+3 0.74   

 

Setting the Water Analysis 

Add a Water Analysis 

Click on the new Water Analysis and press <F2> to change the name to Basic Water Analysis 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Concentration (it may be defined by default) 

Under the Analysis Tab, enter the Analysis Parameters, Recorded properties, and composition of the water 

given in the table above.  

Go to the Add Reconciliation button of the top right corner or select Add Reconciliation from the Actions 

Panel.  
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Note: You may notice that after selecting Add Reconciliation option, the navigator panel displays a sub-stream 
called Reconcile, and this Reconcile sub-stream opens a new tab named Reconciliation. The Reconcile sub-
stream copies the original inputs entered in the Water Analysis. Any changes made in the sub-stream will not 
change the original Water Analysis. 

Additionally, four different types of reconciliation are enabled in the upper right corner of the window: (1) No 
Reconcile, (2) Reconcile pH, (3) Reconcile pH/Alkalinity, and Reconcile pH/Alkalining/TIC . These types of 
reconciliation will be described in more detail later in the next section. 

The selected default calculation is No Reconcile. This option means that the software will compute the water 
properties based on the current concentration of neutral, cations, and anions species. The calculation will not 
use the measured pH, or the measured alkalinity entered (if any).  
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The Calculate Alkalinity box ( ) allows you to compute the alkalinity, also based on the 
concentration entered.  

Select the No Reconcile option 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. Create a new file and name 

it: Water Analysis Calculations. 
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Analyzing the Results 

Viewing the Summary Box 

Review the Summary Box. Let’s analyze it in detail since it contains several pieces of important information, as 
shown in the image below. 

 

The top section contains the charge balance information showing the total equivalent charge (positive and 
negative), and the charge imbalance. This example has a negative imbalance of -8.07210-3 eq/L, indicating 
that more cations are needed in solution in order to reach electroneutrality. The software calculates that 185.568 
mg/L of Na+ are needed to balance the solution. The software adds this amount of Na+ to the solution. This 
information can be further confirmed in the Report Tab in the Charge Balance table. 

The calculation type information shows the calculation type the software used. In this example, the software 
performed a default isothermal calculation at 25 ⁰C and 1 atm. If we selected other calculation specifications, 
they would appear here. 

The phase amounts information shows the distribution of species in the different phases. This analysis 
contains two phases: aqueous and solid.  

The aqueous properties information shows the computed pH, ionic strength, and density of the solution. It is 
important to note here that the measured pH is 6.70 and the computed pH is 4.47. The density of this solution 
is 1.00198 g/ml. Remember, for this example the software used only the concentration of neutrals, cations, and 
anions in solution to do a reconciliation.  
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Viewing the Molecular Basis Tab 

Let’s review the Molecular Basis Tab. The Molecular Basis tab is one of several tabs of the Reconciliation 
object. The information contained in this tab is the molecular composition of the solution after it has been 
reconciliated. In other words, the software has converted the ionic inflows into a molecular stream. 

 

Note: The software generates molecular concentrations based on two priorities. The first priority is to create 
the least number of molecular inflows. This example contains eighteen inflows (plus H2O not shown). The 
second priority is to create the least number of total moles. Moles are not shown here, since the units are mg/l. 
The moles are shown in the Report tab. 

You can use this molecular form as a new Stream in OLI Studio, by using the Add as Stream button, or it can 
be exported to a separate software like OLI Flowsheet: ESP , Aspen Plus, UniSim Design, or other simulators.  
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Converting the Ionic Inflows into a Molecular Stream 

For practice, let’s add this Molecular Basis as a Stream into the Navigator Panel.  

Click on the Add as Stream button. This will open a new window 

 

Note: By default, the name of the stream is Molecular Export of Reconcile. You can change the name if you 
prefer. Additionally, you can include or exclude the phases that you want to export into your stream by checking 
or unchecking the corresponding boxes. 

Leave the defaults and click OK. The program automatically adds a new stream in the navigation panel. 
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Viewing the Report Tab 

The Report tab is slightly different from the Single Point report described in Section 1. This Report contains 
three additional tables, all of which are located at the top. These tables are the Reconciliation Summary, Stream 
Inflows, and Charge Balance. 

 

The Reconciliation Summary table confirms the specifications for the reconciliation such as the charge 
balance method and the reconciliation type (these concepts will be discussed in more detail later in the manual). 
Additionally, shows the conditions at which the calculation was run, in this case 25⁰C and 1 atm. And finally, 
shows a comparison between the measured and calculated properties, in this case it shows the measured vs 
calculated pH. 

 

The Stream Inflows table summarizes all the species that were entered in the water analysis grid. 
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The Charge Balance table contains the concentrations entered and the final balanced values. In this case only 
the sodium (Na+1) concentration was changed.  
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Exploring Reconciliation Options 

When reconciling a Water Analysis, there are three options for reconciliation: 

No Reconcile: The software will run an electroneutrality reconciliation only, and then compute the water 

properties such as pH, density, etc., based on the entered concentration of neutral, cations, and anions species. 

In the No Reconcile option you may allow the program to pick the species to adjust for electroneutrality or 

you may manually choose the species to perform the adjustment. (See electroneutrality options). 

 

Reconcile pH: The software will run both an electroneutrality and pH reconciliation. This type of reconciliation 

will match your recorded pH. Additionally, the software will compute the water properties such as, density, 

electrical conductivity, etc. The pH of the solution is automatically adjusted by the software by adding either 

HCl or NaOH, or you may select your preferred acids and bases to adjust the pH. 

 

Reconcile pH/Alkalinity: The software will run an electroneutrality, pH and alkalinity reconciliation. This type 

of reconciliation will match your recorded pH and alkalinity values. Additionally, the software will compute the 

water properties such as density, electrical conductivity, etc. The pH of the solution is automatically adjusted 

by the software by adding either HCl or NaOH or you may select your preferred acids and bases to adjust the 

pH. The Alkalinity is automatically adjusted by the software, using CO2 as the alkalinity titrant, H2SO4 as the 

alkalinity pH titrant and 4.5 as the alkalinity end point pH. 

 

Reconcile pH/Alkalinity/TIC: The software will run an electroneutrality, pH, alkalinity and Total Inorganic 

Carbon (TIC) reconciliation. This type of reconciliation will match your recorded pH, alkalinity and TIC values. 

Additionally, the software will compute the water properties such as density, electrical conductivity, etc. The TIC 

is automatically calculated by the software, using CO2 as the titrant, H2SO4 as the alkalinity pH titrant and 4.5 

as the end point pH. The (total) Alkalinity is adjusted by the software by adjusting the acetate concentration 

(organic acids) to match the target Alkalinity. The Alkalinity is adjusted by adding or removing acetic acid. In 

this calculation, you cannot change the CO2 or Acetic Acid for the alkalinity adjustment, these are fixed by the 

software. 

Additionally, there is the option to Calculate Alkalinity: . It is important to note, that this is only 
an alkalinity calculation based on the concentration entered, it is not an alkalinity reconciliation.   

We will explore the different types of reconciliation and introduce the different specification options according 
to the reconciliation type. 

In this section we will create a new file. We will run a basic water analysis, from which the various reconciliation 
options will be explored.  
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Example 29: Water Analysis – No Reconcile Option 

In this example we will calculate the pH and different properties of a Produced Water sample based upon its 
measured composition at 1 atm and 25 ⁰C.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the water analysis. Certain inputs, such as the 
name style, units, etc. will require further adjustments, and will be described as necessary.  

Water Analysis – Reconcile Options 
Analysis Parameters/Settings Recorded Properties 

Stream Amount 1 L (Default) Total Dissolved Solids 36500 mg/L 
Temperature 25 ⁰C Measured pH 7.8 
Pressure 1 atm Measured Alkalinity 160 mg HCO3/L 
Name Style Display Formula Density 1.013 
Unit Set Metric, Batch, 

Concentration 
Specific Electrical 
Conductivity 

Not recorded 

Framework  MSE   
Calculation Type Water Analysis   
Stream Name Water Analysis – 

Reconcile Options 
  

Composition 
Neutrals (mg/L) Cations (mg/L) Anions (mg/L) 

SiO2 16 Na+1 10000 Cl-1 19000 
  Ca+2 500 SO4-2 2700 
  Mg+2 1200 HCO3-1 142 
  Sr+2 200 AsO4-3 12 
  Ba+2 5 CHO2-1 20 
  Fe+2 5 C2H3O2-1 50 

 

Calculating the pH 

Setting the Water Analysis  

Add a Water Analysis 

Click on the new Water Analysis and press <F2> to change the name to Water Analysis – Reconcile Options 

Select the MSE thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Concentration (it may be defined by default) 

Under the Analysis Tab, enter the Analysis Parameters, Recorded properties, and Composition of the water 

given in the table above.  
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Go to the Add Reconciliation button of the top right corner or select Add Reconciliation from the Actions 

Panel, and name it No Reconcile. 

Select the No Reconcile option (selected by default) 
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Note: In the No reconcile option, the software runs an electroneutrality reconciliation. The type of balance 
for reconciling electroneutrality is the Dominant Ion method. You can select different types of balance for 
electroneutrality by clicking on the Specs button. 

 

Types of Balance for Electroneutrality 

Click on the Specs button. This will open a new window. 

 

There are 7 different Types of Balance: 

Dominant Ion: This is the default method. The largest counter ion is used to adjust the electroneutrality. In our 
example,747.753 mg/L of Na+1 are added since there is an excess of negative charge (see the above image). 

 
Prorate: This option keeps the relative amount of the counter ions (for this example, the cations) the same and 
are adjusted up or down equally until reaching electroneutrality.  
 
Prorate Cations: All cations are adjusted up or down equally 

 
Prorate Anions: All anions are adjusted up or down equally  
 
Na+/Cl-: Sodium is added when there is an excess of negative charge. Chloride is added when there is an 
excess of positive charge. 
 
Make-up Ion: This option allows for a single ion species to be adjusted. User selects an ion to increase or 
decrease.  
 
User Choice: The software determines if an anion or cation is needed to balance the solution and the user 
choses the specific ion.   
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Keep the default option, Dominant Ion, as the balance type then press OK 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named Water Analysis Calculations. 

 

Analyzing the Results 

Once you run the simulation there are two options to analyze the results: The summary box and the Report  

1. Go to the Report Tab and look at the Reconciliation Summary Table.  

 

The calculated pH and density are different to the measured values. The software only used the concentration 
data to calculate these properties.   
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Example 30: Water Analysis – pH Reconcile Option 

In this example we will reconcile the sample by pH and also calculate the alkalinity of the same Produced 
Water sample used in the previous Example 29: Water Analysis – No Reconcile Option. 

Starting the Simulation 

Under the Water Analysis – Reconcile Options Stream go to the Add Reconciliation button 

Click on the new Reconcile-1 icon and press <F2> to change the name to Reconcile pH 

The default units, names and framework have been previously defined 

Select the Reconcile pH option 

.  

Note that by selecting the Reconcile pH option, now the measured pH is a fixed value (and brown dot appears 
in front of this cell). To match the measured pH, the software added a Calculation Parameters section which 
indicates the acid and basic pH titrants to adjust the pH. By default, HCl and NaOH are selected by the software. 
This is similar to the set pH single point calculation. 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named Water Analysis Calculations. 
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Analyzing the Results 

1. Go to the Report Tab and look at the Reconciliation Summary Table.  

 

The measured and calculated pH are the same. The software added 44.6585 mg/L of NaOH to match the 
experimentally measured pH.  
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Calculating Alkalinity 

Now we will instruct the software to calculate Alkalinity. 

Go back to the Reconciliation Tab and check the Calculate Alkalinity box. 

 

Notice that by selecting the Calculate Alkalinity box two more rows were added to the Calculation Parameters 
section: Alkalinity pH Titrant and Alkalinity End Point pH, besides the pH titrants rows. These two new rows 
indicate that the software will add H2SO4 (selected by default) until the pH reduces to 4.5. The software then 
converts the amount of additional H2SO4 into the alkalinity value. 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key. 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.  
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Analyzing the Results 

1. Go to the Report Tab and look at the Reconciliation Summary Table.  

 

The calculated alkalinity value is different to the measured value. This is because the software is not doing an 
alkalinity reconciliation, rather the software is using only the concentration data to calculate alkalinity. You can 
see this as single point alkalinity calculation. 

Note that in this example, the alkalinity being reported because we checked the Calculate Alkalinity box; if the 
box wasn’t checked we would not see the calculated value in the Reconciliation Summary table. 
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Example 31: Water Analysis – Reconcile pH/Alkalinity Option 

In this example we will reconcile the sample by pH and alkalinity and also calculate the pre-scaling 
tendencies of the same Produced Water sample used in the previous Example 29: Water Analysis – No 
Reconcile Option. 

Starting the Simulation 

Under the Water Analysis – Reconcile Options Stream go to the Add Reconciliation button 

Click on the new Reconcile-1 icon and press <F2> to change the name to Reconcile pH/Alkalinity 

The default units, names and framework have been previously defined 

Select the Reconcile pH/Alkalinity option 

 

Note that by selecting the Reconcile pH/Alkalinity option, now both the measured pH and alkalinity values are 
fixed values (and brown dot appears in front of this cell). 
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To match the measured alkalinity value, the software added a Calculation Parameters section which indicates 
the alkalinity titrant and the pH titrant used to adjust the alkalinity. CO2 is used by default as the alkalinity titrant. 
This is similar to an alkalinity single point calculation. 

To match the measured pH, the software also added a Calculation Parameters section which indicates the 
acid and basic pH titrants to adjust the pH. By default, HCl and NaOH are selected by the software. This is 
similar to the set pH single point calculation. Also notice that the alkalinity box is grayed out. This is because 
we have asked the software to match the measured alkalinity value. This means that calculated alkalinity value 
is no longer needed. 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 

same file that we created before named Water Analysis Calculations. 

 

Analyzing the Results 

1. Go to the Report Tab and look at the Reconciliation Summary Table.  

  

The measured and calculated pH and alkalinity values are the same. The software added 14.9320 mg/L of HCl 
to match the experimentally measured pH and removed 35.0147 mg/L of CO2 to match the experimentally 
measured alkalinity value. 
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Calculating Pre-scaling Tendencies 

Now we will instruct the software to calculate Pre-scaling tendencies. In OLI Studio: Stream Analyzer, Pre-
scaling tendencies are turned OFF by default. We need to enable this option. 

Setting the Water Analysis  

Go back to the Reconciliation tab of the Reconcile pH/Alkalinity water analysis 

Click on the Calculation Options icon . This will open the Calculation Options window. 

Check the Pre-scaling Tendencies box and select the Rigorous method. Then click OK. 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
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It is time to save your file (File >Save as…) or using the save icon in the tool bar.  
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Analyzing the Results 

1. Go to the Report Tab and search for the Scaling Tendencies Table.  

 

This table reports both the Post-Scale and Pre-scale Tendencies. See the section 3.1 Basic Terminology to see 
a more detailed explanation.  

The Scaling Tendencies (reported in the software as Post-Scale), are essentially saturation ratios. When the 
scaling tendency for a given mineral is equal to 1.0 (saturation conditions) it indicates that the mineral is in 
equilibrium with water, a solid phase has formed. A scaling tendency below 1.0 indicates sub-saturation and 
that the solid phase will not form. A solid is at risk of forming when the scale tendency value is greater than 1.0 
(supersaturation conditions). 

The Pre-Scaling Tendencies (reported in the software as Pre-Scale), is defined as the scaling tendency before 
any solids are formed (this can be seen as all the species suspended in solution).  

Note: The Post-Scale and the Pre-Scale tendencies are equivalent if the solid phase is turned OFF. 
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Section 4. Hydrocarbons and Pseudocomponents 

So far, we have learned how to enter molecular and ionic inflows in Stream Analyzer. Stream Analyzer also 
allows you to enter assays or pseudocomponents in order to enter crude oils as streams.  

Crude oils are complex groups of organic molecules containing hundreds, perhaps thousands of pure 
components in a single oil. Modeling crude oils using pure components is impractical, because analyzing for 
each pure component is cost prohibitive and the number of species would make calculations overwhelming. A 
convenient solution to this problem and to modeling the properties of a crude oil is to create pseudo 
components. 

Crude Oil properties may be defined through a distillation curve, where each boiling point range is a progression 
of molecular weights, densities, solubilities, viscosities, and other properties associated with that section. It is 
reasonable for low boiling point molecules to be low molecular weight, low density, low viscosity, and more 
soluble in water. We can dice boiling point curves using well accepted methods standard to create 
pseudocomponents that in combination reflect the property of the whole oil.  

There are two ways to create a crude oil stream on Stream Analyzer: 

The first is to start with a PVT curve and create pseudocomponents using one of the three thermodynamic 
methods coded into the software. 

 
The second is to enter the pseudocomponent data directly and using the same thermodynamic methods to 
predict the component properties. 

The three thermodynamic methods are: API, Lee Kesler, and Cavett. More details about this method can be 
found in Section 11. . 

A brief introduction of how to enter PVT curves and/or pseudocomponents will be shown in the examples below.  

 

Entering a PVT Analysis 

Example 32: Creating an Assay 

In this example, we are going to learn how to enter a simple PVT analysis in order to create a Crude Oil Stream. 

Starting the Simulation 

Add a new Stream 
Click on the new Stream and press <F2> to change the name to Crude Oil 
Select the MSE-SRK thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the conditions of the Stream T= 25 ⁰C and 1 atm 

 
Crude Oil Stream 

Calculation Settings Conditions 
Stream Name Crude Oil Stream Amount Default 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Moles Pressure 1 atm 
Framework  MSE-SRK   
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In the inflows grid, in the white cell below H2O, type ASSAY and then press <Shift + Enter>. You can assign 
other name to your Assay; however, you are limited to 5 characters for the name of the Assay. 

 
Note: The <Shift + Enter> action instructs the software to create an Assay rather than look for a species 
or pure component from the database. 

 

Note: After typing the name of your Assay, immediately press Shift + Enter command keys together. 

 

Use the information provided in the table below to complete the grid. 
 

Assay Information 
Calculation Settings Distillation Data 

Assay amount 1000 moles Volume % Temperature, ⁰C 
Assay Data Type ASTM D86 1 20 
Average Bulk Density Type API Gravity 5 30 
API Gravity 40 10 50 
Distillation Curve Cuts 10 20 60 
Distillation Data See next two columns 40 80 
Thermo Method API-8 60 120 
  80 150 
  90 180 
  95 200 
  99 220 
  100 240 

 

 

 

 

 

Your screen should look like the image below: 
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Note: You can change the Assay Data Type, the Average Bulk Density Type and the Thermo Method options by 
clicking on the white cells. This will enable a drop-down arrow that will show you the different options. 

Click on the Edit button next to the Distillation Data. This will open a new window. Complete the Distillation 
Data using the information given in the table above. Then click OK. 

 
Note: Ctrl+C and then Ctrl+V can be used to copy and paste the data in the Distillation Data table. 

 

The Distillation Curve Cuts will eventually become individual pseudocomponents, each with its own critical 
parameters and thermodynamic reference data. 

At this point we are ready to perform a calculation. Add a Single Point calculation, and then select an 
Isothermal calculation. 
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Change the SinglePoint name to Assay using the <F2> key 
Click on the Calculate button or press the <F9> key to run the simulation 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save the calculations of this 
section under the name Hydrocarbons and Pseudocomponents.  

 

Analyzing the Results 

We will review the results first in the Output Tab and the in the Report Tab. 

Click on the Output Tab 

 

The Output Tab shows a grid with 10 different pseudocomponents, identified with the letter P, 

corresponding to each distillation cut of the crude. Notice that the name of each cut is the combination of 

the oil name (ASSAY for this example) plus its boiling point in K.  

 

The ‘+’ sign adjacent to each Assay expands a sub-table that contains the critical properties of each cut. 

These properties are: Normal boiling point, density, and molecular weight.  
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Click on the Report Tab and scroll down to the Species Output table. 

 

This table shows how the pseudocomponents are distributed between the Liquid-1 and Liquid-2 phases. 

Notice how the Liquid-1 (or aqueous) solubility decreases with each increasing boiling point.  

 

  



 

think simulation | getting the chemistry right 211 

 

Entering Pseudocomponents to a Stream 

There are times when the user does not have (or does not want to use) distillation data. Rather the user had 
the individual properties for a single pseudocomponent. OLI allows the user to enter the individual 
pseudocomponents. In the following example we will illustrate how.  

Example 33: Creating Pseudocomponents 

In this example, we will enter two properties - boiling point and density. The software will use one of four 
thermodynamic models – API-8, API-5, Cavett, or Kessler-Lee – to calculate critical properties of 
pseudocomponents. 

Starting the Simulation 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Crude Oil - Pseudocomponents 

Select the MSE-SRK thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the conditions of the Stream T= 15 ⁰C and 1 atm 

Change H2O from the default value to 20 moles 
 

Crude Oil Stream 
Calculation Settings Conditions 

Stream Name Crude Oil - Pseudocomponents Stream Amount Calculated 
Name Style Display Formula Temperature 15 ⁰C 
Unit Set Metric, Moles Pressure 1 atm 
Framework  MSE-SRK H2O 20 moles 

 
In the inflows grid, in the white cell below H2O, type PC1 and then press <Crtl + Enter> 

 
Note: The <Crtl + Enter> action instructs the software to create a pseudocomponent rather than look for a 

species or pure component from the database. 

 

 
Note: After typing the name of your pseudocomponent, immediately press Ctrl + Enter command keys together. 



 

think simulation | getting the chemistry right 212 

 

Repeat step 8 four more time with the following names: PC2, PC3, PC4 and PC5. Use the information provided 

in the table below to complete the grid. The molecular weight will be calculated by the software. In general, only 

two of the three parameters need be entered. 

 
Pseudocomponents Information 

Pseudocomponent name PC1 PC2 PC3 PC4 PC5 
Inflow (moles) 100 200 250 250 180 
Thermo Method API-8 API-8 API-8 API-8 API-8 
Boiling Point (⁰C) 33 60 100 140 190 
Specific Gravity 0.72 0.76 0.8 0.85 0.9 

Your screen should look like the image below: 
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Notice that at the bottom of each pseudocomponent there is a “+” and a field called calculated properties.  
Stream Analyzer immediately predicts all the calculated properties for each pseudocomponent. Click the “+” 
sign next to PC1 to expand and see these properties. 

 

The values in the green boxes can be edited to match data from other programs. 

At this point we are ready to perform a calculation. Add a Single Point calculation, and then select an 
Isothermal calculation. 
Change the SinglePoint name to Pseudocomponents using the <F2> key 

Click on the Calculate button or press the <F9> key to run the simulation 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save the calculations of this 

section under the name Hydrocarbons and Pseudocomponents.   
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Analyzing the Results 

Click on the Report Tab and scroll down to the Species Output table. 

This table shows how the pseudocomponents are distributed between the Liquid-1 and Liquid-2 phases.  
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Section 5. Mixers 

Mixers are a useful tool to mix one or more streams. This tool allows you to mix Molecular Streams or 
Reconciled Streams. 

 

In this section, you will learn how to set up a Mixer and differentiate the different mixing options to get the most 
out of your simulation results.  
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Mixing Options (Definitions) 

The Mixer Object has four different mixing options: Single point mix, Volume, Ratio, and Multiplier. A quick 
summary of what each mixing options allows you to do is summarized here. 

Single Point Mix 

This option allows you to multiply up or down a stream inflow. When selecting the streams to mix, this option 
will enable the multiplier option for both streams. You can leave the default values that are set by default to 1.0 
or change the multiplier values to any other number.   

 

Volume 

In this option, one stream stays at a constant volume, while the other stream’s volume changes within a range 
specified by the user, as is illustrated in the table below: 

Stream 1 Stream 2 
1 L 1 L 
1 L 2 L 
… … 
1 L n L 

Ratio 

In the ratio mixing type, both streams change at the same time. For example, stream will be 100% and Stream 
will be 0%, then Stream 1 will be 90% and Stream 2 will be 10%, and so on, until it reaches Stream 1 0% and 
Stream 2 100%. 

Stream 1 Stream 2 
100 % 0 % 
90 % 10% 

… … 
0 % 100 % 

Multiplier 

In this mixing option, one stream stays constant, while the other stream changes using a multiplier. The range 
of the multiplier values is given by the user. 

Stream 1 Stream 2 
1 Stream 2  0 
1 Stream 2  1 
… … 
1 Stream 2  n 
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A Basic Mixer Calculation 

A brief introduction to the Mixer tool will be shown in the example below. As we go through the example, basic 
definitions, functionalities, and reporting for the Mixer tool will be introduced.  

Example 34: Calculating the Heat of Mixing 

You will mix 1 L of a 10 wt% Ca(OH)2 solution with 1 L of a 10% HCl solution, and then you will ask the software 
to calculate the heat of mixing and the final temperature of the mixture. 

Starting the Simulation 

In this example we need to create two different streams: a 10 wt% Ca(OH)2 solution and a 10% HCl solution.  

Use the inputs and parameters from the table below to create each stream. Certain inputs, such as the name 
style, units, etc. will require further adjustments, and will be described as necessary.  

Basic Mixing Calculation 
1st Stream 2nd Stream 

Stream Name Ca(OH)2 Stream Name HCl 
Name Style Display Formula Name Style Display Formula 
Unit Set Metric, Batch, Mass Frac. Unit Set Metric, Batch, Mass Frac. 
Framework  MSE Framework  MSE 
Stream Amount 1 kg Stream Amount 1 kg 
Temperature 25 ⁰C Temperature 25 ⁰C 
Pressure 1 atm Pressure 1 atm 
H2O Calculated H2O Calculated 
Ca(OH)2  10 mass% HCl 10 mass% 

 

After creating the streams, Add a Mixer. The Mixer object can be accessed from the Menu Bar by selecting 

Calculations > Add Mixer or by selecting the Add Mixer in the Actions Pane. 

Press <F2> to rename the mixer to Basic Mixing 

Notice that the display layout for the Mixer tool is slightly different. There are two different windows (see image 
below). 

The first window displays all possible streams available for the mix calculation. There is no limit to the number 

of streams to be mixed.  

The second window allows you to change the mixing conditions, e.g., temperature, and pressure of the mixing.  
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Select the Ca(OH)2 stream from the available streams and use the >> button to put it under the Selected 

window  

Select the HCl stream from the available streams and use the >> button to put it under the Selected window  
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Also notice that the default calculation is the Single Point Mix Method at Isothermal conditions. In this 
example, we want to calculate the heat of mixing and the final temperature of the mixture. Thus, an adiabatic 
calculation is required to see this effect. 

Click on the Type of Calculation button and select the Adiabatic calculation 
option 

Note: Once the streams for the mixing have been selected, notice that the multipliers of both streams: 
Ca(OH)2 and HCl can be edited. This specific calculation will be carried out at a constant pressure of 1 
atm, and the final temperature of the mixture will be calculated.  

 

Now, we are ready to perform the calculation. Click on the Calculate button 
or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it and name it as Mixer Calculations. 

 

Analyzing the Results 

Review the Summary Box. After mixing these two streams, the temperature increased from 25 ⁰C to 
approximately ~48.65 ⁰C at a constant pressure of 1 atm. This indicates that that the enthalpy (or heat) of mixing 
is exothermic.   
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A Titration Experiment 

In this example, you will explore the volume mixing option to recreate a titration experiment. As we go through 
the example, different functionalities, reporting and plotting for the Mixer tool will be introduced.  

Example 35: HF Titration with CaCl2 

In this example, first, we will create two new streams, a 0.1 m HF solution, and a 0.1 m CaCl2 solution. What is 
the pH of these individual streams? 

Second, we will mix these two streams in equal amounts. What is the final pH of the mixture?  

And finally, the 0.1 m HF solution will be titrated with a 0.1 m CaCl2 solution. What will the titration curve look 
like? 

Starting the Simulation 

For this example, we need to create two different streams: a 0.1 m HF solution and a 0.1 m CaCl2 solution. 
Note that we have switched thermodynamic frameworks to the AQ framework. Please make sure that this 
framework is selected for both streams in this example. 

Use the inputs and parameters from the table below to create each stream. Certain inputs, such as the name 
style, units, etc. will require further adjustments, and will be described as necessary.  

Titration Calculation 
1st Stream 2nd Stream 

Stream Name 0.1 m HF Stream Name 0.1 m CaCl2 
Name Style Display Formula Name Style Display Formula 
Unit Set Metric, Batch, Moles Unit Set Metric, Batch, Moles 
Framework  AQ Framework  AQ 
Stream Amount Calculated Stream Amount Calculated 
Temperature 30 ⁰C Temperature 30 ⁰C 
Pressure 1 atm Pressure 1 atm 
H2O 55.5082 moles H2O 55.5082 moles 
HF  0.1 moles CaCl2 0.1 moles 

 

Calculating the pH of the individual streams 

Add a Single Point – Isothermal calculation for each stream 

Change the name to pH 0.1 m HF and pH 0.1 m CaCl2 respectively using the <F2> key  

Calculate the isothermal calculation for each stream  

Check the pH values of the individual streams in the Summary Box 

 
Results – pH of the individual streams 
 

pH 0.1 m  HF pH 0.1 m  CaCl2 
2.13 6.82 
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Calculating the pH of the Mixture 

After creating the streams, Add a Mixer. The Mixer object can be accessed from the Menu Bar by selecting 
Calculations > Add Mixer or by selecting the Add Mixer in the Actions Pane. 
Press <F2> to rename the mixer to Titration 

 
Note: Notice that the Available Streams window is showing all the available streams for the mixing 
calculation. Also notice that this window is showing both: Streams and Single Point calculations. 
Additionally, in front of the name of the available streams, the thermodynamic framework appears within 
brackets, e.g., AQ, MSE or MSE-SRK. This is important because in order to carry out mixing calculations, 
the selected streams need to use the same thermodynamic framework. 

 

Select the 0.1 HF – [AQ] stream. Use the >> button to move it to the Selected window 
Select the 0.1 CaCl2 stream. Use the >> button to move it to the Selected window  
Select Single Point Mix as the Mixing Method and Isothermal as the Type of Calculation 
Leave the default values for the multipliers (1.0) and change the temperature at which the mixture takes place 
to 30 ⁰C. 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
At this point is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save 
under the same file that we created before named as Mixer Calculations. 
Check the pH values of the individual streams in the Summary Box  
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Results – pH of the individual streams 

The resultant pH is 1.44. How can this be? An acid stream (the HF stream had a pH of approximately 2.13) and 
a nominally basic stream (the CaCl2 stream had a pH of 6.82) are mixed and the pH is outside the value of 
either stream. 

We will continue using Stream Analyzer to further examine the chemistry in more detail. We will titrate the HF 
stream with CaCl2. 

Titrating HF with CaCl2 

Change the Single Point Mix as the Mixing Method to the Volume option.  
 
Note: You will receive a warning message: Need 1 stream selected as the variable stream (Specs...) 
 

Click on the Specs button. This will open a new window indicating you to select the Stream to vary 
In the Select Stream tab Select the 0.1m CaCl2 stream 

 

Select the Survey Range tab. Change the Volume Range from 0 L to 1 L.   
Change the Number of Steps to 50. Then click OK. 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save under the 
same file that we created before named as Mixer Calculations. 
 
Titration Results and Plotting 

Click on the Plot tab. Note: You will see an empty plot, since we need to 
define the variables that we want to report.  
Click on the Variables button and expand the Aqueous section. Select and 
put the following species in the Y1 axis using the >> button: HF-Aq, H+1, F-1, 
Ca+2. Expand the Solid section and select CaF2(s). 
Next, expand the Additional Parameters Section and Select pH. Put it in the 
Y2 Axis using the >> button. Then click OK. 

 

As you can see, adding CaCl2 to this solution lowers the pH to values as low as 1.33. The pH does begin to 
slowly increase after 0.48 L of CaCl2 have been added. 

Why the unusual pH behavior? You can see that a small amount of 𝐶𝑎ାଶ in solution, causes the formation of 
the solid 𝐶𝑎𝐹ଶ. This effectively removes 𝐹ି from solution according to the following equation: 

𝐶𝑎ାଶ ൅ 2 𝐹ି → 𝐶𝑎𝐹ଶሺ௦ሻ 

As we add more CaCl2 in solution, more CaF2 is formed. As a result, the molecular HF decreases, because it 
dissociates in order to maintain the equilibrium, by producing more  𝐹ି ions. This shifts the following equilibrium 
to the right: 

𝐻𝐹 → 𝐻ା ൅ 𝐹ି 
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This causes an increase of 𝐻ା in solution, and as a result a decrease in the pH. At some point, at around 0.48 
L of 0.1 m CaCl2, the solid reaches a steady value, indicating that the solid has reached its saturation (maximum 
formation) value.   
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Cascading Mixers  

Example 36: Cascading Mixers 

In this example, we will mix two streams, one basic and one acidic, and mix them together under adiabatic 
conditions.  The output of this mixer will then be used as the input to a second mixer where a new caustic 
stream is added.  The schematic in the figure below illustrates the layout. 

 

For this example, we need to create three streams. You have already done this in other examples, so we will 
only give you the input data (for all streams, we will use the AQ – default – thermodynamic framework) 

Cascading Mixer Stream Data 

Parameter Value Units 
Stream Name Base Waste  
Temperature 25.0 oC 
Pressure 1.0 Atmospheres 
Stream Amount 55.5082 (Default) Mole 
H2O 55.5082 Mole 
CO2 0.1 Mole 
NH3 0.01 Mole 
SO2 0.01 Mole 
Stream Name Acid Waste  
Temperature 25.0 oC 
Pressure 1.0 Atmospheres 

H2O 55.5082 Mole 
HCl 0.1 Mole 
H2SO4 1.0 Mole 
Stream Name Caustic  
Temperature 25.0 oC 
Pressure 1.0 Atmospheres 
H2O 55.5082 Mole 
NaOH 1.0 Mole 

To test that our streams are representing their respective names, perform a single point isothermal flash on 
each stream.  When you are done you should have a window that looks like the image below. 
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Now we are ready to begin. Click on the “Streams” at the top of the tree-view in the left-hand window and then 
select Add Mixer from the actions panel. 

 

We can now add the “Base Waste” and “Acid Waste” stream as we have done in previous examples. The only 
difference here is that we are selecting an Adiabatic calculation instead of the default isothermal calculation. 
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Let’s calculate this mixer. Click the Calculate button. If everything is set up correctly the resultant mixed pH 
should be approximately 0.3. 

In the stream tree-view panel, locate your mixer and click the “+” sign. 

 

Click the “+” sign to expand the tree. 
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You can see that the program has performed an equilibrium calculation on each of our input streams as well as 
calculated the mixer. The results of the mixer are stored in the object “1 of 1”. 

We will now add a second mixer from the actions panel. 

 

When we add a subsequent mixer, we will see all our previous objects still displayed. It is possible to reuse a 
stream that we already used (this is not possible in OLI’s other simulators such as OLI Flowsheet: ESP.)  We 
want to connect the output from our first mixer (Mixer) to the inlet of the Caustic stream.  Click the object  

Mixer -(AQ). 

Then add the Caustic stream. Select the type of calculation as Isothermal. 
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We are now ready to calculate the second mixer. Press the calculate button. 

The resultant pH should be approximately 1.0.  We want to increase this value. Change the Multiplier value 
for Caustic Stream from 1.0 to 2.4 

 

Click the calculate button again. The new pH should be approximately 12.1. 

The real value of the cascading mixer is the quick ability to re-calculate the objects if we want to change 
something.  Let’s add some diethanolamine to the series of calculations. Click the Acid Waste stream (not the 
single point calculation below it) and add the component DEXH7 to the grid with a value of 10.0 moles. 

 

7 This is the OLI Tag name for diethanolamine, which is easier to type if you know the name. 
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Return to the last mixer you created (Mixer-1 in our example) and then reduce the Caustic Multiplier back to 
1.0 

To recalculate all the objects at once, press the control+F9 keys and all objects will be calculated.  Now if you 
look at the summary of Mixer2 you will see that the pH has changed to approximately 10. 
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Section 6. Chemical Stability Diagrams 

“Predicting the stability of chemical compounds as a function of solution chemistry is crucial towards 
understanding the electrochemical characteristics of materials in real-world applications. There are several 
commonly considered factors that affect the stability of a chemical compound, such as metal ion concentration, 
mixtures of ion concentrations, pH, buffering agents, complexation agents, and temperature. Chemical stability 
diagrams graphically describe the relative stabilities of chemical compounds, ions, and complexes of a single 
element as a function of bulk solution chemistry (pH and metal ion concentration) and also describe how solution 
chemistry changes upon the thermodynamically driven dissolution of a species into solution as the system 
progresses towards equilibrium”8. 

Stream Analyzer has the capability of building chemical stability diagrams by using the Chemical Diagram tool 
that allows to study the precipitation of species as function of ion concentration and other parameters such as 
pH. In this section we will explore with different examples how to set up cases to use the Chemical Diagram 
tool. 

 

 

8  Santucci, R.J., McMahon, M.E. and Scully, J.R., 2018. Utilization of chemical stability diagrams for improved understanding of 
electrochemical systems: evolution of solution chemistry towards equilibrium. npj Materials Degradation, 2(1), p.1. 
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Building a Chemical Diagram 

In this section, first we will go through the steps of building a basic chemical diagram, and then we will explore 
how the concentration of species and other variables such as temperature and pressure have a significant 
influence on the stability of chemical species.  

Example 37: La(C2H3O2)3 – K3PO4 Chemical Diagram 

For this example, we are going to reproduce the work found in the following paper: Andelman, T., Tan, M. C., 
& Riman, R. (2010). Thermochemical engineering of hydrothermal crystallization processes. Materials 
Research Innovations, 14(1), 9-15. https://doi.org/10.1179/143307510X12599329343123.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

La(C2H3O2)3 – K3PO4 Chemical Diagram 
Calculation Settings Stream Composition and Conditions 

Stream Name Chemical Diagrams Stream Amount Calculated 
Name Style Display Formula Temperature  25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ H2O 55.5082 moles 
Type of Calculation  Chemical Diagram La[C2H3O2]3Note 0.1 moles 
  K3PO4 0.1 moles 
  HNO3 0.0 moles 
  NaOH 0.0 moles 

 
Note: Notice the use of square brackets instead of the traditional parenthesis 

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Chemical Diagrams 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition of the stream given in the table above. Notice that the concentrations of La(C2H3O2)3 

and K3PO4 are held at a 1:1 molal ratio. 

Go to the Add Calculation button and select Chemical Diagram calculation or by selecting the Chemical 

Diagram icon in the Actions Pane 

Select Species vs Species as Type of Diagram – Default 

Change the Chemical Diagram name to Lanthanum/Phosphate using the <F2> key 
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Notice that the calculation is not ready 

Click on the Specs button. This will open the Chemical Diagram Options window 

In the Display Choices tab, select the No Aqueous lines button and check the box for Lanthanum as the 

subsystems to display 
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Click on the Axes category. The dialog changes to display the X Axis tab. 

In the Variable section select the pH option. Leave the default pH Range: 0-14. This also enables the Titrants 

button. 

 

 

Click on the Titrants button. Select HNO3 as the acid titrant and NaOH as the base titrant. Then click OK. 

Note: These titrants were added in the stream definition, and that’s why they appear as possible titrants.  
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Select the Y Axis tab. Select the Species Amount button as the variable to change 

Select La[C2H3O2]3 and K3PO4 species 

For the Inflow Range keep the default range: from 1E-14 to 1.0 moles on a log scale. 

Note: This means we will have initially 1.0E-14 moles of La(C2H3O2)3 and 1.0E-14 moles of K3PO4 

increasing equally until we have 1.0 moles of each. 

Click OK 
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We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it and name it 

Chemical Diagrams. 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Species vs pH diagram for 
the Lanthanum species. 

The X axis of the diagram is pH, varied by adding HCl or NaOH, and the Y axis variable is the concentrations 
of La(C2H3O2)3 and K3PO4, held at a 1:1 molar ratio. From this figure, we can see that at room temperature 
there is a large pH range over which lanthanum phosphate will be the thermodynamically stable product. As pH 
increases, and more OH- ions are present, La(OH)3 begins to form. The pH range in which La(OH)3 forms is 
the right bounded region in the diagram. The area below the lines is where only aqueous species exist. 
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Example 38: Adding 50% Lanthanum Acetate 

In this second example we will add 50% more to the lanthanum acetate species and see the effect of this 
increase in concentration on the chemical diagram. 

Starting the Simulation 

Copy the Lanthanum/Phosphate chemical diagram calculated in the Example 37: La(C2H3O2)3 – K3PO4 

Chemical Diagram, and paste it under the Chemical Diagrams stream.  

Change the name to Lanthanum 50% increase using the <F2> key 

Change the Lanthanum Acetate amount to 0.15 moles 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.   
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). It is important to note that the Y axis label has 
changed to reflect the increased amount of the lanthanum acetate.  

From this figure, we can see that by increasing amount of Lanthanum acetate it favors the stability of La(OH)3 
over a wider range of pH. 
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Example 39: Changing temperature and pressure 

In this thirds example we will use the original amount of the lanthanum acetate species and see the effect of 
this increase in temperature and pressure on the chemical diagram. 

Starting the Simulation 

Copy the Lanthanum/Phosphate chemical diagram calculated in the Example 37: La(C2H3O2)3 – K3PO4 

Chemical Diagram, and paste it under the Chemical Diagrams stream.  

Change the name to Lanthanum HTHP using the <F2> key 

Change the temperature to 200 ⁰C and the pressure to 25 atmospheres 

 

We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar.   
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This figure shows the stability diagram for 
La(C2H3O2)3 and K3PO4 over a range of pH values at 200⁰C and 25 atm. Under these conditions, there is a 
decrease in the pH range over which LaPO4 is the stable product. This is because as temperature increases, 
the insoluble rare earth hydroxides [RE(OH)3] become more stable. The aqueous area of the single-phase 
increases at elevated temperatures due to the increased solubility of the different species. Again, at high pH 
values, only La(OH)3 will form.  
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Chapter III – OLI Studio: Corrosion Analyzer 

Corrosion Analyzer is a module within the OLI Studio. A separate license enables this module. Corrosion 
Analyzer is first-principles corrosion prediction tool. As in Stream Analyzer, for all calculations we will create 
one or more objects, referred to as a Streams, which are used to define a particular chemistry, temperature, 
and pressure.   

There are two different types of calculations that can be carried out in Corrosion Analyzer: Corrosion Rates and 
Stability Diagrams (Potential vs pH and Potential vs species diagrams). A brief definition of each type of 
calculation is given below. 

 

Stability Diagram is used to predict the stability of metals, metal ions, oxides, etc. 
as a function of T, P and solution composition. With this tool you can draw 
conclusions about the ranges of immunity to corrosion, possible passivation and 
dissolution of metals in the presence of species that promote or inhibit corrosion. 

 

Corrosion Rates is used to predict the general corrosion rate, the propensity for 
localized corrosion (pitting or crevice corrosion) to occur, polarization curves, and 
heat treatment effects of metallic materials at one specific equilibrium state. The 
effects of temperature, pressure, pH, concentration of species, and velocity on 
corrosion are also included.  

In this chapter several examples will be provided to cover these calculation types.  
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Section 7. Stability Diagrams 

In this section you are going to learn how to set up a Stability Diagram and how to interpret the results when 
using this tool. 
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How to Interpret a Stability Diagram 

A Stability Diagram also known as Pourbaix Diagram or simply Potential vs pH diagram, maps out the possible 
stable species in an aqueous environment at different pH and potential combinations. This diagram, however, 
does not provide information of reaction rates or kinetic effects.  

A schematic representation of the Pourbaix diagram for copper in water at 25 ⁰C and 1 atm is shown in the 
image below.  

The gray color represents the immune to 
corrosion region. It is the stability field of the 
elemental metal. Cu is the base metal in the 
above plot. 

The green color represents the range of 
possible passivation. It is the stability field 
of a sparingly soluble compound (usually an 
oxide or hydroxide or salt). This compound 
will form a layer on the surface of the metal, 
which may protect the metal from corrosion. 
Having determined that a layer is formed, it 
is necessary to verify whether it is 
protective or not because this depends on 
the crystalline structure of the sparingly 
soluble compound. In the above plot, the 
green area contains CuO and Cu2O as the 
solid phases produced by oxidation of Cu.  

The light-yellow color represents the corrosion region. It is the stability field(s) of dissolved (ionic or neutral) 
metal species in which neither the metal nor passivating solids are stable. In the plot above, Cu2+ is the ionic 
species that is the most stable. 

The diagonal dashed lines, represented by the letters a and b are the water reduction and water oxidation lines, 
respectively. 

Below the water reduction line (a): Water decomposes to form H2 gas. Above the water oxidation line (b): Water 
decomposes to form O2 gas. The region within these lines (a and b) is called the stability region of water.  

The lines that divide different species in the Pourbaix diagram show the equilibrium conditions. These lines 
represent the equilibrium for chemical and electrochemical reactions. 

Finally, as a reference, the values of the Natural pH and the Oxidation Reduction Potential (ORP) are 
superimposed on the diagram. The natural pH line of the water sample is the water’s computed pH before it is 
adjusted using with acid or base to create the diagram. The ORP is represented by the red circle and indicates 
the initial electrochemical potential of the water phase. This is the value before the potential is adjusted using 
a potentiostat, for example.  
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How to determine if corrosion in the absence of oxygen is possible? 

In the absence of oxygen, the most common reduction reaction is the reduction of the proton to elemental 
hydrogen (as shown by line a in the plot below). Depending of the pH that reactions that can occur are the 
following: 

 𝐴𝑐𝑖𝑑𝑖𝑐:   𝐻ା ൅ 2𝑒̅ ® 𝐻ଶ 

𝐵𝑎𝑠𝑖𝑐:   2𝐻ଶ𝑂 ൅ 2𝑒̅ ® 𝐻ଶ ൅ 𝑂𝐻ି 

For a corrosion process to proceed, the line a must lie above a line that corresponds to an equilibrium between 
the metal and metal-containing ions. 

In oxygen-containing solutions, O2
 
can be reduced to H2O (as shown by line b). Depending of the pH that 

reactions that can occur are the following: 

 𝐴𝑐𝑖𝑑𝑖𝑐:   𝑂ଶ ൅ 4𝐻ା ൅ 4𝑒̅® 𝐻ଶ𝑂 

𝐵𝑎𝑠𝑖𝑐:   𝑂ଶ ൅ 2𝐻ଶ𝑂 ൅ 4𝑒̅® 4𝑂𝐻ି 

For a corrosion process to occur, the line b must lie above a line that corresponds to an equilibrium between 
the metal and metal-containing ions.  

Passivation is likely if b lies above a line that corresponds to an equilibrium between the metal and a sparingly 
soluble compound. 

 

Stability diagram for Copper in Water at 25⁰C and 1 atm 
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Building a Pourbaix Diagram 

Example 40: Pourbaix Diagram of Fe-H2O System 

After completing this example, you will learn how to set up a Pourbaix Diagram using the Stability Diagram 
tool. 

Starting the Simulation 

To start the software, double-click the OLI Studio  icon on the desktop, which will take you to the OLI 
Studio interface where you can start creating your calculations. 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 2-12 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface Fe   

 
Add a new Stream 
Click on the new Stream and press <F2> to change the name to Fe-H2O System 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above 
Go to the Add Calculation button and select Stability Diagram calculation or by selecting the Chemical 
Diagram icon in the Actions Pane. 
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Select Pourbaix Diagram as Type of Survey – Default 

Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O Pourbaix Diagram 

 

Note: Notice that two new sections appear in the Definition tab: Calculation Parameters and Contact 

Surface grids. Additionally, the Redox button is turned ON. 

 

In the Calculation Parameters grid is where the pH titrants need to be defined. These default pH titrants 

selected by default are HCl and NaOH. You have the option to change the default titrants to your preferred 

titrants. 

In the Contact Surface grid is where the metal or alloy of interest needs to be defined. E.g. Fe, Cu, carbon 

steel, etc.  

The Redox button (Re) is turned ON for this calculation since reduction and oxidation reactions are need it 

to create the Pourbaix Diagram. This option will enable the different oxidation states of the selected metal. 
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Leave the default titrants for this calculation: HCl and NaOH 

Under the Contact Surface grid type Fe 
 
Note: You also have the option to use the drop-down arrow to search for the metal or alloy of interest.  
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At this point all the basic inputs to create a Pourbaix Diagram have been defined. Notice that in the summary 
box the following default plotting settings have been defined: Potential range: -2 to 2 V vs SHE and pH range: 
0-14. You can modify these default values before running the calculation. 
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Click on the Specs button. This will open the Stability Diagram Options Window 

Under the Display Category you will see the Display Choices tab. Under this tab make sure to select the 

following options: 

No Aqueous lines 

Show natural pH 

Show ORP 

Under Display Subsystems check the Iron and Water boxes 

Under Shading select the option Shade Subsystem and select Iron.  

Click OK to close the window 
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Click on the Axes Category. This will show you the Plot Variables tab. 

 

Note: In the Axes Category you can modify the axes of the Pourbaix Diagram and change the default 

titrants.  

 

 

Change the X Axis or pH range to 2-12 

Leave the default values for the Y Axis of Potential Range (-2 to 2  V SHE) 

Click OK to close the window 

We are ready to perform the calculation. Click on the Calculate button or 

press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool 

bar. You can save it and name it as Stability Diagrams. 
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-

H2O system at 25 ⁰C and 1 atm. 

 

The obtained diagram is useful for assessing the corrosion behavior of iron in pure water.  

Elemental iron (gray section) is stable from -2 to -0.6 V SHE. At a potential greater than -0.6 V SHE, Fe oxidizes 
to Fe+2. If the pH is above 10, the boundary is at a lower potential for example, -0.7 V SHE at 12 pH.  

The software computes that Fe3O4 (magnetite) is stable between a pH range of ~8.3 and 12. This is also known 
as the Passive Film that protects the iron surface from active corrosion. At higher potentials, the software 
computes Fe2O3 (hematite). Hematite is the dehydrated form of Fe(OH)3 and Fe3O4, two forms of rust. These 
phases provide less corrosion protection the iron surface than the magnetite. These two phases are represented 
in the plot by the green color. 

The white sections of the plot represent the dominant iron-containing species dissolved in solution. The species 
with the largest range is Fe+2. The software computes stability for this species from -0.6 V to 0.77 V SHE, at 
low pH, and it is no longer stable at pH 10. Active corrosion of the iron surface is predicted if the pH is between 
0 and 10. The actual corrosion rate cannot be predicted from this plot, nor can the pH of the water film (diffusion 
layer) in contact with the iron surface. Therefore, the pH range of 0 to 10 is a guideline and not a direct prediction. 

The natural pH and the oxidation reduction potential (ORP) of water, which is represented by the red circle, are 
showing that when placing Fe in pure water at 25 ⁰C and 1 atm. The point at which the natural pH and the ORP 
intersects (7 pH, 0.4 V SHE) indicates that Fe2O3 (hematite) is the most stable species that forms. 
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Additionally, notice that the oxidation of iron can be coupled with the reduction of water because water reduction 
line (line a) lies above the lines that represent the oxidation of iron. Therefore, corrosion of iron can occur with 
the evolution of hydrogen and formation of soluble iron-containing ions e.g., Fe2+. 

Selective Oxidation and Reduction Chemistry  

Occasionally you may want to remove a specific oxidation state for an element when building a Stability 
Diagram. There are a variety of reasons to perform such an activity, one being that a specific oxidation state 
may be kinetically unavailable for the reaction. Another case is that perhaps you need to compare and contrast 
two systems.  We will explore how to do this in the following example.  

Example 41: Turning off the Fe+6 oxidation state in the Stability Diagram 

In this example you will create a Stability diagram for iron in water at ambient conditions (see previous example 
for details on how to create this stream), learn how to change the default titrants and turn off/on different specific 
oxidation states of the metal of interest. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface Fe H2SO4 0 moles 
  NaOH 0 moles 

 
Under the Fe-H2O System add a new Stability Diagram calculation. Go to the Add Calculation button and 
select Stability Diagram calculation or by selecting the Add Stability Diagram icon in the Actions Pane. 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above. Add H2SO4 and 
NaOH as inflows. Note: H2SO4 and NaOH will be used as titrants to adjust pH 
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O Selective Oxidation 
Under the Contact Surface grid type Fe 

 

 

 



 

think simulation | getting the chemistry right 253 

 

Changing the Default Titrant 

In the Calculation Parameters grid, click on HCl (which is default titrant). A drop-down arrow appears, click 
on it and select H2SO4. NaOH has been selected by default. 

 

Note: You can also change the default titrant using the Specs button 

Click on the Specs button 
Select the Axes option under the Category window 
Click on pH Titrants. This will open a new window 
 

 
 

Select H2SO4 as the Acid titrant, and NaOH as the Base titrant. Then click OK to exit both windows. 
 



 

think simulation | getting the chemistry right 254 

 

 

The screen should look like the image below after all the inputs and definitions have been entered: 

 

We are ready to perform the calculation. Click on the Calculate button or 

press the <F9> key 
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It is time to save your file (File >Save as…) or using the save icon in the tool 

bar. You can save it under the same file created in the previous example 

named Stability Diagrams.  
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-

H2O system at 25 ⁰C and 1 atm. 

 

Marcell Pourbaix did not consider the FeO4
2- ion in his work. This is iron in the +6 oxidation state for which there 

was little thermodynamic data available in the1960s. To reproduce his work, we need to remove the redox 
subsystem that pertains to Fe(+6). 

Selective Redox, removing an undesired oxidation state 

In the Menu bar go to Chemistry > Model Options. This will open a new 
window 
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Select the Redox tab, expand the Iron Subsystems by clicking on the ‘+’ icon, 
and uncheck the Fe(+6) oxidation state. Note that if you have an inflow 
component with this oxidation state it will remain in the calculation. Click the 
OK button to save your changes and close the window. 

 

We are ready to recalculate to consider the changes. Press the <F9> key or 

go to the Definition tab and click on the Calculate button. 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). In the figure below, you can see that the region 
dominated by the FeO4

2- ion is not present.  
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Modeling the Effects of Hydrogen Sulfide on Corrosion 

Example 42: The Effect of Hydrogen Sulfide on the Corrosion of Iron 

The H2S (S-2) forms a relatively insoluble precipitate with Fe+2. This precipitate has the potential to cover the 
metal surface and enhance the pH region where iron is protected from the water. We will model this using the 
Stability Diagram tool. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface Fe H2S 1e-4 moles 

 
Under the Fe-H2O System add a new Stability Diagram calculation. Go to the Add Calculation button and 
select Stability Diagram calculation or by selecting the Add Stability Diagram icon in the Actions Pane. 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above. Add 1e-4 moles of 
H2S as an inflow. 
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O-H2S System 
Under the Contact Surface grid type Fe 

The screen should look like the image below after all the inputs and definitions have been entered: 
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Note: By default, only the transition metals are turned ON. The different oxidation states of elements that are 
not transition metals are not turned on automatically. You need to turn them ON manually. 

Go to the Redox button (Re), and click on the drop-down arrow 
Select Sulfur. This will turn the oxidation states of sulfur ON 

 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Stability Diagrams. 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-
H2O-H2S system at 25 ⁰C and 1 atm. 

 
Inspection of the diagram reveals a 
profound effect of H2S on the corrosion of 
iron. New stability fields of FeS and FeS2 
are observed. Elemental iron is found to be 
in equilibrium with FeS over for pH values 
ranging from ca. 6.0 to 12.5.  

Since the Fe/FeS equilibrium line lies 
below the H+ reduction line (a), a process 
consisting of the reduction of H+ to H0 and 
oxidation of Fe to FeS is likely to occur in 
de-aerated environments. FeS forms a 
passive film and offers some protection 
against corrosion.  

In fact, the protection due to the formation 
of FeS is possible over a much wider pH 
range than that due to the formation of 
Fe3O4 (magnetite) in the absence of H2S. 

This has important implications for corrosion in refinery installations, where H2S is frequently present. 
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Modeling Corrosion at High Temperature 

Example 43: High Temperature Iron in Water 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 300 ⁰C 
Unit Set Metric, Batch, Moles Pressure 150 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface Fe   

 
Under the Fe-H2O System add a new Stability Diagram calculation. Go to the Add Calculation button and 
select Stability Diagram calculation or by selecting the Add Stability Diagram icon in the Actions Pane. 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above  
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O High T 
Under the Contact Surface grid type Fe 

The screen should look like the image below after all the inputs and definitions have been entered: 

 

We are ready to perform the calculation. Click on the Calculate button or 

press the <F9> key 
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It is time to save your file (File >Save as…) or using the save icon in the tool 

bar. You can save it under the same file created in the previous example 

named Stability Diagrams.  
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-

H2O system at 300 ⁰C and 150 atm. 

 

We can see from the diagram above that passivation is only possible at moderate pH’s. 
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Example 44: Neutralization of Refinery Streams with Alkanolamines 

In this example you will create a stability diagram for alkaline neutralization in an oil refinery. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 

as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Fe-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 50 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface Fe HCl 0 moles (Acid Titrant) 
  DEA9 0 moles (Base Titrant) 
  C8H18 2E-07 moles 
  C7H16  8E-07 moles 
  C3H8  1.2E-04 moles 
  C4H10  2E-05 moles 
  C5H12  7E-6 moles 
  C6H14  2E-6 moles 
  H2S 0.01 moles 

 

Under the Fe-H2O System add a new Stability Diagram calculation. Go to the Add Calculation button and 

select Stability Diagram calculation or by selecting the Add Stability Diagram icon in the Actions Pane 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition, temperature and pressure of the stream given in the table above  

Select Pourbaix Diagram as Type of Survey – Default 

Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O-Alkanoamines 

Under the Contact Surface grid type Fe 

Change the Base Titrant to DEA 

Turn Redox ON for Sulfur. Click on the drop-down arrow next to the Re button and select Sulfur 

Note: You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab. 

Make sure that Sulfur is checked.  

 

9 The “ESP” name for this species is DEXH, which can be used as an input to make your life easier. The formula name is: HN(C2H4OH)2 
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The screen should look like the image below after all the inputs and definitions have been entered: 

 

We are ready to perform the calculation. Click on the Calculate button or 

press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool 

bar. You can save it under the same file created in the previous example 

named Stability Diagrams.  
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-

H2O system at 50 ⁰C and 1 atm. 
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Modeling the Effects of Complexation on Corrosion 

In this section we will simulate the reaction of Copper with Ammonia and Gold metal with Cyanide. This section 
attempts to answer the question of how strong complexing agents affect the passivation of these metals. 

Example 45: Copper and Ammonia 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Cu-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface  Cu NH3 0 moles 

 
Add a new Stream 
Click on the new Stream and press <F2> to change the name to Cu-H2O System 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above  
Under the Cu-H2O System Stream add a new Stability Diagram calculation. Go to the Add Calculation button 
and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane 
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Cu-H2O-NH3 
Under the Contact Surface grid type Cu 

The screen should look like the image below after all the inputs and definitions have been entered: 
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We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Stability Diagrams. 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Cu-
H2O system at 25 ⁰C and 1 atm. 

 

 

In the absence of oxygen (looking at only the a line), 
we can see that the copper equilibrium line lays 
above the hydrogen a line.  This means there is 
insufficient oxidizing power in the water to corrode 
copper metal in pure water. 

What happens if Ammonia (NH3) is added to the 
solution? The next step is to understand the effect 
of NH3 on the stability of copper. 

 

 

 

Effect of NH3 on the Stability of Copper 

Go to the Definition tab, and change the amount of NH3 from 0 to 0.1 moles 
Click on the Calculate button or press the <F9> key 

 
Analyzing the Results 

Click on the Chemical Diagram tab (
). This tab displays the 

Pourbaix Diagram for the Cu-H2O-NH3 system at 
25 ⁰C and 1 atm in a 0.1 m of NH3 solution. 

 

 

 

Notice that a large area of corrosive liquid has 
appeared in the stability field for the copper oxides. 
This means that it is thermodynamically possible for 
the ammonia to break down the passivation layer of 
copper oxide in the presence of oxygen. Notice that 



 

think simulation | getting the chemistry right 268 

 

in the absence of oxygen (the a line only), copper is still stable. 
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Now repeat the exercise with 1.5 moles of NH3 

Go to the Definition tab, and change the amount of NH3 from 0 to 1.5 moles 
Click on the Calculate button or press the <F9> key 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Cu-
H2O-NH3 system at 25 ⁰C and 1 atm in a 1.5 m of NH3 solution. 

 

 

 

At this concentration of ammonia, most, if not all the 
passivating copper oxide has been reacted away. 
Only at very high pH values are there any stable 
oxides.   
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Example 46: Gold in the presence of Cyanides 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Au-H2O System Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface  Au NaCN 0 moles 

 
Add a new Stream 
Click on the new Stream and press <F2> to change the name to Au-H2O System 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above  
Under the Au-H2O System Stream add a new Stability Diagram calculation. Go to the Add Calculation button 
and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane 
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Au-H2O  
Under the Contact Surface grid type Au 
 
The screen should look like the image below after all the inputs and definitions have been entered: 

 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Stability Diagrams. 
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Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Au-
H2O system at 25 ⁰C and 1 atm. 

You can see that without oxygen, gold 
metal is immune to corrosion. The 
hydrogen line a is below the gold 
equilibrium line. In the presence of oxygen, 
gold is still immune to corrosion except at 
very low pH. 

One of the most commonly used leaching 
processes for gold extraction is the 
cyanidation process. This process is a 
hydrometallurgical technique for extracting 
gold from low-grade ores by converting 
the gold to a water-soluble coordination 
complex. Basically, this approach adds 
cyanide salts to water. We are going to 
simulate this using the software. 

 

 

Effect of Cyanide on the Stability of Gold 

Go to the Definition tab, and change the amount of NaCN from 0 to 1e-4 moles 
Click on the Calculate button or press the <F9> key 

 
Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Au-
H2O-NaCN system at 25 ⁰C and 1 atm. 

 

 

 

In the presence of oxygen, gold completely 
corrodes with cyanide. This is primarily due 
to the formation of the gold complex: 
𝐴𝑢ሺ𝐶𝑁ሻଶ

ି. This complex is stable over all 
regions where water is also stable. This 
means that now gold can be processed in 
water in a variety of conditions. 
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Modeling the Effect of Oxidizing Inhibitors on Corrosion 

In this chapter we will look at the effect of modeling corrosion inhibitors. We will do this by superimposing two 
stability diagrams over one another. If one solid field overlaps the corrosion range of the other system, then 
passivation is likely. 

Example 47: Iron in the presence of chromates 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Inhibitors Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface  Fe   
Contact Surface Cr   

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Inhibitors 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition, temperature and pressure of the stream given in the table above  

Under the Inhibitors Stream add a new Stability Diagram calculation. Go to the Add Calculation button and 

select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane 

Select Pourbaix Diagram as Type of Survey – Default 

Click on the new Stability Diagram and press <F2> to change the name to Fe-Cr-H2O Pourbaix Diagram 

Under the Contact Surface grid type Fe and then Cr 

 

Note: Make sure that both Fe and Cr are enabled for Redox reactions. Use the arrow next to the Re button 

to expand the list. 

You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab. Make 
sure that Fe and Cr boxes are checked. 
 

  



 

think simulation | getting the chemistry right 273 

 

The screen should look like the image below after all the inputs and definitions have been entered: 

 

 
Click the Specs button and under the Display Choices tab check the following options: 
No aqueous lines 
Show ORP 
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Click OK to close the Stability Options window 

We are ready to perform the calculation. Click on the Calculate button or 

press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool 

bar. You can save it under the same file created in the previous example 

named Stability Diagrams. 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-
Cr-H2O system at 25 ⁰C and 1 atm. 

 

As you can see in this diagram, the shaded chrome passivating solid (Cr(OH)3ppt) overlays the corrosive region 
of the iron system. This means that there is potential for passivating the metal in that region. 

The Cr(OH)3 field overlaps with the corrosion range of Fe in most of the pH range. This causes inhibition 
because of the coupling of: Oxidation of Fe to Fe2+, reduction of chromates to Cr(OH)3, and the deposition of a 
protective layer of Cr(OH)3. 
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Example 48: Iron in the presence of arsenates 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Inhibitors Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface  Fe   
Contact Surface As   

 
Under the Inhibitors Stream add a new Stability Diagram calculation. Go to the Add Calculation button and 
select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane 
Select Pourbaix Diagram as Type of Survey – Default 
Click on the new Stability Diagram and press <F2> to change the name to Fe-As-H2O Pourbaix Diagram 
Under the Contact Surface grid type Fe and then As 

 
Note: Make sure that both Fe and As are enabled for Redox reactions. Use the arrow next to the Re button 
to expand the list. 
 
You can also enable Redox reactions via the menu bar: Chemistry > Model Options > Redox tab. Make 
sure that Fe and As boxes are checked. 

The screen should look like the image below after all the inputs and definitions have been entered: 
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Click the Specs button and under the Display Choices tab check the following options: 
No aqueous lines 
Show ORP 

 

Click OK to close the Stability Options window 
We are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Stability Diagrams. 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-
As-H2O system at 25 ⁰C and 1 atm. 

 

 

The elemental arsenic field overlaps with 
the corrosion range of Fe in most of the pH 
range provided that the conditions are 
reducing (absence of oxygen). This 
promotes inhibition because of the coupling 
of: Oxidation of Fe to Fe+2 and the 
reduction of arsenates to elemental As. 
This promotes the deposition of a 
protective layer of As. This can only work in 
reducing environments; otherwise, the 
protective layer of As will oxidize and 
dissolve.  
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Implications of Stability Diagrams on Cathodic Protection 

Cathodic protection works by shifting the potential of the metal into its immunity range. Stability diagrams can 
help you to answer the following questions: 

What is the potential range that ensures that the metal stays in the immunity range? 

What is the effect of environmental variables on the immunity domain? 

We will explore the Fe-H2O system at different temperatures and pressures to answer these questions. 

Example 49: Effect of Temperature and Pressure on the Pourbaix Diagram of Fe-H2O System 

Starting the Simulation 

Iron at 30 ⁰C  and 1 atm 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Stability Diagram Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Cathodic Protection Stream Amount Calculated 
Name Style Display Formula Temperature 30 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ pH Range 0-14 (Default) 
Calculation Type Stability Diagram H2O 55.5082 moles 
Contact Surface  Fe   

 
Add a new Stream 

Click on the new Stream and press <F2> to change the name to Cathodic Protection 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Moles 

Enter the composition, temperature and pressure of the stream given in the table above  

Under the Cathodic Protection Stream add a new Stability Diagram calculation. Go to the Add Calculation 

button and select Stability Diagram calculation or by selecting the Chemical Diagram icon in the Actions Pane 

Select Pourbaix Diagram as Type of Survey – Default 

Click on the new Stability Diagram and press <F2> to change the name to Fe-H2O at 30C and 1 atm 

Under the Contact Surface grid type Fe 
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The screen should look like the image below after all the inputs and definitions have been entered: 
 

 
 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Fe-
H2O system at 30 ⁰C and 1 atm. 

 

 

 

 

In the whole pH range, cathodic protection 
will require shifting the potential to 
moderately negative values. 



 

think simulation | getting the chemistry right 279 

 

Iron at 300 ⁰C  and 100 atm 

Go to the Definition tab, and change the Temperature and Pressure to 300⁰C and 100 atm 
Click on the Calculate button or press the <F9> key 

 

Analyzing the Results 

Click on the Chemical Diagram tab ( ). This tab displays the Pourbaix Diagram for the Cu-
H2O-NH3 system at 300 ⁰C and 100 atm. 

 

 

 

The immunity range in acidic and neutral 
solutions is weakly affected by 
temperature.  However, the immunity 
range in alkaline solutions is shifted to 
much lower potentials which makes 
cathodic protection much more difficult. 
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Section 8. Introduction to Rates of Corrosion 

In this section you are going to learn how to set up a Corrosion Rate calculation, how to study the effect of 
different variables on the corrosion rates of different alloys, such as temperature, pH, flow velocity, etc., and 
how to interpret the results when using this tool. 

We will also explore how to interpret the results for the propensity to localized corrosion, polarization curves 
and heat treatment effects.  
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A Basic General Corrosion Rate Calculation  

A brief introduction to the corrosion rate tool will be shown in the example below. As we go through the example, 
the basic definitions, functionalities, and reporting for the Corrosion rate tool will be introduced. Note: As of 
version 11.5 and earlier, only the AQ thermodynamic framework supports the corrosion rate calculation. 

Example 50: Corrosion rate of an oxygenated 0.1 m NaCl solution 

Starting the Simulation 

To start the software, double-click the OLI Studio icon on the desktop, which will take you to the OLI Studio 
interface where you can start creating your calculations. 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Corrosion Rate Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name CR of carbon steel Stream Amount Calculated 
Name Style Display Formula Temperature 25 ⁰C 
Unit Set Metric, Batch, Moles Pressure 1 atm 
Framework  AQ H2O 55.5082 moles 
Calculation Type Corrosion Rates O2 2.5e-4 moles 
Contact Surface Carbon Steel G10100 (generic) NaCl 0.1 moles 

 

Add a new Stream 
Click on the new Stream and press <F2> to change the name to CR of carbon steel 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon and select the Formula option 
Click on the Units Manager Icon, and select Metric, Batch, Moles 
Enter the composition, temperature and pressure of the stream given in the table above 
Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add Corrosion 
Rates icon in the Actions Pane. Your screen should look like the image below. 
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Note: By default, the software has selected Carbon steel G10100 (generic) as the default contact surface to 
perform the corrosion rates on. You can click on the white space of the Carbon steel G10100 (generic) name, 
and it will show a drop-down arrow. You can then click on the dropdown arrow, and you will be able to see and 
select any alloy present in the Alloy database. 

 

Additionally, the Calculation Parameters grid shows two options: (1) Flow Type and (2) Effect of FeCO3 /FeS 
scales on corrosion rates. 

By default, the software selects Static as Flow Type. There are 7 options for Flow Type, and a brief description 
of the first five options will be given below. 

 

Static 

The solution is not flowing in this calculation.  
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Pipe Flow 

The fluid is flowing through a pipe. The pipe diameter and flow velocity must be defined. The default pipe 
diameter is 0.1 meters and the default flow velocity is 2 m/s.  

Rotating disk  

This reproduces a type of experiment that is used quite frequently in the laboratory. A disk is rotated to bring 
fluid to the surface of the electrode in a predictable manner. The diameter of the disk is specified as well as the 
revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000 RPM.  

Rotating Cylinder  

This reproduces a type of experiment that is used quite frequently in the laboratory. A cylindrical rotor is rotated 
to bring fluid to the surface of the electrode in a predictable manner. The diameter of the rotor is specified as 
well as the revolutions per minute (RPM). The default diameter is 0.01 meters and the default RPM is 5000 
RPM.  

Complete Agitation  

In this calculation, the liquid phase is completely agitated, and no mass transfer limitations apply. 

Leave the default alloy Carbon steel G10100 (generic) as the contact surface 
Go to the Survey by option and select Single Point Rate. This option will allow you to calculate the corrosion 
rate at the temperature and pressure specified. 

 

Note: You can also study the effect of other variables such as temperature, pressure, (chemical species) 
composition, pH, pipe flow, etc. on the corrosion rate. The effect of these variables can be set up as a survey 
calculation. In the upcoming corrosion rate examples, survey calculations to study corrosion rates will be shown 
in more detail. 

A brief description of the most common survey types for studying corrosion rates are given below.  

pH Survey – This calculation is like the pH survey available in OLI Studio: Stream Analyzer. The specification 
requires a titrant acid and base to change the pH.  
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Temperature Survey – The default range is from 25-100 ⁰C. Any range may be used by changing the Range 
option. The user should consider that some points in the survey may not converge due to phase changes (e.g., 
boiling off of aqueous liquids).  

Composition Survey – The composition of a chemical compound, for example NaCl, can be varied to study its 
effects on corrosion rates. The range of the chemical compound defaults from 0 to 1 mole with an increment of 
0.1 moles. This range can be changed via the Range option.  

Care should be taken when adding salts that can form hydrates (e.g., CaCl2.6H2O). When these hydrated salts 
begin to precipitate from solution, large amounts of water may be complexed with the crystal. The solution may 
dehydrate, and non-convergence may be the result.  

Pressure Survey – The pressure of the system can also be varied. The default range can be changed via the 
Range option. Care should be taken when working at very low pressures since the solution may inadvertently 
boil off the liquid and non-convergence may result.  

Flow Velocity Survey – In systems that are flowing, the flowrate of the stream can be varied. 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. Create a new file and name 
it: Corrosion Rates. 

 

Analyzing the Results 

Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 
corrosion rate and pH. 
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Click on the View Data button to see the results in tabulated form. 

 

The predicted corrosion rate of carbon steel at 25 ⁰C and 1 atm is 0.13 mm/year when exposed to an 

oxygenated 0.1 m NaCl solution. It is important to highlight that this predicted corrosion rate is the corrosion 

rate once the system has reached a steady state. 

 

Click on the Localized Corr. Rate tab ( ). This tab displays a plot showing the results of 

three different calculated data: 

Corrosion Potential (red dot) 

Repassivation Potential (yellow triangle) 

Maximum Pit Current Density (blue square) 

 

Click on the View Data button to see the results in tabulated form. 
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Notice that in this case, the corrosion potential has a higher value than the repassivation potential. This 

indicates that carbon steel at 25 ⁰C and 1 atm when exposed to an oxygenated 0.1 m NaCl solution will 

likely suffer localized corrosion (pitting or crevice corrosion). The maximum pit current density gives the 

worst-case pitting rate for these conditions. 

  

Now, click on the Polarization Curve tab ( ). This tab displays a plot showing the 

calculated polarization curve of carbon steel. 
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The net polarization curve is given by the red curve. This red curve is obtained by adding up all the currents 

of the half reactions at a given potential. The corrosion potential is calculated by applying the mixed potential 

theory, and it is represented by this red triangle. Once the corrosion potential is obtained, the corrosion 

current density also is computed and subsequently the corrosion rate. 

 

Exploring corrosion rate calculation options 

Example 51: Corrosion in a Water-Filled Carbon Steel Tank 

In the following example you are going to study the corrosion rate of a carbon steel tank with a volume of 10 m3 
tank (3.2 cm high and 200 cm in diameter) that is filled to the top with water. The tank’s wall thickness is 1.27 
cm.  

These are the operation conditions: 

Sometimes the water in the tank remains static (mixer off), closed to the atmosphere 
Some other times the tank is fully mixed (complete agitation) 
The tank when operating has a variable speed mixer with a rotation speed between 0 and 12,000 rpm 
At other times, the tank is open to the atmosphere. The effects of O2, CO2 and flow will be studied. 

We will evaluate each instance to compute the corrosion risk.  

 

 
 

Starting the Simulation 

First operation condition: Static flow, tank closed to the atmosphere at ambient conditions  

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Corrosion rate calculation of tank as a function of flow 
Calculation Settings Stream Composition and Conditions 

Stream Name CR vs flow Stream Amount 10000 L 
Calculation Type Corrosion Rates Temperature 25 ⁰C 
Name Style Display Name Pressure 1 atm 
Unit Set Metric, Batch, Concentration Water Calculated 
Framework  AQ   
Contact surface  Carbon Steel G10100 (generic)   
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Add a new Stream 
Click on the new Stream and press <F2> to change the name to CR vs flow 
Select the AQ thermodynamic Framework 
Click on the Names Manager Icon, and select the Display Name option, and click OK 
Click on the Units Manager Icon, and select the Metric, Batch, Conc. option, and click OK 

 

 
In the Definition tab, notice that the units of the Stream Amount changed from moles (mol) to liters (L). 

Enter the composition, temperature and pressure of the stream given in the table above 
Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add 
Corrosion Rates icon in the Actions Pane.  
Change the Rates name to Static Flow, 25C using the <F2> key.  
Leave the default Flow Type as Static 
Leave the default alloy Carbon steel G10100 (generic) as the contact surface 
Go to the Survey by option and select Single Point Rate. This option will allow you to calculate the corrosion 
rate at the temperature and pressure specified. 

Your screen should look like the image below. 

 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key. 
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It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Corrosion Rates.  



 

think simulation | getting the chemistry right 290 

 

Analyzing the Results 

Click on the output tab labeled 1 (next to the input tab), and check the results located in the Corrosion Values 
tab.  

 

The corrosion rate is 7.13e-3 mm/yr. This is a negligible rate, since the thickness of the tank is 12.7 mm, then 
corroding half the wall thickness would take about 900 years.  

 

Second operation condition: Turbulent flow, tank closed to the atmosphere at ambient conditions  

 
Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and 
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane 
Change the Rates name to Turbulent Flow, 25C using the <F2> key.  
Change the default Flow Type to Complete Agitation 
Leave the default alloy Carbon steel G10100 (generic) as the contact surface 
Go to the Survey by option and select Single Point Rate. 

Your screen should look like the image below. 
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Analyzing the Results 

Click on the output tab labeled 1 (next to the input tab), and check the results located in the Corrosion 
Values tab.  

 

The corrosion rate increased 0.0196 mm/year, still a relatively low value. 

Third operation condition: Varying flow, tank closed to the atmosphere at ambient conditions  

 
Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and 
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane 
Change the Rates name to Varying Flow, 25C using the <F2> key 
Go to the Survey by button and select Rotating Disk 
Under the Calculation Parameters grid. change the Disk Diameter to 200 cm 

Note: At this point the vertical dimensions of the tank are unimportant. We will assume that the tank can be 
modeled like a rotating cylinder. The propeller rotates at 1200 rpm, although it is not expected that the wall 
velocity will approach this value, and so a lower value will be used (we still want it to be high enough to see the 
effects of shear).  
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The next step is to set the speed of the mixer. Go to the Specs button next to the Rotating Disk option 
Change the Disk Rotation Speed Range from 0 to 300 cycles/min with an increment of 10 cycles/min. Then 
click OK.  

 

Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

Your screen should look like the image below. 

 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key  
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It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Corrosion Rates.  
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Analyzing the Results 

Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 
corrosion rate and pH. 

 

The corrosion rate is computed to increase as the bulk liquid velocity increases from 0 to 300 rpm near the wall 
surface. The reason is straightforward; the higher velocity reduces the static water film thickness on the metal 
surface. This diffusion layer film limits the mass transfer of corrosion products and bulk chemicals to and from 
the surface. As the liquid velocity (and therefore shear force) increases, the film thickness decreases, and the 
concentration gradient increase. This increases the flux of materials to and from the surface, which increase 
corrosion rates. 

Fourth operation condition: Static flow, tank open to the atmosphere (aerated with O2 only) at ambient 
conditions  

Open steel tanks are in contact with oxygen in the air. To simulate this, follow the steps below. 

Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and 
select Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane 
Change the Rates name to Static Flow, O2 using the <F2> key 
Add Oxygen (O2) to the inflow grid 
Leave the default Flow Type as Static 
Go to the Survey by button and select Composition  
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The next step is the concentration range of oxygen. Go to the Specs button next to the Composition option. 
This will open a new window. 
Under component select (click on) O2. Then select the Survey Range tab and enter the Survey Range as 
follows: Log Scale, Start=1e-6, End=10, Steps=10. Then click OK. 

  

Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

Your screen should look like the image below. 
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We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key  
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Corrosion Rates. 

Analyzing the Results 

Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 
corrosion rate and pH. 

Right-mouse click on the X-axis and change it to Logarithmic Scale 

 

Right-mouse click on the pH curve and select Remove 
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The resulting plot shows the impact of oxygen on the corrosion rate. Corrosion increases by a factor of 20 once 
the concentration increases beyond 100 μg/l. Aerated water contains approximately 8 mg/l O2. Corrosion on 
the tank wall is 0.16 mm/yr. At this rate, 50% of the 12.3 mm wall will be dissolved in 40 years. 

Fifth operation condition: Static flow, tank open to the atmosphere (aerated with O2 and CO2) at ambient 
conditions  

The atmosphere contains ~400 ppmV CO2. At this concentration 0.6 mg/l CO2 is dissolved in water as molecular 
CO2, this CO2 hydrolyzes water to form the following reactants: 

𝐶𝑂ଶ ൅ 𝐻ଶ𝑂 ൌ 𝐻ା ൅ 𝐻𝐶𝑂ଷ
ି 
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The resulting pH is about 5.6 at ambient conditions. 

The impact of CO2 on corrosion is two-fold, as two separate reactions occur at the metal surface: 

𝐻ା ൅ 𝑒ି ↔
1
2
𝐻ଶ  

𝐻𝐶𝑂ଷ
ି ൅ 𝑒ି ൌ

1
2
𝐻ଶ ൅ 𝐶𝑂ଷ

ିଶ 

To test the CO2 impact, you will recalculate the corrosion rate using two CO2 concentrations: 0 and 0.6 ppm.  
 
Under the stream ‘CR vs Flow’ add new corrosion rate calculation. Go to the Add Calculation button and select 
Corrosion Rates calculation or by selecting the Add Corrosion Rates icon in the Actions Pane 
Change the Rates name to Static Flow, O2 and CO2 using the <F2> key 
Add Oxygen (O2) and carbon dioxide (CO2) to the inflow grid 
Leave the default Flow Type as Static  
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Go to the Survey by button and select Survey by Composition and then by Composition (as shown below) 

 

The next step is the concentration range of oxygen and carbon dioxide. Go to the Specs button next to the 
Composition option. This will open a new window. 
Under the Category section, make sure to select Var. 1 -Composition. Go to the Component tab, and select 
O2 

 

Then select the Survey Range tab and enter the Survey Range as follows: Log Scale, Start=1e-6, End=10, 
Steps=10. Then click OK. 
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Under the Category section, select Var. 2 -Composition. Go to the Component tab, and select CO2 

 

Then select the Survey Range tab. Select the Point List option. Create two points with values of 0 and 0.6 
mg/L. Then click OK. 

 

Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

  



 

think simulation | getting the chemistry right 301 

 

Your screen should look like the image below. 

 

We are ready to perform the calculation. Click on the Calculate button or 
press the <F9> key  

 
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under the same file created in the previous example 
named Corrosion Rates.  
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Analyzing the Results 

Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 
corrosion rate and pH. 

Right-mouse click on the X-axis and change it to Logarithmic Scale 
Right-mouse click on the Y-axis and change it to Logarithmic Scale 
Right-mouse click on the pH curve and select Remove Series 

 

The effects of CO2 are small, particularly in relation to the oxygen effects. The Corrosion rates at low O2 content 
are about 0.0071 mm/yr with no CO2 and 0.0083 mm/yr with 0.6 mg/l CO2; a small difference between two small 
rates. At 10 mg/l O2 the corrosion rate is 0.16 mm/y and it is the same with and without CO2. Thus, CO2 has no 
effect on corrosion at high O2 concentrations meaning that the surface is corroded by oxygen and small 
concentrations of CO2 does not change this rate.  



 

think simulation | getting the chemistry right 303 

 

Sixth operation condition: 300 cycles/min flow, tank open to the atmosphere (aerated with O2 and CO2) at 
ambient conditions  

 
Lastly, you will look at the effects of shear rates on the tank in contact with CO2 and O2. 
 
Copy (right-mouse click or Ctrl+C) ‘Static Flow, O2 and CO2’ corrosion calculation, and paste (right-mouse 
click or Ctrl+V)under the stream ‘CR vs Flow’ 
 

  
 

Change the Static Flow, O2 and CO2-1 name to 300 rpm flow, O2 and CO2 using the <F2> key 
Add Oxygen (O2) and carbon dioxide (CO2) to the inflow grid 
Change the Flow Type from Static to Rotating Cylinder 
Set the Rotor Diameter to 200 cm 
Set the Rotor Rotation to 300 cycles/min 
Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

Your screen should look like the image below. 
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We are ready to perform the calculation. Click on the Calculate button or press the <F9> key  
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Corrosion Rates. 
 
 

Analyzing the Results 

Click on the General Corr. Rate tab ( ). This tab displays a plot showing the results of 
corrosion rate and pH. 
 
Right-mouse click on the X-axis and change it to Logarithmic Scale 
Right-mouse click on the Y-axis and change it to Logarithmic Scale 
Right-mouse click on the pH curve and select Remove Series 
Double click on the CO2=0.6 mg/L. This will open a new window. Change the color to blue. 

 

The plot should look like the image below. 

 



 

think simulation | getting the chemistry right 305 

 

The 0.6 mg/L CO2 curve shifted to higher values at low O2 concentrations compared to no CO2 presence. Now, 
when comparing the corrosion rate for the 0.6 mg/L CO2 concentration at 300 rpm vs static conditions, the rates 
are 0.067 mm/year and 0.008 mm/year respectively. The effect of shear at high O2 concentrations (right side of 
the plot) is also pronounced. Corrosion is still dominated by O2 attack, but the rate is now over 10 mm/year, 
about 100x greater than the static conditions. 

Gas condensate corrosion 

Example 52: Condensed overhead gas and mitigation strategies 

An alkanolamine gas sweetening plant has corrosion problems in the condensed overhead gas. 

Diethanolamine is used to neutralize an acid gas containing carbon dioxide (CO2) and hydrogen sulfide (H2S). 
The diethanolamine is regenerated and the acid gases are driven off in a stripper. The off gas from this stripper 
is saturated with water vapor. As these gases cool, they will condense. This condensate can be very corrosive. 
The plant’s service life can be shortened considerably due to these condensed acid gases. 

In this example, you will calculate the gas dew point temperature, remove the condensed aqueous phase and 
perform a Corrosion Rate calculation with the condensed water. Lastly, you will consider mitigation strategies 
for the pipes.  

You are introducing fluid velocity and liquid condensation into the calculation. The software uses a diffusion 
layer model to compute mass transfer to and from corroding surfaces. Higher rates produce thinner layers, 
resulting in faster mass transfer rates, and thus higher corrosion rates. The liquid condensation point is 
straightforward; it calculates the temperature (or pressure) where the first liquid drop forms. 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Corrosion Rate Calculation 
Calculation Settings Stream Composition and Conditions 
Stream Name Gas condensate Stream Amount 1e5 moles 
Name Style Display Formula Temperature 38 ⁰C 
Unit Set Metric, Batch, Mole Fraction Pressure 1.2 atm 
Framework  AQ H2O Calculated (mole%) 
Calculation Type Corrosion Rates CO2 77.4 
Survey Single Point Rate N2 0.02 
Flow Type Pipe Flow H2S 16.6 
Pipe Diameter 10  cm CH4 0.5 
Pipe Flow Velocity 2 m/s C2H6 0.03 
Contact Surface Carbon Steel G10100 (generic) C3H8 0.03 

 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Gas Condensate 

Select the AQ thermodynamic Framework 

Click on the Names Manager Icon and select the Formula option 

Click on the Units Manager Icon, and select Metric, Batch, Mole Fraction 
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Enter the composition, temperature and pressure of the stream given in the table above 

Go to the Add Calculation button and select Corrosion Rates calculation or by selecting the Add Corrosion 

Rates icon in the Actions Pane.  

Go to the Survey by option and select Single Point Rate. Change the name to Gas Cond. Dew Point. 

Change the Flow Type from Static to Pipe Flow. 

Specify the Pipe Diameter = 10 cm and the Pipe Flow Velocity = 2 m/s. 

Leave the default alloy Carbon steel G10100 (generic) as the contact surface 

 

Your screen should look like the image below. 

 

 

Now that the gas condensate stream is created, the next task is to isolate the condensed water at the dew point 

temperature. 
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Click on the Specs button. This will open a new window 

Under the Category section, select Calculation Type 

Change the Type of Calculation from Isothermal to Dew Point. Make sure that radio button for temperature is 

selected since we are going to calculate the Dew Point temperature for this example. Then click OK. Notice 

that the input grid has been updated: 

 

You could have also used the drop-down arrow next to the “Calculation Type” box to directly pick a dew point 

(or any other required) calculation type. 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 

same file created in the previous example named Corrosion Rates. 

 

Analyzing the Results 

Click on the General Corr. Rate tab ( ). 

Click on the View Data button to see the results in tabulated form. 

 

Notice that the calculated dew temperature is 37.6⁰C, corrosion rate is 0.7 mm/year, and the dew point pH 

is 3.9. To further interpret the results of this calculation, we are going to study the polarization curve.  

Click on the Polarization Curve tab ( ). Before interpreting this plot, we will format it for easy 
viewing. 

Click on the Options button. This will open a new window.  

 

Under the Category section select X axis.  Change the Minimum to 1e-6 and Maximum to 1e6. 

Now, select Y axis.  Change the Minimum to -1.5 and Maximum to 1.5. Then click OK. 
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Click on the Variables button. This will open a new window.  

 

Remove the following variables by unchecking them. See image below. Then Click OK. 

 

Your polarization curve should look like the image below. 

 
You can click and drag the legend of the polarization curve to your desired position.  

This is a measured potential vs. current density plot. The anodic portion (green curve) is the carbon steel. There 
are cathodic reactions. The sum of the cathodic currents adds up to the anode curve at a single point: The 
corrosion potential (represented by the inverted red triangle ▼) with a value of -0.43 V vs SHE. At the corrosion 
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potential, the anodic and cathodic currents are equal, and this value is also known as the icorr. For this example, 
icorr=0.61 A/m2. 

Notice that the cathodic reaction that contributes the most to corrosion is H2CO3 (light green line). The next 
contributors are H2S (orange line) and HS-1(blue line) equally. After that is H+ (turquoise line). Water reduction 
(light blue line), contributes the least to corrosion. 

 

Mitigation Strategies 

There are several mitigating solutions to this corrosion problem. 

One is adding insulation to prevent temperature drops. The dew point is very close to the overhead gas 
temperature so this may not be a suitable option. Adding heat to keep the temperature above the dew point is 
usually considered along with insulation. 

Changing the chemistry to change the partial oxidation and reduction processes is also an option.  

Changing alloys could mitigate the corrosion problems as well.  

We will explore the change of chemistry and change of alloys for this example. 

 

Adjusting the solution chemistry 

The condensate pH is approximately 3.9. We can try to add a base to increase the pH. In this section, we will 
add Diethanolamine to raise the pH to 7.5. 

Single Point– Set pH Calculation 
 
Click on the ‘Gas Condensate’ stream and go to the Add Calculation button and select Single Point 
calculation or by selecting the Add Single Point icon in the Actions Pane.  
Change the name to DEA using the <F2> key.  
Add DEA in the inflows grid. (It should have changed to the formula name: HN(C2H4OH)2 
Go to the Type of Calculation option and select Set pH 
Change the Target pH to 7.5 
Click on the drop-down arrow for the pH Base Titrant and select DEA (or HN(C2H4OH)2) 
 
We have set up the calculation to adjust the amount of DEA to match the target value of pH=7.5. 
 
Your screen should look like the image below. 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Corrosion Rates.  
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Analyzing the Results 

Check the summary box to analyze the results. 

 

The pH is set to 7.5 and the inflow of DEA to the total gas is approximately 5.97e-4 mole%. 

The DEA concentration in the condensing water and the amount remaining in the vapor phase can both be 
viewed in the Report tab. 

Click on the Report Tab and go to the Total and Phase Flows and Species Output tables 
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Recalculating the corrosion rate with DEA 

We first need to capture the condensate from the DEA pH calculation. We want only the liquid portion to perform 
our corrosion rate calculation. This would represent the first drop of condensate from the gas stream. 

 

Click the Add as Stream button 
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Uncheck the following boxes: Second Liquid, Vapor, and Solids. This removes these phases from the 
saved stream. Click the OK button 

We now can recalculate the corrosion rate with DEA in the stream. This represents some DEA entrained in the 
vapor phase as the gas leaves the regenerator. 

 Copy ‘Gas Cond. Dew Point’ corrosion calculation from the Gas condensate stream, and paste it under 
the stream ‘DEA-Liq1’ 

  

Change the name to Gas Cond. Dew Point DEA using the <F2> key 
The added DEA is already in the inflows gird. 
Leave the default alloy Carbon steel G10100 (generic) as the contact surface 
Change the calculation type to Isothermal 

Your screen should look like the image below. 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Corrosion Rates. 
 

 

Analyzing the Results 

Click on the General Corr. Rate tab ( ). 

Click on the View Data button to see the results in tabulated form. 
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Notice that the corrosion rate has decreased from 0.7 mm/year to 0.48 mm year. The pH is 7.6, and it 

remained like the target value of 7.5. Based on these results neutralizing the pH had a partial effect on 

corrosion reduction.  

 

Changing the Alloy 

Since treating the acid gas with a base is probably not a good idea for metal hydroxides, perhaps we can 
change the alloy. We will add a new corrosion rates calculation and test different alloys. 

13%Cr Stainless Steel 
 
Copy ‘Gas Cond. Dew Point’ corrosion calculation, and paste it under the stream ‘Gas Condensate’ 

 
Change the name to Gas Cond. 13%Cr using the <F2> key.  

 
Notice that in the inflows, copying and pasting  does not bring the DEA and its composition to this corrosion 
calculation. The reason why is because the DEA was added at the corrosion rate calculation level, and not 
at the stream level. 
 

Change the contact surface to Super13%Cr stainless steel 

Your screen should look like the image below. 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Corrosion Rates. 

 

Analyzing the Results 

Click on the Report tab to see the results. (You may need to use the ◄► buttons to move the tabs and find 
the Report tab). 

Go to the Calculated Rates table 
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The corrosion rate of Super 13%Cr is several orders of magnitude lower when compared to the corrosion 
rate for Carbon Steel, i.e.  at 0.0012 mm/year for 13%Cr vs 0.7 mm/year for Carbon Steel. This is consistent 
with the use of Super 13% Cr to protect against CO2 corrosion. 

Click on the Polarization Curve tab ( ). 

Click on the Variables button. This will open a new window.  

 

Remove the following variables by unchecking them. See image below. Then Click OK. 

 

The polarization curve (after some layout modifications) should look like the image below. 
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The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select 

the option Alloy Layout Changes to modify the appearance of your plot.  

The corrosion potential of Super 13%Cr is -0.25 V vs SHE and the corresponding corrosion current 
icorr=0.001A/m2. The icorr for Carbon Steel was 0.61 A/m2, this means that 13%Cr is 10x more resistant to 
corrosion under the same conditions.  

Stainless Steel 304 
 

Copy ‘Gas Cond. Dew Point’ corrosion calculation, and paste it under the stream ‘Gas Condensate’ 
Change the name to Gas Cond. SS304 using the <F2> key 
Change the contact surface to Stainless Steel 304 

 
Your screen should look like the image below. 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous example named Corrosion Rates. 
Analyzing the Results 

 
Click on the Report tab to see the results. (You may need to use the ◄► buttons to move the tabs and find 
the Report tab). 
Go to the Calculated Rates table 

 

 
 

The corrosion rate of 304 SS is now 0.0024 mm/year. This is a negligible value. 
 
Click on the Polarization Curve tab ( ). 
Click on the Variables button. This will open a new window.  
Remove the following variables by unchecking them. See image below. Then Click OK. 

 

 

The polarization curve (after some layout modifications) should look like the image below. 
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The layout of the plot was changed for easy reading. To change layout, you can right click on any part of the plot and select 

the option Alloy Layout Changes to modify the appearance of your plot.  

The corrosion potential of SS304 is -0.17 V vs SHE and the corresponding corrosion current icorr=3.3e-3 A/m2. 
With this low corrosion current density, sour gas regeneration can be remedied using a higher-grade alloy such 
as SS304.    
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Section 9. Thermal Aging and Variations in Alloy Composition 

Overview and Basic Terminology 

Localized corrosion of engineering alloys is a complex function of metallurgical factors and environmental 
conditions. Among metallurgical factors, effects of thermal instabilities are of interest for assessing the 
performance and expected service life of industrial components fabricated from nominally corrosion-resistant 
stainless steels and nickel-base alloys. 

Fabrication processes such as heat treatment and welding are known to introduce microstructural changes that 
may affect both the mechanical and corrosion performance of an alloy. In particular, thermal instability of 
stainless steels and nickel-base alloys may lead to the formation of complex metal carbides of the type M3C2, 
M7C3, M6C, or M23C6 in which the metallic component M represents Cr, Mo, W, and Fe. The carbide is 
chromium- or molybdenum-rich depending on the carbide type, which in turn depends on the alloy composition 
and temperature. Also, various chromium-rich intermetallic phases can form in many alloys. Precipitation of 
such phases may occur at temperatures ranging from 500 to 900 °C depending on alloy composition. Formation 
of grain boundary carbides often results in the depletion of chromium and, possibly, molybdenum in the vicinity 
of the grain boundary because of the slow diffusion of substitutional elements such as chromium relative to the 
interstitial carbon. 

Similarly, the corrosion resistance of welded components may be affected by the segregation of alloying 
elements and precipitation of intermetallic phases, carbides or nitrides in the solidified weld and unmixed zones 
as well as the precipitation of carbides and other phases in the heat-affected zone adjacent to the weld. 

Sensitization of Fe-Ni-Cr-Mo alloys and its effects on intergranular attack and intergranular stress corrosion 
cracking is the most directly observed effect of Cr depletion. It may result in intergranular attack and 
intergranular stress corrosion cracking. Localized corrosion can be also affected by Cr and Mo depletion.  

Corrosion Analyzer contains the following technology that can help address these issues: 

A grain boundary microchemistry model for predicting the chromium and molybdenum depletion in the vicinity 
of grain boundaries as a result of carbide formation. 
An electrochemical model for calculating the repassivation potential of Fe-Ni-Cr-Mo-W alloys as a function of 
alloy composition and environmental conditions including temperature and concentrations of aqueous solution 
species. 
A procedure for calculating the observable repassivation potential that corresponds to macroscopic localized 
corrosion by applying the electrochemical model to the depletion profiles and performing suitable integration. 

More details about this technology are described by Anderko et al. (2008), Tormoen et al. (2009), Anderko et 
al. (2009), and Sridhar et al. (2009). 

Alloy Chemistry 

Simulations can be performed, in general, for alloys that belong to the Fe-Ni-Cr-Mo-W-N-C family (i.e., for 
stainless steels and nickel-base alloys).  

Depletion profiles in the vicinity of grain boundaries and depletion parameters can be obtained for austenitic 
alloys (including stainless steels and Ni-base alloys). Also, the effect of Cr and Mo depletion on localized 
corrosion can be calculated. This effect can be examined using the repassivation potential, which provides a 
threshold potential for the stabilization of localized corrosion (Anderko et al., 2009).  
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For other alloys from the Fe-Ni-Cr-Mo-W-N-C family, the repassivation potential can be calculated if the alloy 
composition is known. This also includes experimental alloys and separate phases that may be formed as a 
result of various forms of heat treatment (Sridhar et al., 2009).  

Calculation types 

Thermal aging is an additional phenomenon that can be simulated within the framework of corrosion kinetics. 
All calculation types and, in particular, survey types, that are supported for corrosion kinetics are also supported 
in conjunction with the study of thermal aging. 

If it is desired to make calculations on a thermally aged sample, the thermal aging temperature and time need 
to be specified in the Calc Parameters section in the Definition tab. The default values are 399 °C for the 
thermal aging temperature and 0.0 hours for the thermal aging time. If either of these default values is used, no 
thermal aging effects will be predicted. Thus, by default, Corrosion Analyzer performs calculations on samples 
that have not been thermally aged. 

Thermal Aging Temperature Survey 

This calculation makes it possible to vary the thermal aging temperature within a certain range. A fixed value of 
thermal aging time is assumed as specified by the user. Typically, the temperatures for which thermal aging 
effects can be observed range from ~500 °C to ~900 °C, with the effects being most pronounced in the middle 
of this range. 

Thermal Aging Time Survey 

This calculation can be used to examine the effect of aging time at a fixed thermal aging temperature. 

Output Specific to Thermal Aging 

The following output can be generated: 

Chromium and molybdenum depletion profiles, i.e., the variation of Cr and Mo concentration within the grain 
as a function of grain boundary. 

 
The depletion parameter, which provides compact information on the extent to which the depletion process 
reduces the grain boundary concentration below a certain critical value of, which can be defined by well-
known criteria for maintaining passivity (e.g. 𝑥஼௥

∗ ൌ 0.11 𝑜𝑟 0.12). This parameter can be calculated as the area 
of the depletion profile below the threshold concentration 𝑥஼௥

∗ , divided by bulk Cr concentration, 𝑥஼௥
଴ : 

𝛿ሺ𝑥஼௥
∗ ሻ ൌ

1
𝑥஼௥
଴ න ൫𝑥஼௥

∗ െ 𝑥஼௥ሺ𝑧ሻ൯𝑑𝑧
௭∗

଴
 

where 𝑧∗ is the distance from the grain boundary that corresponds to the threshold concentration 𝑥஼௥
∗ . 

 
The repassivation potential, which is a key parameter for determining whether localized corrosion can occur, 
may be affected by thermal aging in a rather complex way.  
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Thermal Aging and Variations in Alloy Composition 

We will show examples of simulating the effects of thermal aging on Fe-Ni-Cr-Mo-W-C-N alloys (i.e., stainless 
steels and nickel-base alloys). Specifically, we will show how to predict: 

Chromium and molybdenum depletion profiles in the vicinity of grain 
boundaries, which result from heat treatment of austenitic alloys. 

Depletion parameters for sensitized austenitic alloys, which provide an 
indicator of whether the alloy is susceptible to intergranular corrosion. 

Effect of thermal aging on the repassivation potential of austenitic alloys, 
which provides a threshold condition for localized corrosion (pitting or crevice 
corrosion). 

The repassivation potential of alloys with compositional variations that may or 
may not result from thermal aging. This facility can also be used for bulk 
alloys that are not in the database or to hypothetical or experimental alloys 
as long as they belong to the Fe-Ni-Cr-Mo-W-C-N family. An example will be 
given for a duplex alloy, either annealed or thermally treated. 

Example 53: Thermal aging of alloy 600 

We will be studying the behavior of thermally aged alloy 600 in a dilute aqueous solution of sodium chloride, 
and will simulate how the time of thermal aging affects alloy 600 at a fixed thermal aging temperature of 700°C. 

Starting the Simulation 

Thermal Aging Calculation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Thermal Aging Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Thermal Aging Stream Amount Calculated 
Calculation Type Corrosion Rates Temperature 60 ⁰C 
Survey by Thermal Aging Time Pressure 1 atm 
Name Style Display Name H2O Default – 55.5082 moles 
Unit Set Metric, Batch, Moles NaCl 0.04 moles 
Framework  AQ   
    

 

Add a new Stream 

Click on the new Stream and press <F2> to change the name to Thermal Aging 

Select the AQ thermodynamic Framework (selected by default) 

Click on the Units Manager Icon and select Metric, Batch, Moles 

Click on the Names Manager Icon and select Display Name 

Enter the stream composition and conditions specified in the table above 
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Go to the Add Calculation button and select Corrosion Rates 

Note: Even though the thermal aging simulation facilities do not predict corrosion rates per se, they belong 

to the category of corrosion kinetics and, therefore, they are included in the Corrosion Rates section of the 

Corrosion Analyzer. 

 

Select the Survey by Thermal Aging Time 

Change the name from Rates to Alloy 600 using the <F2> key or by right-mouse click on the object and 

select rename 

Select Alloy 600 from the Contact Surface grid 

In the Calculation Parameters grid, change the default value for the Thermal Aging Temperature to 700°C.  

Note that the default value for the Thermal Aging Temperature is 399 °C, which is a low value so that, in 

the default case, no effects of thermal aging are being calculated.   

 

Your screen should look like the image below. 

 

Now we need to specify the Thermal Aging Time range. Click on the Specs button. This will open a new 

window.  
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Under the Survey Range tab, change the range for Thermal Aging Time from 0 to 22 hours with an increment 
of 4.4 hours (of 5 steps). 

 

 
 

Under the Category section, select the Thermal Aging option. 

 

In this Thermal Aging Category, you can change all parameters that are necessary for calculating chromium 
and (if applicable) molybdenum depletion profiles. You can change: 
The alloy composition (for example, to analyze the effect of a different carbon content); 
The stoichiometry of the carbide phase that may form at the grain boundary; the typical carbide stoichiometry 
is M7C3 or M23C6 (where M = Cr, Mo) but can be adjusted  
The parameters that define the equilibrium constant for the formation of the carbide 
The diffusion coefficient of Cr and, if applicable, Mo 
The threshold concentration of Cr for sensitization. This threshold concentration is used for calculating the 
depletion parameter. 
The average grain size, which affects the process of healing of chromium depletion as a function of time 
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Also, you can indicate whether the repassivation potential (Erp) should be calculated directly from the correlation 
developed by Anderko et al. (2008), which expresses Erp as a function of alloy composition or not. If it is not 
calculated directly, then the repassivation potential is calculated first using the alloy-specific parameters for the 
alloy of interest and only the decrement of Erp (i.e., Erp, thermally aged – Erp, bulk alloy) is obtained from the correlation. 
This decrement is then added to the alloy-specific Erp value. This option is set by default to “No” because this 
maximizes the accuracy of calculations for alloys that are already in the database. 

 
For now, we will accept the default settings. Click OK. 
Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous section named Corrosion Rates. 
 

Analyzing the Results 

Click on the Depletion Profile tab ( ). If you don’t see it in your screen, use the ◄► buttons 
to move the tabs. 
 

 
Note: Since alloy 600 does not contain any molybdenum, the molybdenum curves will always be equal to zero.   

 
This plot will show the concentrations of chromium and molybdenum within a grain as a function of the distance 
from the grain boundary (in m). You will see that, for each condition, there are four lines: 
Cr weight %: concentration of Cr in weight % 
Mo+W weight %: sum of the concentrations of molybdenum and tungsten in weight % 
Corrected Cr weight %: concentration of Cr corrected for beam scattering and related effects so that it can 
be directly compared with experimental results. The procedure for calculating the correction is described by 
Anderko et al. (2009). 
Corrected Mo+W weight %: sum of the concentrations of Mo and W corrected in the same way as those for 
Cr.  
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Let’s customize the plot 
 
Click on the Options button. This will open a new window. 
Since alloy 600 does not contain Mo or W, eliminate the Mo+W curves. To do this, go to the Category section 
and select the Curves option 
Highlight the Mo+W weight % curves by pressing the Shift key and the down key (Shift + ). After highlighting 
these curves, check the Hidden button.  

 

 
 

After hiding the Mo+W weight % curves, do the same for the Corrected Mo+W weight % curves. Then click 
OK. 

 
The plot should look like the image below. 
 

 
The legend of this plot was modified for clarity. The border style of the legend was modified by double clicking on the legend, 

and selecting None as the Border Style  
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Differences between Uncorrected and Corrected Depletion Profiles 

Now, let’s focus on the differences between the uncorrected and corrected depletion profiles. To have a clear 
picture of the difference between them, we will analyze the depletion profiles results obtained at 4.4 hours of 
thermal aging. 

Click on the Options button, and select the Curves category 
Highlight all curves except the ones labeled as: 

 
Cr Weight % - Thermal Aging Time = 4.40000 hr, and 

Corrected Cr Weight % - Thermal Aging Time = 4.40000 hr 
 
Check the Hidden box, then click OK. 
 

Your plot should look that the image below. 

 

In the obtained plot, you can see the difference between the two curves for small distances from the grain 
boundary (roughly below 30 m). The corrected concentration is much more rounded in the vicinity of the 
minimum because instrumental measurement effects. At larger distances from the grain boundary, there is no 
difference between the two curves. 
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Effect of Cr depletion on corrosion 

After analyzing the depletion profiles, let’s focus on the effects of Cr depletion on corrosion. We will do it by 
analyzing two parameters – the depletion parameter and the repassivation potential.  

To have more meaningful results, let’s expand the range of thermal aging time and reduce the interval for 
calculations. 

Copy the Alloy 600 corrosion calculation, and then paste it under the Thermal Aging Stream 
Rename the new calculation as Alloy 600 – Cr depletion 
Go back to the Definition tab and click the Specs button 
In the Var.1 Thermal Aging Time category, change the Survey Range as follows: Start=0 hours, End= 60 
hours with an Increment= 1 hour. Then click OK. 

Your screen should look like the image below 

 

Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous section named Corrosion Rates.  
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Analyzing the Results 

Click on the Localized Corr. tab ( ). By default, this tab will show a plot of the corrosion potential 
and repassivation potential.  

 

Let’s add a new parameter to the plot: The Depletion Parameter. 

 

Click on the Variables button. This will open a new window. 
Look for the Corrosion Values section, click on the ‘+’ icon, and select the Depletion Parameter option. 
Click on the >> button that belongs the Y2 Axis. This action will place the new variable under the Y2 Axis. 
Then click OK. 
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The plot should look like the image below. 

 

It is clear that the depletion parameter reaches a maximum for aging time of about 10 hours. Since the depletion 
parameter is a measure of the susceptibility of an alloy to intergranular corrosion, we can expect that the alloy 
will be most susceptible to intergranular corrosion at intermediate aging times. When the depletion parameter 
is zero, intergranular corrosion or intergranular stress corrosion cracking are unlikely. The decrease of the 
depletion parameter as a function of time is a manifestation of the phenomenon of healing of Cr depletion. 

The repassivation potential shows a minimum as a function of aging time (see the option View Data). This 
indicates that the tendency of the alloy to undergo localized corrosion is enhanced as a result of thermal aging. 
However, the effect of thermal aging on the repassivation potential of alloy 600 is small (cf. Tormoen et al., 
2009, Anderko et al., 2009). The repassivation potential shows a minimum at low aging times (ca. 1-2 hours). 
Therefore, the susceptibility to localized corrosion is enhanced the most for these aging times. It is noteworthy 
that the maximum in the depletion parameter does not coincide with the minimum in the repassivation potential. 
This is due to the fact that intergranular corrosion (which is related to the depletion parameter) and localized 
corrosion (which is controlled by the repassivation potential) are subject to different mechanisms. A general 
discussion of these differences is given by Tormoen et al. (2008).  

In general, the alloy will be susceptible to localized corrosion if the corrosion potential exceeds the repassivation 
potential. In the above example, the corrosion potential is low because we have no oxidizing agents in the 
system. Therefore, the alloy will not undergo localized corrosion at the conditions of this example. However, a 
rise in the corrosion potential due to the presence of oxidizing agents may cause localized corrosion. 
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Example 54: Thermal aging of alloy 825 
 
Alloy 825 is appreciably different from alloy 600 because it contains molybdenum and, also, substantially more 
chromium in addition to other alloying elements. 
 
In this example, we will simulate how the temperature of thermal aging affects alloy 825 at a fixed thermal aging 
time of 15 hours. 
 
Starting the Simulation 
 

Thermal Aging Calculation 

 
Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  
 

Thermal Aging Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Thermal Aging Stream Amount Calculated 
Calculation Type Corrosion Rates Temperature 95 ⁰C 
Survey by Thermal Aging Temperature Pressure 1 atm 
Name Style Display Name H2O Default – 55.5082 moles 
Unit Set Metric, Batch, Moles NaCl 2.846e-3 moles 
Framework  AQ   
    

 
Under the Thermal Aging stream add a new calculation rate. Go to the Add Calculation button and select 
Corrosion Rates or select the Add Corrosion Rates icon in the Actions panel 
Change the name from Rates to Alloy 825 using the <F2> key or by right-mouse click on the object and 
select rename 
Select the Survey by Thermal Aging Temperature option 
Change the stream composition and conditions to the specified values in the table above 
Select Alloy 825 from the Contact Surface grid 
In the Calculation Parameters grid, change the default value for the Thermal Aging Time to 15 hours 

 
Note that the default value for the Thermal Aging Temperature is 0 hours, which means that no thermal 
aging is considered by default.   

Your screen should look like the image below 
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Now we need to specify the Thermal Aging Temperature range. Click on the Specs button. This will open a 
new window. 
Under the Survey Range tab, change the range for Thermal Aging Temperature from 550 to 900 °C with 
increments of 50 °C. We will keep the other parameters at their default values. Click OK. 

 

 
 

We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous section named Corrosion Rates. 
 

Analyzing the results 

Click on the Depletion Profile tab ( ). If you don’t see it in your screen, use the ◄► buttons 
to move the tabs. 

Since alloy 825 contains Mo in addition to Cr, you will see the depletion profiles for both Cr and Mo. 
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For clarity, let’s customize the plot by removing the corrected depletion profiles and leaving only the uncorrected 
(or directly calculated) ones.  

Click on the Options button, and select the Curves category, highlight the Corrected curves and check the 

hidden box. Then click OK.  

 

Your plot should look like the image below 

 
The plot was modified by right clicking on it and selecting the option Allow Layout Changes. This option allows to move and 

rearrange the plot and legend. Additionally, the color of the lines was changed for each temperature in order to distinguish the 
temperature effect. 
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As shown in the plot above, the depletion profile is very narrow at the lowest temperature, i.e., 550 °C. On the 
other hand, it becomes flat at high temperatures, and it has a high minimum. The high minimum value is 
particularly important because it indicates that the local depletion of Cr and Mo is much less severe at high 
temperatures (due to much faster diffusion of substitutional elements and subsequent healing). 

It should be noted that the Mo profile qualitatively parallels the Cr profile but has somewhat different slopes 
because of differences in diffusion coefficients of Cr and Mo. 

Effect of Cr and Mo depletion on corrosion 

To look at the effect of Cr and Mo depletion on corrosion 

Click on the Localized Corr. tab ( ). By default, this tab will show a plot of the corrosion potential 
and repassivation potential. 

 

Let’s add a new parameter to the plot: The Depletion Parameter. 

Click on the Variables button. This will open a new window. 
 

Look for the Corrosion Values section, click on the ‘+’ icon, and select the Depletion Parameter option. Click 
on the >> button that belongs the Y2 Axis. This action will place the new variable under the Y2 Axis. Then click 
OK.  
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It is evident that both the depletion parameter and repassivation potential show their extreme values at 
intermediate temperatures of thermal aging. In the case of the depletion parameter, it is a maximum and, in the 
case of the repassivation potential, it is a minimum. This is in agreement with experimental data (Anderko et 
al., 2009). Non-zero values of the depletion parameter indicate the possibility of intergranular corrosion. A 
depression in the repassivation potential indicates an increased tendency for localized corrosion.  
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Thermal Aging and Localized Corrosion of Annealed and Thermally Aged 
Duplex Alloy 2324 

In the previous examples, we used the Corrosion Analyzer’s capabilities to predict the Cr and Mo depletion 
profiles for austenitic stainless steels and nickel-base alloys. However, we are not limited to such calculations. 

We can also use the Corrosion Analyzer to predict the localized corrosion behavior of other alloys and other 
phases, including those that are not stored in the database. This facility is based on a generalized correlation 
for predicting the repassivation potential of Fe-Ni-Cr-Mo-W-N alloys as a function of alloy composition (Anderko 
et al., 2008). This correlation can be applied to both bulk alloys that are not in the database and to phases that 
may result from thermal aging. 

In this section, we will go through two simulations: 

First, we will predict the tendency for localized corrosion for the duplex alloy 2324 in an aerated chloride 
solution. Alloy 2324 (a.k.a. AISI 329) is not in the database, so the repassivation potential will be calculated 
from the generalized correlation (Anderko et al., 2008). The corrosion potential will be calculated for a 
similar alloy because the corrosion potential does not differ much for many Fe-Cr-Ni-Mo alloys in the 
passive state in neutral solutions. 
 

Second, we will predict the localized corrosion tendency for alloy 2324 after thermal aging. Thermal aging 

of duplex steels in the temperature range of 900C to 600C leads to the formation of various phases - , 

, M23C6-type carbide, and secondary austenite (2). The secondary austenite phase is primarily responsible 
for the increased tendency of the alloy for localized corrosion. This is due to a very significant depletion of 
chromium in the secondary austenite over relatively wide spatial areas (Sridhar et al., 2009). Since the 
composition of the secondary austenite cannot be predicted at present, we will use experimental 
microstructural data (Sridhar et al., 2009) in conjunction with the generalized correlation for the 
repassivation potential. 

 

Example 55: Prediction of Localized Corrosion for Alloy 2324 Before Thermal Aging in an 
Aerated NaCl Solution 

Starting the Simulation 

Use the inputs and parameters from the table below to create the stream’s composition. Certain inputs, such 
as the name style, units, etc. will require further adjustments, and will be described as necessary.  

Thermal Aging Calculation 
Calculation Settings Stream Composition and Conditions 

Stream Name Thermal Aging – Alloy 2324 Stream Amount Calculated 
Calculation Type Corrosion Rates Temperature 60 ⁰C 
Survey by Composition  Pressure 1 atm 
Name Style Display Name H2O Default – 55.5082 moles 
Unit Set Metric, Batch, Moles NaCl 0 moles 
Framework  AQ O2 0.02 moles 
  N2 0.08 moles 

Note: The oxygen and nitrogen have been added to simulate the presence of air 
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Add a new Stream 
Click on the new Stream and press <F2> to change the name to Thermal Aging – Alloy 2324 
Select the AQ thermodynamic Framework (selected by default) 
Click on the Units Manager Icon and select Metric, Batch, Moles 
Click on the Names Manager Icon and select Display Name 
Enter the stream composition and conditions specified in the table above 
Go to the Add Calculation button and select Corrosion Rates 
Select the Survey by Composition 
Change the name from Rates to Alloy 2324 – before aging using the <F2> key or by right-mouse click on 
the object and select rename 
 
Since alloy 2324 is not available in the database, we will select stainless steel 316 as the contact surface. This 
will ensure that the predicted corrosion potential is very similar to that for alloy 2324. 
 
Select Stainless Steel 316 from the Contact Surface grid 

Unlike in the previous examples, do not make any changes in the Calc Parameters section. We will not make 
Cr depletion calculations; rather, we will be specifying the compositions of the phases. 

Your screen should look like the image below. 

 

We will be running a composition survey to see how the concentration of NaCl affects the propensity for 
localized corrosion.  
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We need to specify the NaCl concentration range. Click on the Specs button. This will open a new window. 
 

Under the Component tab select Sodium Chloride 

 

Click on the Survey Range tab and change the concentration range as follows: Start=0.001 moles, End=6 
moles, and number of steps=20. Then, click on the Log radio button. 

 

 
Under the Category section, select the Thermal Aging option. The screen will be populated with default 
parameters for type 316 stainless steel.  

In the following steps we are going to enter the alloy 2324 composition and use the repassivation potential (Erp) 
correlation (embedded in the software) to calculate the Erp of the alloy. This is necessary because no 
parameters for alloy 2324 are stored in the databank and we have to rely exclusively on the correlation to predict 
the repassivation potential.   
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First, click on the Yes button next to “Erp directly from correlation:”  

Then, enter the composition of alloy 2324 by replacing the default values for alloy 316.  

 

Enter the following composition of alloy 2324: 

 

Element Composition (wt%) 
Fe 67.245* 
Cr 25.4 
Ni 5.75 

Mo+W 1.5 
C 0.025 
N 0.08 

*which is the balance that includes many minor elements 

The remaining parameters in the Thermal Aging screen can remain the same because we will not be using 
them in this example (i.e., we will not be calculating any depletion profiles). After entering the values, the screen 
should look as follows: 

.  

Click OK to accept the changes 
 

We are now ready to perform the calculation. Click on the Calculate button 
or press the <F9> key 

 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. You can save it under the 
same file created in the previous section named Corrosion Rates.  
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Analyzing the results 

Click on the Localized Corr. tab ( ). By default, this tab will show a plot of the corrosion and 
repassivation potentials as a function of NaCl concentration. In the Y2 axis the Maximum Pit Current Density is 
also plotted.  

 

To visualize the results better, change the horizontal axis to a logarithmic scale. 

Right-mouse click on the X Axis and select Logarithmic Scale 
 

The plot should look like the image below. 

 

These results indicate that alloy 2324 is susceptible to localized corrosion in aerated solutions when the chloride 
concentration exceeds 0.3 molal. Above this concentration, the repassivation potential drops below the 
corrosion potential and, therefore, localized corrosion can be stabilized at these conditions. 
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Example 56: Prediction of Localized Corrosion for Alloy 2324 After Thermal Aging 

Now, we will perform the same prediction of localized corrosion calculations for thermally aged alloy 2324. We 
will run the same concentration survey as in the previous case so that we can compare the results for bulk alloy 
2324 with those for a heat-treated sample. 

Sridhar et al. (2009) found that after aging alloy 2205 at 700 °C for 24 hours, the formation of a chromium-
depleted secondary austenite phase is responsible for a much-increased tendency for localized corrosion. We 
will use this experimental data to approximate the localized corrosion tendency of alloy 2324. 

Starting the Simulation 

Copy the Alloy 2324-before aging calculation and paste it under the Thermal Aging – Alloy 2324 stream 
 

   
 

Rename the calculation as Alloy 2324 – after aging by using the <F2> key or by right-mouse click on the 
object and select rename 
 
Click on the Specs button. This will open a new window. 

 
Under the Category section, select the Thermal Aging option. The screen will be populated with default 
parameters for type 316 stainless steel.  

 
Click on the Yes button next to “Erp directly from correlation:” – because we will be running calculations for a 
completely new phase 

 
Then, enter the composition of the secondary austenite phase by replacing the default values for alloy 316.  

 
Note: we are using experimental data obtained for alloy 2205 for illustration purposes). For more details 
how these compositions were determined, see the paper of Sridhar et al. (2009).  
 
Enter the following composition: 
 

Element Composition (wt%) 
Fe 80.774* 
Cr 12.512 
Ni 5.134 

Mo+W 1.399 
C 0.017 
N 0.164 

*which is the balance that includes many minor elements 
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The remaining parameters in the Thermal Aging screen can remain the same because we will not be using 
them in this example (i.e., we will not be calculating any depletion profiles). After entering the values, the screen 
should look like the image below. 
 

 

Click OK to accept the changes 
We are now ready to perform the calculation. Click on the Calculate button 
or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool 
bar. You can save it under  
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Analyzing the results 

Click on the Localized Corr. tab ( ). By default, this tab will show a plot of the corrosion and 
repassivation potentials as a function of NaCl concentration. In the Y2 axis the Maximum Pit Current Density is 
also plotted.  

 
To visualize the results better, change the horizontal axis to a logarithmic scale. 

Right-mouse click on the X Axis and select Logarithmic Scale 
 

The plot should look like the image below. 

 

The obtained plot shows that the repassivation potential is much lower than that for bulk alloy 2324. Because 
of the strong depression of the repassivation potential, the corrosion potential exceeds the repassivation 
potential at chloride concentrations of 0.0007 m. Thus, localized corrosion is predicted to be possible at 
concentrations above 0.0007 m. This indicates a very strong increase in the propensity for localized corrosion 
compared with bulk alloy 2324, for which the predicted threshold is 0.3 m. 

In general, you can use this facility to predict the repassivation potential for any alloys, including unknown and 
experimental ones, as long as they belong to the Fe-Ni-Cr-Mo-W-N-C family.
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Chapter IV – OLI Studio: EVS Analyzer

Section 10. EVS Overview 

Overview and Theoretical Foundation 

Engineering systems may have many pits and corroded areas of varying degree of severity. The first 
perforation, whose time and location will be a matter of probability, may cause the failure of the construction.  
Accordingly, the probability of such failure must be known as accurately as possible. 

Extreme value statistics (EVS) is one of the most powerful statistical techniques that have been used 
extensively to extrapolate damage (maximum pit depth) from small samples in the laboratory to larger area 
samples in the field (see, for example, Eldridge G. 1957, Shibata T. et al. 1988, Kowaka et al. 1994). Thus, it 
was shown (Shibata T. et al. 1988) that probability of failure of a construction, Pf, i.e. the probability that at least 
one pit reaches the critical dimension, d, (for example wall thickness) in the system with area S is described by 
the equation: 
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where location parameter, u, and scale parameter, α, are measured by using small samples with constant area, 
s. Equation (1) is to extrapolate corrosion damage from a small reference area, such as a coupon to a larger 
operation area, S. This is the classical use of Extreme Value Statistics. 

Experimental studies demonstrate that both the shape and location parameters are time dependent. However, 
those dependencies must be established empirically and since no theory contained within classical EVS is 
available for the functional forms of u(t) and α(t), it is necessary to know answer (prediction) in advance for 
predicting the damage at long times. This has proven to be a severe constrains of the applicability of classical 
EVS.  

This problem can be overcome by applying damage function analysis (DFA) method that considers propagation 
of corrosion damage by drawing an analogy between the growth of a pit and the movement of a particle 
(Engelhardt and Macdonald, 2004). In many cases DFA yields an analytical expression for u and α in terms of 
time of the hyperbolic form: 

𝑢 ൌ
௔భ௧

ଵା௔మ௧
 𝑎𝑛𝑑 𝛼 ൌ 𝑎ଷ𝑡      (2) 

where a1, a2, and a3 are readily determined by calibration from short term data in order to predict damage over 
the longer time. Namely, equations (2) are used now by OLI software for predicting damage in corroding 
systems. It must be noted that a different (power) form of such dependencies has been used by Laycock et al. 
1990. 

Input and Output Specific to EVS 

For applying this technique the user has to provide a set of experimental data (xi, ti, si), i = 1,2,…,N, where xi is 
the depth of the deepest pit over area si, of a metal exposed to corrosion attack. The separate area, si, could 
be distinct coupons from a designed experiment or random samples at various times from different locations in 
the system. Experiments must be performed for at least two different times.  

The output of the code yields the probability of failure as a function of time for a large system with area S. The 
code also allows the user to answer on several engineering questions, for example, what service life, t, will 
have the pipe with the width, d, and length L in order to ensure acceptable performance (probability of failure, 
Pf ).  
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Advantages and Disadvantages of EVS 

The advantage of this approach is self-evident. The prediction of corrosion damage for long times will be done 
by using experimental data for short times without requiring the explicit determination of any information about 
the kinetic parameters of the system. However, such approach has evident disadvantages, as follows:    

The results of the analysis cannot be transferred for predicting corrosion damage to other systems (for 
example pipelines) due to the different technological and environmental conditions that generally exist. The 
results cannot be used for predicting damage in the same system if technological and environmental 
conditions change. 

 
We can expect that when the depth of the pit increases some critical value, the nucleation of cracks can 
occur. A purely statistical method cannot predict such a transition. This method also cannot predict any 
catastrophic event. 

 
This method cannot be used for design of new constriction, because it relies upon calibration upon a pre-
existing system. 

Extreme Value Statistics for Predicting Pitting Damage 

We will show examples of applications of Extreme Value Statistics for predicting pitting damage. Specifically, 
we will show how to predict: 

The depth of the deepest pit in the engineering structure or laboratory systems as a function of time and the 
surface area of the system 

 
Probability of failure for a given penetration depth and the area of the system as a function of observation time 

 
Probability of failure for a given observation time and the area of the system as a function of penetration depth 

 
Probability of failure for a given penetration depth and observation time as a function of the area of the system 

Foundations of Extreme Value Statistics can be found in the following references: (Aziz, 1956, Kowaka et al. 
1994, Laycock et al. 1990, Engelhardt and Macdonald, 2004). 

 
Example 57: Corrosion of Aluminum Alloy in Tap Water  

In this example, we will consider the classical data for pitting corrosion (Aziz, 1956). In this paper, we can find 
particularly the experimental data for the maximum pit depths developed on Alcan 2S-O coupons with area 
s≈129 cm2 immersed in Kingston tape water at 25 0C . The experimental data is summarized in the table below. 

Maximum pit depth (in μm) developed on Alcan 2S-O coupons with immersed in Kingston tape water for different observation 
times. Area of all coupons is s≈129 cm2 

Coupon # One Week One Month Three Months Six Month One Year 
 7 days 30 days 90 days 180 days 365 days 
1 180 460 480 620 640 
2 266 500 578 620 680 
3 290 510 610 620 700 
4 306 580 610 680 760 
5 334 580 610 680 800 
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6 340 640 660 720 810 
7 340 654 690 740 820 
8 410 680 718 740 840 
9 410 692 760 760 840 
10 545 692 798 760 900 

 

Calculating the Depth of the Deepest Pit 

Starting the Simulation 

 
Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane 

 

 
 

Click on the new EVS calculation and press <F2> to change the name to EVS-Aluminum samples.  Notice that 
the default calculation is the Pit Depth Prediction. 

 
All samples have a constant area s = 129 cm2. Under the Calculation Parameters grid, enter 129 cm2 for the 
Surface Area and Default Value cells. 
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There are experimental data sets for 5 different periods of time. This means that we need to enter 5 different 
sample groups. 

By default, Sample group 01 is created. Click on the …   button to edit this field. This will open a new window. 
 

Change the title to One Week, enter the number 7 for the number of elapsed days, and check the box ‘Include 
for Calculation’. Then click OK.  
 

 
 

Enter the Pit Depth data (second column) obtained for 1 week 

 

Now we need to add 4 more groups. 

Click on the Add Group button (located at the bottom of the window). This will open a new window. 
 

Change the title to One Month, enter the number 30 for the number of elapsed days, and check the box 
‘Include for Calculation’. Then click OK. 

 
Enter the Pit Depth data (second column) obtained for 1 month.  

 
Click on the Add Group button, and repeat the same procedure for one month, three months, six months and 
one year. 
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Note the following: 

Here, for the description of different experiments we simply used the number of the corresponding row in 
Table 1. However, this description can be done in an arbitrary form. 

 
For each group, the order of samples relative depth can be arbitrary (not necessary in ascending order as in 
Table 1) 

 
If coupons have different areas each area must be specified in the column Area 

 
Radio button Elapsed means the time after corrosion attack is used in calculations and namely this time is 
used usually in scientific publication. However, it is possible to use also Actual Time of the experiments.  

 

At this point, the experimental data has been entered. Now we need define the period of time for which we want 
to do the prediction of failure due to pitting. 

Click on the Specs button. This will open a new window. 
 

Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 days, End=365 
days, and number of steps=50. Then click OK 
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Before running the calculation, we are going to study two different cases: 
 
The first case will include the experimental data for 1 week and 1 month – short term experiments 

 
The second case will include all the experimental data – long term experiments  
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Predicting the Worst Pit Depth for 1 year of service life using short term experiments (Experimental Data for 1 
week and 1 month) 
 
Check the boxes for 1 week and 1 month only to include them into the calculations 

 

 
 

We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save this new file as EVS 
calculations. 
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Analyzing the results 
 
Click on the Plot tab ( ). You will see a plot of the predicted mean value of the depth of the deepest pit, 
xm and the plots of values xm – σ and xm + σ, where σ is the standard deviation of xm. 

 
It is important to note that only data for short term experiments (for 1 week and 1 month) are shown as 
black circles in the plot. The additional data are shown as red diamonds, only for demonstrating the 
accuracy of prediction. 

 

Click on the Report tab, and to the Calculation Results table. 
 
The predicted depth of the deepest pit at 365 days is 610.43m ≤ 825.373m ≤ 1040.31m (based on the 
short-term experimental data). 

 

 
Predicting the Worst Pit Depth for 2 years of service life using long term experiments (all data sets) 

 
The accuracy of prediction increases when additional group of experiments are included into consideration. For 
this case we are going to add the experimental data for 3 months, 6 months and 1 year. 

 
Go back to the Definition tab 

 
Include (check) the experimental data for 3 months, 6 months and 1 year 

 
Click on the Specs button. This will open a new window 

 
Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 days, End=730 
days, and number of steps=50. Then click OK 

 
Then Click on the Calculate button or press the <F9> key  
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Analyzing the results 
 
Click on the Plot tab ( ). 

 

Click on the Report tab, and to the Calculation Results table. 

The predicted depth of the deepest pit at 730 days (1 year) is 617.57 m ≤ 780.873 m ≤ 944.18 m. 

 

Calculating Fail Probabilities 

When doing engineering design, information regarding the probability of failure is of importance to consider. 
The next set of calculations will involve calculating the Probability of Failure for a given: 

Penetration depth  

Observation time (life) 

Area of the system 
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Fail Probability: Depth 

Let’s start with the calculation of Probability of Failure for a given penetration depth and the area of the system 
as a function of observation time. 

We are going to answer the following question: 

Which thickness, d, does an aluminum pipe with the area of S= 1 m2 have to have in order to ensure acceptable 
performance (probability of failure  Pf< 5% at design service life, ts =5 years? 

 
Starting the Simulation 
 
Use the data enter in the example above. Change the Calculation Type to Fail Probability: Depth 

 
Under the Calculation Parameters grid, enter 1 m2 for the Surface Area and 5 years for the Service Life. 
Change units by clicking on the blue hyperlinks. 
 
Make sure all data sets are selected (checked) 

Your screen should look like the image below. 
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We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. 

 

Analyzing the results 
 
Click on the Plot tab ( ). You will see a plot of predicted probability of failure 

 

Click on the Report tab, and to the Calculation Results table. 
 

We can conclude that the acceptable pipe wall width is reached at d > 1950 μm. 

 

Fail Probability: Life 

Let’s continue with the calculation of Probability of failure for a given service time (life) and the area of the 
system as a function of penetration depth. 

We are going to answer the following question: 

What service life, t, will have the aluminum pipe with the width, d=1850 μm with area S=10 m2 in order to ensure 
acceptable performance i.e. probability of failure, Pf< 5 %?  
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Starting the Simulation 
 

Change the Calculation Type to Fail Probability: Life 
Under the Calculation Parameters grid, enter 10 m2 for the Surface Area and 1850 m for the Critical Pit 
Depth. Change units by clicking on the blue hyperlinks (If needed). 

 
For this calculation we need to specify the period of time at which we want to bound the calculation. 
  
Click on the Specs button. This will open a new window. 
Change the Service Life range as follows: Start=0 years, End=3 years and Increments=0.2 years. Then click 
OK. 

 

Your screen should look like the image below. 
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We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. 

 

Analyzing the results 

Click on the Plot tab ( ). You will see a plot of predicted probability of failure. We need to modify the plot 
to see the results in more detail. 

 

Double click on the Y axis. This will open a new window. 

Check the boxes Minimum and Maximum. Then click OK. 
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The plot should look like the image below 

 

The maximum probability of failure seems to be at around 10%. 

Click on the Report tab, and to the Calculation Results table. 
 

We can conclude that the lifetime of this pipe before failing is <0.6 years. 

 

Fail Probability: Area 

Finally, let’s do the the calculation of Probability of failure for a given penetration depth and service time as a 
function of the area of the system. 

We are going to answer the following question: 

What area, S, can have the aluminum pipe with the width, d=2000 μm and service life t=5 years in order to 
ensure acceptable performance i.e. probability of failure, Pf < 5 %? 
 

Starting the Simulation 

Change the Calculation Type to Fail Probability: Area 

Under the Calculation Parameters grid, enter 2000 m for Critical Pit Depth and 5 years for the Service Life. 
Change units by clicking on the blue hyperlinks (If needed). 
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For this calculation we need to specify the surface area range that we want to survey. 

Click on the Specs button. This will open a new window. 

Change the Surface Area range as follows: Start=0 sq-m, End=100 sq-m and Number of steps=50. Then click 
OK. 

 

Your screen should look like the image below. 
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We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. 

 

Analyzing the results 

Click on the Plot tab ( ). You will see a plot of predicted probability of failure. We need to modify the plot 
to see the results in more detail. 

 

The maximum probability of failure seems to be at around 30%. 

Click on the Report tab, and to the Calculation Results table. 

We can conclude that acceptable performance is reached at <14 m2. 
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Example 58: Failure Analysis due to Corrosion in Pipelines  

In this example, we will show how in some cases reliable prediction of corrosion damage can be done by using 
a very limited number of experimental points.  

In the table below, you can see the results of direct measurements of the depth of the deepest pits in the pipeline 
between Samara and Moscow [Zikerman, 1972].   

 

Pit depths (mm) for pipeline between Samara and Moscow 

 Group 1 Group 2 Group 3 Group 4 Group 5 Group 6 Group 7 Group 8 
Sample 1440 h 5040 h 5760 h 8959 h 12624 h 17688 h 28032 h 28272 h 

1 0.1   1.4 1.7 1.9  2.1 
2  0.49  1.95 2.1 2.08  2.25 
3 0.3 1.6  1.8     
4 0.4   1.6 1.65 1.88   
5 0.9  1.57 2.1 2.21 2.4 2.4  
6 0.3  1.2 1.4 1.4 1.55 1.71  

 

Calculation the Depth of the Deepest Pit 

 

Starting the Simulation 

 
Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane 

 

 
 

Click on the new EVS calculation and press <F2> to change the name to EVS-Pipeline samples.  Notice that 
the default calculation is the Pit Depth Prediction. 

 
Under the Calculation Parameters grid, enter 1 cm2 for the Surface Area and Default Value cells. 

 

Note: Because the area of the pipelines metal was not changed with time the information about this area 
is not needed for extrapolation of corrosion damage in time.  
 

Since the data is in hours, click on the blue hyperlink day and change it to hours (hr) (for both: The Experiment 
Start and the Sample Group.  



 

think simulation | getting the chemistry right 362 

 

Your screen should look like the image below: 

 

There are experimental data sets for 8 different periods of time. This means that we need to enter 8 different 
sample groups. 

By default, Sample group 01 is created. Click on the …  button to edit this field. This will open a new window. 
 

Leave the default name as Sample Group 01, enter the number 1440 for the number of elapsed hours, and 
check the box ‘Include for Calculation’ 
 

 
 

Enter the Pit Depth data (second column) obtained for 1440 hours.  

 

Now we need to add 7 more groups. 

Click on the Add Group button (located at the bottom of the window. This will open a new window. 
 

Leave the default name as Sample Group 02, enter the number 5040 for the number of elapsed hours, and 
check the box ‘Include for Calculation’. Then click OK. 
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Enter the Pit Depth data (second column) obtained for 5040 hours. 
Click on the Add Group button, and repeat the same procedure for 5760, 8959, 12624, 17688, 28032 and 
28272 hours.  

Once you have entered all the experimental data, your screen should look like the image below. 

 
Make sure that all the groups are selected (checked) to be considered for the calculation. 

At this point, the experimental data has been entered. Now we need define the period of time for which we want 
to do the prediction of failure due to pitting. 

Click on the Specs button. This will open a new window. 
 

Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 hours, End=30000 
hours, and Increment=2000 hours. Then click OK 
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Before running the calculation, we are going to study two different cases: 
The first case will include the experimental data from groups 01 to 05 
The second case will include all the experimental data from groups 01 to 08 
 
Calculation including Groups 01 to 05 

 
Check the boxes for Group 01 to 05 
We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save it under the same file 
that we previously created as EVS calculations. 
 
Analyzing the results 
 
Click on the Plot tab ( ). You will see a plot of the predicted mean value of the depth of the deepest pit, 
xm and the plots of values xm – σ and xm + σ, where σ is the standard deviation of xm. 

 



 

think simulation | getting the chemistry right 365 

 

As previously noted, only the points in black mean that were used for predicting propagation of corrosion 
damage. The red diamonds mean that were not taken into account for the calculation and are shown only for 
demonstrating the accuracy of prediction. 

Calculation including Groups 01 to 08 
 

Check the boxes for Group 01 to 08 
We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save it under the same file 
that we previously created as EVS calculations. 
 
Analyzing the results 
 
Click on the Plot tab ( ).  

 

The plot above show how the predicted results improved with increasing number of subsequent inspections.  

Note: The predictions can be substantially improved if they were obtained on the same part of the pipe where 
conditions are approximately the same. 

Click on the Report tab, and to the Calculation Results table. 

You can see here that at 30,000 hours the maximum pit depth predicted is 1.55 m ≤2.54 m ≤3.53 m. 
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Example 59: Predicting the Pit Depth with Insufficient Data  

In some cases, the data that provided by the user may be insufficient for reliable prediction of corrosion damage. 
The table below, shows experimental data (obtained from Laycock et al. 1990) for depths of the deepest pits 
that were measured on 316L coupons (2 x 2 x 1/2 in) in a 10% ferric chloride solution at 50 0C. 

Pit Depth Data for an area of s= 25.8 cm2, depth in m 

 

Calculation the Depth of the Deepest Pit 

Starting the Simulation 

Add a new EVS calculation. Select the Add EVS Calculation icon in the Actions Pane 

 

Click on the new EVS calculation and press <F2> to change the name to EVS-Insufficient Data.  Notice that 
the default calculation is the Pit Depth Prediction. 

Under the Calculation Parameters grid, enter 25.8 cm2 for the Surface Area and Default Value cells. 

Since the data is in hours, click on the blue hyperlink day and change it to hours (hr) (for both: The Experiment 
Start and the Sample Group. 

Your screen should look like the image below: 

 

Sample Grp 1 Grp 2 Grp3 Grp 4 Grp 5 Grp 6 Grp 7 Grp 8 Grp 9 

 40.5 h 144.17 h 215.33 h 292.5 h 331.0 h 378.5 h 453.25 h 477.0 h 528.0 h 

1 775 1326 1036 912 1361 1613 2101 1722 1714 

2  1176 1199 1173 1534 1641 2024 1798 1767 

3        1496 1775 
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There are experimental data sets for 9 different periods of time. This means that we need to enter 9 different 
sample groups. 

By default, Sample group 01 is created. Click on the …  button to edit this field. This will open a new window. 
Leave the default name as Sample Group 01, enter the number 40.5 for the number of elapsed hours, and 
check the box ‘Include for Calculation’ 
 

 
 

Enter the Pit Depth data (second column) obtained for 40.5 hours.  
 
Now we need to add 8 more groups. 
 
Click on the Add Group button (located at the bottom of the window. This will open a new window. 
Leave the default name as Sample Group 02, enter the number 144.17 for the number of elapsed hours, and 
check the box ‘Include for Calculation’. Then click OK. 
Enter the Pit Depth data (second column) obtained for 144.17 hours. 
Click on the Add Group button, and repeat the same procedure for the rest of the experimental data (groups) 
 
Once you have entered all the experimental data, your screen should look like the image below. 
 

 
At this point, the experimental data has been entered. Now we need define the period of time for which we want 
to do the prediction of failure due to pitting. 
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Click on the Specs button. This will open a new window. 

Under the Survey Range tab, enter the range for Pit Depth Prediction as follows: Start=0 hours, End=580 
hours, and number of steps=50 hours. Then click OK 

.  

Before running the calculation, we are going to study two different cases: 

The first case will include the experimental data from groups 01 to 03 
The second case will include all the experimental data from groups 01 to 09 

 

Calculation including Groups 01 to 03 

Check the boxes for Group 01 to 03 

We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save it under the same file 
that we previously created as EVS calculations. 
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Analyzing the results 

Click on the Plot tab ( ).  

 

We see that in this case the prediction cannot be considered satisfactory. The reason is that for the first, second, 
and third observation times the observed mean value of deepest pit decreases. Obviously, such behavior of 
maximum pit depth has no physical foundation. Generally speaking, such situation is the result of an insufficient 
numbers of experiments (used coupons) for given observation times. Accordingly, we can expect that after 
increasing the number of used coupons the situation can improve.  

Calculation including Groups 01 to 09 
 

Check the boxes for Group 01 to 09 
We are now ready to perform the calculation. Click on the Calculate button or press the <F9> key 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Save it under the same file 
that we previously created as EVS calculations.  



 

think simulation | getting the chemistry right 370 

 

Analyzing the results 
 
Click on the Plot tab ( ).  

 

The plot above show how the predicted results improved with increasing number of subsequent inspections.  

The plot above also shows that the results of approximation of the full set of available experimental data from 
Laycock et al. 1990) can be reasonably approximated by using EVS approach.  

Additionally, these results show that insufficient number of coupons (measurements at given observation times) 
can be compensated by increasing numbers of observation at different times. 

Click on the Report tab, and to the Calculation Results table. 

You can see here that at 580 hours the maximum pit depth predicted is 1309.93 m ≤ 1724.09 m ≤1724.09 
m. 
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Chapter V – OLI Studio: ScaleChem 

think simulation | getting the chemistry right is a module within the OLI Studio. A separate license enables this 
module. 

Why Use OLI Studio: ScaleChem? 

Scale problems arise when fluid, initially in equilibrium with its environment, is disturbed and becomes unstable. 
The unstable fluid results in H2O, CO2, and H2S partitioning across the water, oil, and gas phases, corrosion of 
metal surfaces, and precipitation/dissolution of solids. think simulation | getting the chemistry right recognizes 
all three effects, which are all important to the oil and gas production professional. 

Precipitates form when mineral-forming elements increase the concentration of produced waters beyond 
supersaturation, or the saturation point. The primary causes of supersaturation are pressure, temperature, 
phase partitioning, and fluid mixing. think simulation | getting the chemistry right quantifies the effects on mineral 
scale potential while calculating the physical and chemical properties of fluid and gas phases. Industry 
professionals can use the software’s calculations to help determine the best methods to deal with scaling 
situations. 

think simulation | getting the chemistry right can be used to calculate scaling at one or more user specified 
temperatures and pressures.  Other calculation options include the ability to mix waters at user specified ratios 
to find compatible waters, and the ability to saturate a water with respect to one or more solids to simulate 
reservoir conditions. 

There are different types of inputs and calculation objects that can be used in think simulation | getting the 
chemistry right. A brief definition of each type of calculation is given below. 

Input Objects 

There are three different types of input objects, also referred to as analysis types, in the think simulation | getting 
the chemistry right software: Brine Analysis, Oil Analysis and Gas Analysis.  

 

think simulation | getting the chemistry right refers to all waters and aqueous samples as 
brines. This option is added by double clicking on the Add Brine Analysis. A brine can be a 
surface water, an injection water, a formation water, a production water or any other type of 
aqueous fluid you can create. Brine compositions are entered in terms of ionic concentrations. 
In addition, the brine pH, total inorganic carbon and alkalinity can also be specified. 

 

Add Oil Analysis allows you to enter an oil (non-aqueous phase). The oil sample may consist 
of pure component hydrocarbons (e.g., alkanes), distillation data, pseudocomponents or all 
three. 
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Add Gas Analysis allows you to enter any hydrocarbon mixture which may or may not contain 
water, carbon dioxide or hydrogen sulfide. The default hydrocarbon is methane (CH4) but the 
hydrocarbon list may be expanded to include higher carbon numbers. 
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Calculation Objects 

There are five different types of calculations that can be carried out in think simulation | getting the chemistry 
right: Saturator, Facilities, Scale Scenario, Scale Contour, and Mixing Water. A brief definition of each type of 
calculation is given below. 

 

Add Saturator object combines fluids at the specified temperature and pressure and 
saturates the combined phases with the selected minerals. 

 

Add Facilities mixes and separates fluids. It is used to simulate production operations.  

 

Add Scale Scenario object calculates the scaling of minerals from a fluid as temperature 
and pressure changes, e.g. at different production locations.. 

 

Add Scale Contour object calculates the scaling of minerals from a fluid over a matrix of 
temperature and pressure. It creates a 2D contour plot visual. 

 

Add Mixing Water object mixes two potentially incompatible brines together to identify at 
what ratios the scale will form.  

In this chapter we will model a hypothetical field and learn how to use and set up each one of the objects 
presented above. 
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Section 11. Entering a Brine Analysis in think simulation | getting the 
chemistry right 

Entering Data for a Brine Analysis 

To add a Brine Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add Brine, or by 
selecting the Add Brine Analysis icon in the Actions Pane. 

 

 

You will see three different tabs for this analysis. The Description, Design and Report tab.  

The Brine Analysis open in the Design, which has 2 different sub-tabs: Data Entry and Reconcile, where we 
need to enter the laboratory analysis information. 
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We will start in the Data Entry (red) sub-tab. Here you enter the concentration of Cations, Anions, and Neutrals. 
This sub-tab comes already prepopulated with some of the most common cations, anions, and neutrals species 
found in laboratory water/brine analyses (by default the units are in mg/L). If your species is not present in the 
prepopulated grid, simply click on the white grid and type the ion or neutral of interest. If it is a cation, type the 
element followed by a plus (+) sign and the corresponding oxidation state, e.g., Cu+2. If it is an anion, type the 
element followed by a minus (-) sign and the corresponding oxidation state, e.g., Br-1. If it is a neutral, simply 
type the species either using the formula name or its chemical name, as has been shown in the previous 
sections.  

The Brine Analysis grid also contains search aids to find a specific cation, anion, or neutral species. The first 
search aid is the drop list located in each the cation, anion, and neutral grid sections. The list is alphabetic and 
is activated using the drop-down arrow within the cell, after the first few letters of the ion is typed. 
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If a name is misspelled or if the text is unrecognized, then a red ‘X’ appears to the left of the name. This name 
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry 
(which will turn black) and hit the key <Delete>.  

 

The Reconcile sub-tab is used to define the measured properties of the brine. In this Reconcile sub-tab, we 
will tell the software how to reconcile the brine.  
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The first step, however, is to enter the brine measured properties and conditions. To do this we need to start in 
the Properties | Measured | Calculated table. 
 

 

By default, the values of temperature, and pressure are 25oC and 1 atm. The aqua-blue cells indicate the 
values that you need to enter if they were measured at the temperature and pressure specified, these are: 
Measured pH, Measured Alkalinity10, Density, Specific Electrical Conductivity and Total Dissolved Solids (TDS). 
 
You can always change the units of these properties by clicking on the units highlighted in blue. This action will 
open the Units Manager Window.  

If you don’t have a measured property value, for example, the Specific Electrical Conductivity, just leave it blank.  

 

10 This is generally a reliable value, unless solids have precipitated in the sample.  Alkalinity is often but not always the same value as the 
bicarbonate ion (HCO3

-). ScaleChem Analyzer can reconcile on a measured alkalinity by adjusting the solution composition. 
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The yellow cells, under the Calculated column, will contain calculated values by the software and will be shown 
once the simulation is run.  

When reviewing laboratory analysis of brine samples, it is quite common for the positive ions (cations) and the 
negatively charged ions (anions) in solution to not balance. This may be due to the precision limits of the various 
experimental procedures used to measure the ions - i.e. some ions may not have been analyzed. These 
solutions must have a neutral charge. think simulation | getting the chemistry right will adjust/modify inflows in 
order to balance the charges and make the solution neutral. This adjusting procedure is referred to as 
Reconciliation.   

There are 5 different types of Reconciliation Options:  

Concentration Data Only 
Gas-phase CO2 content (mole%) 
Measured pH and Alkalinity 
Measured pH Only  
Measured pH, Alkalinity, TIC 

Additionally, there is the option to calculate the alkalinity value by checking the Calculate Alkalinity box. 

 

 

When the Reconciliation Option is selected, the software will calculate the properties of the brine 

A more detailed description of each reconciliation option is given in Section 11.3. Reconciliation Options in the 
Brine Analysis below. 

Brine Analyses - Reporting Elements 

Brine analysis data obtained from ICP measurements will contain concentrations for B, P, S, and Si. These 
elements do not exist in the water, rather they exist as dissolved ions. If they are part of your analysis, then you 
should convert them to the following before entering them into the Brine Analyses object. 

Converting element concentration to species for Brine Analysis 

 
 

Aqueous Species Formula to enter Formula weight multiplier 

B, boron Boric Acid H3BO3 B (mg/l)  5.72 = H3BO3 (mg/l) 

Si, Silicon Silica SiO2 Si (mg/l)  2.14 = SiO2 (mg/l) 

P, Phosphorus Dihydrogen Phosphate H2PO4-1 P (mg/l)  3.13 = H2PO4 (mg/l) 

S, Sulfur Sulfate or Sulfide 
HS-1 or SO4-2 

(cannot tell from total S only) 

S (mg/l)  1.03 for HS-1 (mg/l) 

or 

S (mg/l)  3.0 for SO4-2 (mg/l) 
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Reconciliation Options in the Brine Analysis - Definitions 

When reconciling a Brine Analysis, there are five options for reconciliation: 

Concentration Data Only: The software will run an electroneutrality reconciliation only, and then compute the 
water properties such as pH, density, etc., based on the entered concentration of neutral, cations, and anions 
species. In the Concentration Data Only option you may allow the program to pick the species to adjust for 
electroneutrality or you may manually choose the species to perform the adjustment. (See electroneutrality 
options). 

Gas-phase CO2 content (mole%): Frequently it is simpler and more stable to measure the gas-phase CO2 
that is separated from the brine at the sampling point.  When matched with another measured variable, usually 
alkalinity, the concentration of the carbonate species and the pH can be calculated. think simulation | getting 
the chemistry right performs a CO2 gas fraction calculation by taking the PCO2 and the calculated alkalinity 
(based on the water analysis data) to reconcile the system for pH and carbonate properties. The CO2 is adjusted 
to match a saturated gas composition. 

Measured pH Only: Many brines analyses report a measured pH. This pH may or may not match the pH 
calculated by the software. The cause may be an incomplete and/or inaccurate brine description. The software 
will run both an electroneutrality and pH reconciliation. This type of reconciliation will match your recorded pH. 
Additionally, the software will compute the water properties such as, density, electrical conductivity, etc. The 
pH of the solution is automatically adjusted by the software by adding either HCl or NaOH, or you may select 
your preferred acids and bases to adjust the pH. 

Measured pH and Alkalinity: The purpose of the Measured pH and Alkalinity reconciliations is to match the 
computed pH and alkalinity values with those you measured. The software will run an electroneutrality, pH and 
alkalinity reconciliation. Additionally, the software will compute the water properties such as density, electrical 
conductivity, etc. The pH of the solution is automatically adjusted by the software by adding either HCl or NaOH 
or you may select your preferred acids and bases to adjust the pH. The Alkalinity is automatically calculated by 
the software, using CO2 as the alkalinity titrant, H2SO4 as the alkalinity pH titrant and 4.5 as the alkalinity end 
point pH. You can also change to a different alkalinity titrant if you prefer.    

  
Measured pH, Alkalinity, TIC: The purpose of this reconciliation is to match the measured pH, total alkalinity, 
and the total inorganic carbon (TIC). The Total Inorganic Carbon (TIC) is adjusted using CO2 as the alkalinity 
titrant, H2SO4 as the alkalinity pH titrant and 4.5 as the alkalinity end point pH. The software adjusts the acetate 
concentration (organic acids) to match the total Alkalinity value by adding or removing acetic acid. You cannot 
however change the CO2 or acetic acid for the alkalinity adjustment.  These are fixed by the software. The 
target pH is obtained simultaneously by HCl or NaOH.  You may select your preferred acids and bases to adjust 
the pH instead of the default HCl and NaOH.   

Additionally, there is the option to Calculate Alkalinity: . It is important to note, that this is only 
an alkalinity calculation based on the concentration entered, it is not an alkalinity reconciliation.   
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A Basic Brine Analysis  

A brief introduction to the brine analysis tool will be shown in the example below. As we go through the example, 
the basic definitions, functionalities and reporting for the Brine Analysis object will be shown.  

Example 60: Basic Brine Analysis 

In this example, we will input dissolved species concentrations and other measured properties into a Brine 
Analysis object to model a hypothetical water sample. We will calculate the pH and scaling tendency of a 
brine sample based upon its measured composition at 1 atm and 25 ⁰C.  

Starting the Simulation 

Use the inputs and parameters from the table below to create the brine analysis. Certain inputs, such as the 
name style, units, etc. will require further adjustments, and will be described as necessary.  

Brine Analysis Composition 
Cations (mg/L) Anions (mg/L) Neutrals (mg/L) Measured Properties 
Na+1 20400 Cl-1 37000 CO2 150 pH 7.1 
K+1 400 SO4-2 2200 H2S 15 Alkalinity as HCO3-, mg/L 715 

Ca+2 3800 HCO3-1 0     
Mg+2 830 HS-1 0     
Sr+2 15 C2H3O2-1 715     
Ba+2 0.7       
Fe+2 10       

 

Setting the Water Analysis 

Add a Brine Analysis. Go to the toolbar menu and click on Streams > ScaleChem > Add Brine, or by selecting 
the Add Brine Analysis icon in the Actions Pane 

 

 
 

Click on the new Brine and press <F2> to change the name to Brine Analysis 
Select the AQ thermodynamic Framework (remember that MSE is the default so please switch it) 
Click on the Names Manager Icon and select the Formula option (default) 
Click on the Units Manager Icon, and select Metric, Concentration (default) 
Under the Design Tab, enter the Cation, Anion, and Neutrals composition given in the table above. 
Your screen should look like the image below: 
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Note: It is highly unusual for the data to be electrically neutral. Therefore, the software reconciles the sample 
for electroneutrality. After entering each species concentrations, you will notice that the software shows a 
yellow column named Balanced. The software balances charges according to the selected option and displays 
this in the yellow column.  

There are 4 different Balance Options: 

1) Dominant Ion: This is the default method. The largest concentration ion is used to adjust the 
electroneutrality. In our example,1938.077 mg/L of Cl-1 are added since there is an excess of positive 
charge (see the above image). 

2) Prorate Cations: All cations are adjusted up or down equally 
3) Prorate Anions: All anions are adjusted up or down equally  
4) Make-up Ion: This option allows for a single ion species to be adjusted. User selects an ion to 

increase or decrease.  
 

Select Dominant Ion as balance option 
Click on the Reconcile (vertical blue tab) 
Notice that the five different types of reconciliations are available in in the upper left corner of the window (see 

image below). Also, you can see the Calculate Alkalinity box ( ) option, which allows you to 
compute the alkalinity, based on the concentration entered.  
 
Select the Concentration Data Only option. This option means that the software will compute the water 
properties based on the current concentration of neutral, cation, and anion species. The calculation will not use 
the measured pH, or the measured alkalinity entered (if any).  

 
Enter the measured properties: pH = 7.1 and Alkalinity = 715 as mg HCO3/L 
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Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

It is time to save your file (File >Save as…) or using the save icon in the tool bar. Create a new file and name 
it: ScaleChem Analysis Calculations. 
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Analyzing the Results 

Once the calculation is done, the Calculated column displays the results obtained based on the concentrations 
entered in the Data Entry tab. Notice that the calculated results are pH=5.31 and Alkalinity=263.0 mg HCO3-
1/L vs the measured values of pH=7.1 and Alkalinity=715 mg HCO3-1/L. 

 

To the right you can see the results summarized in the Summary Box. 

The top section contains the Stream Parameters information. In this example, the software performed the 
calculation at 25 ⁰C, 1 atm, and a total Stream amount of 1 L.  

The Dominant Ion Charge Balance section shows the type of balance that was used to reach electroneutrality, 
which cation/anion was deficient, and how much of it was added.  

The Phase amounts section shows the distribution of species in the different phases. This analysis contains 
two phases: aqueous and vapor.  

The Aqueous Phase Properties information shows the computed pH, ionic strength, and density of the 
solution. It is important to note here that the measured pH is 7.1 and the computed pH is 5.31. The density of 
this solution is 1.04487 g/ml. Remember, for this example the software used only the concentration of neutrals, 
cations, and anions in solution to do a reconciliation. 
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Click on the Report tab and scroll down to the Pre and Post Scaling Tendencies table. 

 

From this table, you can see that Barite and Pyrrhotite solids have been predicted to be supersaturated.  

For more detailed information about scaling tendencies, you can go to Scaling section on page 179. 

Scroll down to the Brine Composition table 

 

This table shows the composition of the brine after the reconciliation (calculation) has taken place. 
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Section 12. Entering a Gas Analysis in think simulation | getting the 
chemistry right 

Entering Data for a Gas Analysis 

To add a Gas Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add Gas, or by selecting 
the Add Gas Analysis icon in the Actions Pane. 

 

 

You will see four different tabs for this analysis. The Description, Design, Definition and Report tab.  

The gas analysis opens in the Design tab, which has 2 different sub-tabs: Inflows and Reconcile, where we 
need to enter the laboratory gas analysis information. 

 

We will start in the Inflows (red) sub-tab. Here you enter the concentration of a pure-component hydrocarbon 
gas, in mole % units. The standard list of component extents to C6 alkanes. 
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If there is a component that is not present in the prepopulated grid, simply click on the white grid and type the 
species of interest, using the formula name or its chemical name, as has been shown in the previous sections. 
Let’s say for example, you want to add Isooctane. Type isooctane or i-C8H18 in the white cell to add it to the 
list. 

There is also the option of using the drop-down arrow, that allows you to search for the specific components 
you want to add. 

 

If a name is misspelled or if the text is unrecognized, then a red ‘X’ appears to the left of the name. This name 
needs to be corrected or the row deleted before proceeding. To delete the row, simply select the wrong entry 
(which will turn black) and hit the key <Delete>.  
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The Reconcile sub-tab is used to calculate the properties of the gas at the temperature and pressure conditions 
specified. By default, the values of temperature, and pressure are 60 ⁰F (15.56oC) and 14.7 psia (1.002 atm). 

 

 

A Basic Gas Analysis 

A brief introduction to the gas analysis tool will be shown in the example below. As we go through the example, 
the basic definitions, functionalities, and reporting for the Gas Analysis object will be shown.  

Example 61: Basic Gas Analysis 

The Gas Analysis object provides a quick way to enter a pure-component hydrocarbon gas. 

Setting the Gas Analysis 

Add a Gas Analysis. Go to the toolbar menu and click on Streams > ScaleChem > Add Gas, or by selecting 
the Add Gas Analysis icon in the Actions Pane 

 

 

Click on the new Gas Analysis and press <F2> to change the name to Gas Analysis 

Select the AQ thermodynamic Framework (Remember that MSE is the default so you need to change it) 

Click on the Names Manager Icon and select the Formula option (default) 

Click on the Units Manager Icon, and select Metric, Mole Frac. (default) 

Under the Inflows Tab, enter the gas composition given in the table below 
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Gas Analysis Composition 
Formula Component Name Mole % 

H2O Water 1.80 

N2 Nitrogen 3.00 

CO2 Carbon Dioxide 1.50 

H2S Hydrogen Sulfide 0.50 

CH4 Methane 65.5 

C2H6 Ethane 14.0 

C3H8 Propane 8.00 

i-C4H10 Isobutane  1.00 

n-C4H10 n-Butane 3.00 

i-C5H12 Isopentane 0.50 

C5H12 n-Pentane 0.70 

C6H14 n-Hexane 0.50 

Your screen should look like the image below: 

 

Note: There are several options to the right of the data entered. 
 
Entry options: Here you can select the preferred units, and display name. You also have the option to show 
the non-zero values only – sometimes the composition of species is zero – and also show the normalized 
(yellow) column – this option is useful when the values don’t add up to 100 mole%.  
 
Template manager: Here you can select the standard (default) template or the extended template – which 
includes hydrocarbons with longer chains. You can also create and save your own template for future use. 
 
Normalize options: When your analysis does not add up 100 mole% you can select between two options: 
Make-up and Prorate. For the Make-up option, the default gas used is CH4. 
 

Click on Reconcile (vertical blue tab). The reconciliation calculation will be calculated at 15.556 C and 1.00231 
atm (standard conditions). 



 

think simulation | getting the chemistry right 389 

 

  
 
Now, we are ready to perform the calculation. Click on the Calculate button or press the <F9> key 

 
It is time to save your file (File >Save as…) or using the save icon in the tool bar. Create a new file and name 
it: ScaleChem Analysis Calculations. 
 

 
Analyzing the Results 
 
Once the calculation is done, the Reconciled Gas column displays the results at equilibrium conditions. 
 

 
 
To the right you can see the results summarized in the Summary Box. 
 
The top section contains the Stream Parameters information. In this example, the software performed an 
equilibrium calculation at 15.556⁰C and 1.00231 atm. 
 
The Phase amounts section shows the distribution of species in the different phases. This analysis contains 
two phases: aqueous and vapor.  
 
The Aqueous Phase Properties information shows the computed pH, ionic strength, and density of the 
solution.  
 
Click on the Report tab. Here you will see a more complete representation of the results at equilibrium. 
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Section 13. Entering an Oil Analysis in think simulation | getting the 
chemistry right 

Entering Data for an Oil Analysis 

To add an Oil Analysis, go to the toolbar menu and click on Streams > ScaleChem > Add Oil, or by selecting 
the Add Oil Analysis icon in the Actions Pane. 

 

 

You will see three different tabs for this analysis. The Description, Design, and Report tab.  

The oil analysis opens in the Design tab, which has 4 different sub-tabs: Combined, Pseudocomponents, 
Assay and Reconcile.  

In the Combined (red) sub-tab, pure components (organic and inorganic) are entered. If there is a component 
that is not present in the prepopulated grid, simply click on the white grid and type the species of interest, using 
the formula name or its chemical name, as has been shown in the previous sections. Let’s say for example, 
you want to add Isooctane. Type isooctane or i-C8H18 in the white cell to add it to the list. 

Also, you can use the show non-zero only option to hide all the zero values – since they are not needed. 
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In the Pseudocomponents (blue) sub-tab, you can enter pseudocomponents. Here you need to provide the 
molecular weight, NBP, SG, Thermodynamic Method, and the mole% information. 

 

In the Assay (red) sub-tab, distillation curves can be entered. The Assay screen contains three data entry grids: 
Component, Entry Options and Distillation Data. 

 

Component Grid: In the component grid you can name your assay. No more than 5 letters are allowed for the 
name. The mole% instructs the software that the mole% entered represents the total hydrocarbon mass. 
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Entry Options Grid: In this grid there are four pieces of information that the user needs to fill out: The Assay 
Type, the Thermo Method, Density and No. of Cuts. 
 
There are four Assay types. These are experimental methods used to create distillation curves. 
 

 

ASTM D86 runs at atmospheric pressures and is used for all oil types 
ASTM D1160 runs at vacuum pressure and is used for heavy oils 
ASTM D2887 runs on a gas chromatograph and is used for light oils 
TBP is the true boiling point curve 
There are also four methods for calculating thermodynamic properties, referred to as Thermo Method in the 
software, and these are: API-8, API-5, Cavett and Lee-Kessler. 

 

The API-8 and API-5 are methods that use specific gravity to determine critical parameters.  
Cavett is a method to determine critical parameters using the API gravity 
Lee-Kessler is a method to determine critical parameters by using the Watson K 

There are three, average bulk density options: Specific Gravity, API gravity and Watson K. 

 

Specific Gravity (SG) is the ratio of the material density to water. think simulation | getting the chemistry right 
requires specific gravity to be between 0.228 and 1.6. 
API Gravity is defined as API Gravity = (141.5/SG) – 131.5 
Watson K is a method that relates density to boiling point 

A more detailed description of the different assay types, thermodynamic methods and density calculation 
methods is found in the Basic Definitions for the Oil Analysis Tool section on pages 393-396. 

Distillation Data Grid: In this section the distillation data is entered.  
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The Reconcile tab is where the equilibrium calculations are performed and is used to calculate the properties 
of the gas at the temperature and pressure conditions specified. By default, the values of temperature, and 
pressure are 60 ⁰F (15.556oC) and 14.7 psia (1.002 atm). 

 

 
Basic Definitions for the Oil Analysis Tool 
 
Hydrocarbon Petroleum Fractions 
 
Frequently a hydrocarbon analysis is the only data available for entry into the software. This analysis is usually 
a distillation curve where the volume distilled as a function of temperature of a petroleum fraction has been 
analyzed. This information must be turned into a vapor, organic and aqueous component for use in the 
simulator. 

ASTM D86  

Used for light and medium petroleum products and is carried out at atmospheric pressure. The results are 
converted internally in the OLI model generator to a TBP (True Boiling Point Curve). This curve is then fit to a 
spline to smooth the curve. The cuts are taken from the spline. 
 
ASTM D1160  

Used for heavier petroleum products and is often carried out under vacuum. Sometimes as low as 1 mm Hg.  
The results are converted internally in the OLI model generator to a TBP (True Boiling Point Curve). This curve 
is then fit to a spline to smooth the curve. The cuts are taken from the spline. 
 
ASTM D2887  

Uses gas chromatography to produce the distillation curve and is applicable to a wide range of petroleum 
products. The results are always reported on a volume percent basis. The results are converted internally in 
the OLI model generator to a TBP (True Boiling Point Curve). This curve is then fit to a spline to smooth the 
curve. The cuts are taken from the spline 
 
True Boiling Point (TBP) 

These curves, in practice, are difficult to obtain. The other methods are usually used instead. 
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Thermodynamic Methods (pseudo-components and petroleum fractions) 
The methods used within OLI to calculate the critical temperature and pressure are the API, Cavett and Lee-
Kesler methods. 

API Method 

Uses the specific gravity to estimate the critical parameters. The specific gravity, if not entered, can be estimated 
from the API gravity or the Watson K. The boiling points are taken from the assay data. API version 5 (API-5) 
and API version 8 (API-8) are currently supported. 
 
The API method is selected by the user. Tc, Pc, and Vc are calculated as follows: 
 

𝑇௖ ൌ 24.2787 ൈ 𝑇௕
଴.ହ଼଼ସ଼ ൈ 𝑆𝐺଴.ଷହଽ଺ 

 

ln𝑃௖ ൌ
3.12281𝜌 ൅ 9

𝑇௕
ଶ.ଷଵଶହ𝑆𝐺ଶ.ଷଶ଴ଵ

 𝑖𝑓 𝑇௕ ൏ 1000 ℉ 

 
 
Otherwise 

ln𝑃௖ ൌ 8.3634 െ
0.566
𝑆𝐺

െ ൬0.24244 ൅
2.2898
𝑆𝐺

൰ ൅ ൬
0.11857
𝑆𝐺ଶ

൰ ൈ 0.001 ൈ 𝑇௕

൅ ൬1.4685 ൅
3.648
𝑆𝐺

൅
0.47127
𝑆𝐺ଶ

൰ ൈ ฬ𝜌 െ 7 ൈ 𝑇௕
ଶ െ ൬0.42019 ൅

1.6977
𝑆𝐺ଶ

൰ฬ 𝜌 െ 10 ൈ 𝑇௕
ଷ 

 

𝑉௖ ൌ
𝑍௖ ൈ 𝑇௖ ൈ 10.73

𝑃௖
 

Where,  
Tc = Critical temperature in Rankine 
Pc = Critical pressure in psia 
Zc = Critical compressibility factor  
 

𝑍௖ ൌ
1

3.43 ൅ 6.7𝜌 െ 9 ൈ ∆ଶ
 

And 

∆ൌ
8.75 ൅ 1.978ሺlog𝑇௕ሻ ൈ 𝑇௕

1.8
 𝑖𝑓 𝑇௖ ൏ 536.67 𝑅 

If 536.67<Tc<593 R, the above result for Δ is multiplied by f: 

𝑓 ൌ ൬𝑇௖ െ
536.67
𝑇௖ െ 𝑇௕

൰
଴.ଷ଼

 

 

If Tc>593 R, 
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∆ൌ ቆ
ሺ0.98907 ൈ 𝑆𝐺ሻሺ∆ െ 592.4439ሻ

𝑀𝑊
ቇ
଴.ହ

 

 

Cavett 

This method uses the API gravity method to determine the critical properties. The API gravity, if not entered 
can be estimated from the actual specific gravity or the Watson K. The boiling points for the pseudo-components 
are taken from the assay. 
 
If the Cavett method is chosen by the user, Tc, Pc and Vc are calculated as follows: 
 
 

𝑇௖ ൌ 768.0712 ൅ 1.7133693 ൈ 𝑇௕ െ 0.0010834 ൈ 𝑇௕
ଶ െ 0.008921258 ൈ 𝑇௕ ൈ 𝐴𝑃𝐼 ൅ ሺ3.8890584𝜌 െ 7ሻ

൅ 𝑇௕
ଷ ൈ 5.309492𝜌 െ 6 ൈ 𝑇௕

ଶ ൈ 𝐴𝑃𝐼 ൅ 3.27116𝜌 െ 8 ൈ ሺ𝑇௕ ൈ 𝐴𝑃𝐼ሻଶ 
 
𝑙𝑜𝑔𝑃௖ ൌ 2.829046 ൅ 0.0009412 ൈ 𝑇௕ െ 3.047475𝜌 െ 5 ൈ 𝑇௕

ଶ െ 2.087611𝜌 െ 5 ൈ 𝐴𝑃𝐼 ൈ 𝑇௕ ൅ 1.5184103𝜌 െ 9 ൈ 𝑇௕
ଷ

൅ 1.1047809𝜌 െ 8 ൈ 𝐴𝑃𝐼 ൈ 𝑇௕
ଶ െ 4.82716𝜌 െ 8 ൈ 𝐴𝑃𝐼ଶ ൈ 𝑇௕ ൅ 1.3949619𝜌 െ 10 ൈ ሺ𝐴𝑃𝐼 ൈ 𝑇௕ሻଶ 

𝑉௖ ൌ
𝑍௖ ൈ 𝑇௖ ൈ 10.73

𝑃௖
 

Where,  
Tc = Critical temperature in Rankine 
Pc = Critical pressure in psia 
Zc = Critical compressibility factor  
 

𝑍௖ ൌ
1

3.43 ൅ 6.7𝜌 െ 9 ൈ ∆ଶ
 

 
And 

∆ൌ
8.75 ൅ 1.978ሺlog𝑇௕ሻ ൈ 𝑇௕

1.8
 𝑖𝑓 𝑇௖ ൏ 536.67 𝑅 

 
If 536.67<Tc<593 R, the above result for Δ is multiplied by f: 
 

𝑓 ൌ ൬𝑇௖ െ
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൰
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If Tc>593 R, 

∆ൌ ቆ
ሺ0.98907 ൈ 𝑆𝐺ሻሺ∆ െ 592.4439ሻ

𝑀𝑊
ቇ
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Lee-Kesler 

This method uses the Watson K and the specific gravity (which can be estimated via the Watson K) to determine 
the critical parameters. 
 
If the Lee-Kesler method is selected by the user, Tc, Pc, and Vc are calculated as follows: 
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811
𝑆𝐺

൅ ሺ0.4244 ൅ 0.1174 𝑆𝐺ሻ ൈ 𝑇௕ ൅ ሺ0.4669 െ 3.2623 𝑆𝐺ሻ ൅
100,000

𝑇௕
 

 

ln𝑃௖ ൌ 8.3634 െ
0.566
𝑆𝐺

െ ൬0.24244 ൅
2.2898
𝑆𝐺

൅
0.11857
𝑆𝐺ଶ

൰ ൈ 0.001 ൈ 𝑇௕

൅ ൬1.4685 ൅
3.648
𝑆𝐺

൅
0.47127
𝑆𝐺ଶ

൰ ൈ ฬ𝜌 െ 7 ൈ 𝑇௕
ଶ െ ൬0.42019 ൅

1.6977
𝑆𝐺ଶ

൰ฬ 𝜌 െ 10 ൈ 𝑇௕
ଷ 

 

𝑉௖ ൌ
𝑍௖ ൈ 𝑇௖ ൈ 10.73

𝑃௖
 

Where,  
Tc = Critical temperature in Rankine 
Pc = Critical pressure in psia 
Zc = Critical compressibility factor  
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1
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If 536.67<Tc<593 R, the above result for Δ is multiplied by f: 
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Average Bulk Density 
 
Specific Gravity 

Unitless, relative to pure water (H2O) at 15 oC which has a density of 1.0 g/mL 
 
API Gravity 

Degrees API (oAPI). This is calculated via the following equation: 
 

𝐴𝑃𝐼ሺ60𝐹ሻ ൌ ൬
141.5

𝑠.𝑔. ሺ60𝐹ሻ
൰ െ 131.5 

where, SG is the specific gravity at 60 oF. 
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Watson K 

The Watson K has no units but is calculated via: 

𝐾 ൌ ൭
𝑁𝐵𝑃

ଵ
ଷൗ

𝑆𝐺
൱ 

where NBP is the normal Boiling point. 

 

Putting together a complete calculation in think simulation | getting the 
chemistry right 

Now that we have defined some terms, we are now ready to begin entering the information required to run a 
calculation. In this calculation we will be entering the concentrations of a single brine.  

Task 1 – Create a Brine Analysis  

In this task we will show the main interface of a Brine Analysis, followed by an example of a brine (water 
analysis) and calculate its scaling tendency. Steps for the simulation will be given with bullet points.  

Add Brine Analysis from Actions Panel. 

 
 

Click on the description Tab.  If the Description tab is not currently displayed, click on the tab. 

 

The chemistry of the brine needs to be entered. This information includes concentrations, alkalinity, pH and 
density. The table below describes the hypothetical water that we will create:  

Brine Analysis 

Cations mg/L Anions mg/L Measured Properties 
Na+1 36000 Cl- 57000 Temperature 25 C 
K+1 300 SO4-2 250 Pressure 1 atm 
Ca2+ 600 H3CO3-1 600 pH 7.67 
Mg2+ 150   Alkalinity 600 
Sr+2 80   Density (mg/L) 1.064 
Ba+2 5   Total Dissolved Solids (mg/L) 96280 

 
The screen should look like the image below 
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Select Formula 

 

You can display an easier-to-read table by showing only the species that have actual concentrations. 

Select the Show non-zero only box 
 

 

Another thing to consider is which Balance Option to select.  

It is highly unusual for the data to be electrically neutral.  Therefore, samples are reconciled for Electroneutrality. 
After entering each species concentrations, you will notice that Balanced values show up in the column next to 
values. The Column header says Balanced. 
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When adding or removing ions to balance charge, the solute mass is altered. We must decide as to whether 
we keep the mass of the solution constant (thereby adjusting the amount of water) or keeping the amount of 
water constant and adjusting the solution mass. 

 

 

Select Dominant Ion balance option type. 

You can review the Dominant Ion Charge and Ions needed to balance in the tables presented in the Summary 
Box. 
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The summary box shows additional detail about the brine’s chemistry and balance option. The stream 
parameters table shows default values. The Dominant Ion Charge Balance shows the total cations or anions, 
and the total imbalance.  

Now is time to enter the measured property data in the Reconcile Tab. 

 Select Concentration Data Only Option 
 Check the Calculate Alkalinity box 
 Enter the measured pH (7.67), density (1.064 g/mL) and TDS (96280 mg/L) 
 Leave the Allow solids to form unchecked. 

We will leave the Allow solids to form unchecked because generally the industry uses acid to preserve water 
samples, which prevent solids to form. Acidified samples contain the unprecipitated ion concentration, which is 
what we entered into the brine. In this step, we will eliminate solids because allowing solids to form would 
change the brine’s composition significantly.  

 

Select the Calculate button or press the <F9> key  

 

Once the calculation is done, the calculated column displays results based on the concentration that were 
entered in the Data Entry Tab. The calculated results of note are pH=7.43 and 564.26 mg/L as HCO3 in total 
alkalinity. 
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Experimental inaccuracies in sample measurement may, on occasion, result in a calculation that indicates that 
solid is supersaturated. This can normally be ignored providing that the super saturation is not excessive. 

 

More details of the Brine composition can be found in the Report Tab. 

In the Report tab, scroll down to the Pre and Post Scaling Tendencies, where you will find the results of Scaling 
Tendencies with Solids off. 

 

If we would have allowed solids to form, these concentrations would not be as close to the initial values. 

Note: If scaling tendencies did not show up in the Report Tab, follow these steps: 

Right click on the brine analysis icon 
Select Calculation Options 
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Enable Pre-scaling Tendencies 

 

 

Task 2 – Create a Scaling Scenario 

The next task is to calculate the brine scaling tendencies. Once the Brine Analysis data is entered and 
the sample reconciled, we can begin the Scaling Scenario calculation.   
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1. Select Add Scale Scenario from Actions panel.  

 

Once we add a Scale Scenario object, the software opens to a new Design screen containing three 
vertical tabs: Inlets, Conditions, and Solid. We will work in each of these sections to set up the 
scaling calculation. 

 

Inlet Tab 

Type You can select the brine, gas or hydrocarbon of interest 

 

Name Click in the Name field. As you position the cursor in the field, a Down Arrow will appear. You 
can then select from a list of brines, gases or oils already entered into this think simulation | 
getting the chemistry right document. 

Flow Enter the flow rate for the gas, hydrocarbon or brine. 

 

2. Click on the Description tab and rename the Scale Scenario as “Brine Scale Scenario”. 
3. Then click the Design tab. 

Your screen should now look like image below. 
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4. Select the Inlets tab 
5. Select the right corner of the first cell in the Type column then select Brine (bbl/day). You may need to 

change units by clicking the blue hyperlink. 

 

6. Select Brine from the drop-down menu in the Name column. 

 

7. Enter 1400 (bbl/day) in the Flow Column. Please change units if necessary.  

 

Conditions Tab 

8. Select the Conditions Tab (vertical blue tab on the left-hand side of the Design screen) 
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The Conditions section is where we enter points along the production scheme. The first column is Location. 
We can use the dropdown menu in each row to select a location or type in our own location name. 

9. Type in the following conditions or use the dropdown menu within the Location cells. 

 

Scale Scenario Locations 

Location Temperature (C) Pressue 
(bar) 

Reservoir  125 275 
Bottomhole 125 280 
Downhole 115 190 

Midwell 105 130 
Wellhead 100 100 

Choke 90 80 
Separator 60 30 

The diagram within the Conditions screen and the list of locations in the Summary window both show the 
locations in the order that we entered. This screen has options for zooming, auto steps, sorting by temperature 
or pressure, and dropping solids at specified conditions. 
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The graphical view clearly shows the five locations and their Temperature and Pressure conditions. 

The Drop Solids checkbox column is designed to help the users decide if they want to carry forward solids from 
certain locations or not.  

Solid Tab 

10. Select the Solid Tab 
11. Make sure that the solid button in the menu bar is selected. 

 

12. Select the Standard checkbox 
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13. Press the Calculate button of select the <F9> key 
14. Select the Plot Tab 

You can customize which curves are visible by selecting the Variables button. 

 

15. Select the View Data button 

 

The View Data button shows the pre-scaling tendency at each location. We can copy the results of this table to 
a program like Excel by selecting the top left cell then selecting <Ctrl>+<C> on the keyboard. 
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Task 3 – Create a Gas Analysis 

Double click on the Add Gas Analysis object in the Actions Panel 

 

This adds a Gas object to the Navigator panel. 

Select the Description tab, then rename the object Gas Analysis. 

 

Enter the following composition and values in the Inflows grid: 

Gas Analysis 

Formula Component 
Name 

mole % Formula Component 
Name 

mole % 

H2O Water 1.80 C3H8 Propane 8.00 
N2 Nitrogen 3.00 i-C4H10 Isobutane 1.00 

CO2 Carbon dioxide 1.50 n-C4H10 n-Butane 3.00 
H2S Hydrogen sulfide 0.50 i-C5H12 Isopentane 0.50 
CH4 Methane 65.5 n-C5H12 n-Pentane 0.70 
C2H6 Ethane 14.0 n-C6H14 n-Hexane 0.50 

The Inflows grid will look like one below.. 
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This is the extent of the gas entry step. There are modifications that can be part of the gas analysis entry step 
(in the Reconcile Tab), but in this case, they are not considered. Now that the gas is entered, the scale scenario 
considered in Task-2 will be recomputed.  

 

Task 4 – Recalculate Scale Scenario with Gas 

The gas analysis will be added to the Scale Scenario so that it is considered during the scale evaluation. 

Select the Brine Scale Scenario icon in the navigator panel 

 

Select the Design Tab (horizontal tab) if not automatically sent there 
Select the Inlets tab (vertical) if not automatically sent there 
In the Type Column Add Gas 

 

In the Name column select Gas Analysis 

 

Enter a flowrate of 250 std E3m3/day in the flow cell 



 

think simulation | getting the chemistry right 410 

 

 

Calculate (Press <F9>) 
Select Plot Tab 

 

Select Variables button 
Remove all the variables from the Y1 Axis and the Y2 axis by double-clicking on the variables (this removes 
them from the list). Alternatively, highlight each variable and click on the double-arrow. 

You will replace the existing variables with the calcite pre-scaling tendency. 

Expand the Pre-scaling Tendencies button by clicking the + sign 
Double-click on the CaCO3 (Calcite) variable to move it to the Y1 Axis 
Expand the Additional Stream Parameters and add pH to the Y2 axis 
Click OK 
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If you are in the View Data view, then the table should be similar to the one below. 

 

Calcite is sub-saturated (S<1) at all locations. 

Select the View plot button 

The decreasing calcite saturation trend and the increasing pH is easier to see from the plot view. 

 

Task 5 – Creating a Saturator Object 

You will use the Saturator object to set the reservoir minerals at equilibrium with the produced fluid. It is 
reasonable, in some cases, to saturate the produced fluid with common evaporite and secondary minerals like 
CaCO3, CaSO4.H2O, FeCO3, and NaCl. This assumes that as the reservoir fluid flows through the rock pores, 
there is sufficient time to interact with the surface minerals. This is based on a second assumption that the 
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vertical column of liquid and gas are in complete equilibrium and that the saturating minerals are distributed 
throughout the reservoir matrix, such that complete water-mineral contact is possible.  

In this case we are going to simulate a particular oil & gas well: ABC.  This well produces from calcite-cemented 
sandstone. Barite is also present in minor quantities in the rock matrix. You will, therefore, create a reservoir 
called ABC Reservoir and saturate the Brine (previously calculated) with calcite and barite. You will then 
recalculate the Brine Scale Scenario. 

1) Add a Saturator Object 

 

 

2) Select the Description Tab to rename the Object Reservoir 

 

3) Select the Design Tab 

 

The Saturator has two vertical tabs: Inlets and Solid. 

In the Inlets Tab the Fluids are entered in the top grid and the Conditions are entered in the bottom grid. 

Solids are selected and saturated in the Solid Tab. 
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4) Enter the Brine calculated in Task 1 (see the image below for the flows) 
5) Enter the Gas calculated in Task 3 (see the image below for the flows) 
6) Enter the Reservoir conditions: 125 C and 275 bar in the conditions section. 

 

The Saturator’s calculate button is yellow. This is because solids have not been selected yet. A warning also 
appears in the summary box. A yellow button is allowable, and a calculation may continue; it is merely a warning 
that the case is incomplete. 

7) Select the Solid Tab (vertical tab) 
8) Select the Standard checkbox 

This last step instructs the software to allow the selected solids to precipitate – to include solid-liquid equilibrium 
equation in the calculation. It does not instruct the software to saturate these solids. Rather, if the phase is 
supersaturated, then it will precipitate. It is in the lower section that saturated solids are chosen. 

This section contains two columns. The first (Solid) is the mineral to be saturated, and the second (inflow) is 
the cation and anion to be adjusted. If, for example, Barite is subsaturated in the existing fluid, then Ba+2 and 
SO4-2 are added. The amount of each added is stoichiometrically equivalent; one Ba+2 with one SO4-2, which 
maintains charge balance. If, for example, (again) Calcite is supersaturated, then equal mole amounts of Ca+2 
and CO3-2 will be removed from the fluid. This inflow will be positive if the solid is subsaturated in the existing 
fluid, or it will be negative if the solid is supersaturated. 

9) Use the Solid drop-down menus to select BaSO4 (Barite) and CaCO3 (Calcite) as solids to saturate 
10) Use the Inflow drop-down menu to select BaSO4 and CaCO3 as solids to saturate (it should have been 

selected automatically). 

 

At this point, the Calculate button is green indicating that the specifications are complete. 

11) Calculate (or press the <F9> key) 
12) Click the Report tab 
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The Saturator Report tab contains several tables: Saturation Details, Inlet Summary, Stream/Phase Properties, 
Pre and Post Scaling Tendencies, Brine Composition, Gas Composition, and if selected an inlet summary. 

Scroll down to the Pre and Post Scaling Tendencies Table 

 

The Excess Solute  column shows that trace amounts of BaSO4 and CaCO3 are present in the water. These 
exceedingly small values (in the parts-per-trillion range) are the specifications or targets for the calculation. The 
software sets these target solid concentrations and then adjusts up or down, the BaSO4 and CaCO3 inflows 
until it reaches these targets. These part-per-trillion values may look arbitrary, but in fact the values are 
equivalent to 1e-10 moles of solid/kg water. 

Notice also, that the pre-scale tendency for BaSO4 and CaCO3 are set to 1.0, by saturation definition. That is, 
these are not calculated, they are defined. The remaining scale tendencies are computed. 

Task 6 – Recalculate the Scale Scenario with the Saturated Reservoir 

Considerable time is spent creating what is hoped to be a more representative brine. The Brine is reconciled 
for charge balance, and where needed, alkalinity and pH; the gas is saturated with water as needed (though 
not done in this case), and lastly the fluids are set to equilibrium with important reservoir minerals. It is only after 
these steps are complete, and that there is confidence that the assumptions and calculations are representative 
of the process, that a final scaling calculation is run. 

The Reservoir calculation contains the representative fluid. It is, therefore, the output of this calculation that 
will be used in all subsequent calculations. To access this output, a new Type of fluid, Whole Fluid is defined. 
The Whole Fluid type represents 100% of the contents of a previous calculation, regardless of phase. 

You will use the Whole Fluid from the Reservoir to rerun the scaling calculations. 

Select Brine Scale Scenario in the Navigator Pane and rename it Reservoir Scale Scenario 
Select the Design tab 
In the Inlets tab in the Type column delete the Brine and Gas from the Type column (click the small gray box 
to the left of the name which will highlight the entire row, then press the delete key) 
Add Whole Fluid 
In the Name column select Reservoir 
In the Flow column select <Automatic> 
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Note: The Whole Fluid type refers to all the phases within the fluid. The Automatic option takes the final flow 
rate phase of the separator and automatically enters this as the flow rate in the Scale Scenario calculation. 

Go to the Solid tab and make sure that the Standard box is checked 

 

Calculate (Press <F9>) 
Select Plot tab and select View Plot (note: you may have to delete the existing entry and then reselect the 
dominant pre-scaling tendencies from the variables list) 

 

The Saturator is a tool for normalizing the thermodynamics of a reservoir system. The purpose of this calculation 
is to apply the constraint of solid-liquid equilibrium on a system to create a specific compositional starting point. 
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The basis of this calculation is that water in the pores of a rock matrix is at equilibrium with the mineral surface. 
Some questions to consider are whether it is reasonable to assume that a reservoir gas, oil, water, and rock 
are in equilibrium. Furthermore, we should also consider over what vertical and radial distance we can make 
this claim. 

Regardless of the inconsistencies, the industry widely accepts this approach. It is up to the analyst to decide if 
the Saturator produces a more representative fluid than the original data. 

Task 7 – Add a Contour Diagram 

An alternative to the Scale Scenario calculation is the Contour Diagram. The conditions defined in the Scale 
Scenario are specific to production locations, and generally no more than ten are entered. By comparison, the 
conditions defined in the Contour Diagram are a range of temperatures and pressures. The object then 
computes a matrix of temperature and pressure conditions and creates a presentation-quality contour diagram. 

Add Scale Contour 
Rename the Object Contour Reservoir 

 

Select the Design Tab 
Select the Inlets (vertical) tab 
Select the bottom right corner of the 1st cell in the Inlet grid and choose Whole Fluid 
Select Reservoir in the 2nd column 
Keep the <Automatic> flow rate option in the 3rd column 

 

 

Click Conditions (vertical) tab 

The minimum and maximum conditions are at the Separator 60C, 30 bar and Reservoir 125C, 275 bar. These 
are the start and end range of the study. To create a reasonable number of calculations (~300) and to keep the 
matrix somewhat symmetric, we will use increments of 2 C and 10 bar. 

Change the Start to 60 
Change the End to 125 
Select the Increment radio button 
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Enter 5 as the increment 
Uncheck the Log box (if it is checked) 
In the Pressure Range box, change the Start to 30 
Change the End to 275 
Select the Increment radio button (uncheck the Log box first) 
Change the Increment to 10 

 

This produces a matrix of 13 temperature and 15 pressure steps. This produces a 14x16 matrix, or 224 
calculations. 

 

Select the Solid Tab 
Check the Standard box 
Calculate. The calculation should take less than 5 min to complete 
When calculation is done, go to the Plot tab 
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The default plot is the total solids forming. The color scale represents a different numerical range. The red cells 
indicate heavier solid precipitation, and the faint purple-white in the center and left of the screen indicate that 
little to no scale forms. The upper right corner is the Reservoir conditions (125C and 275 bar). The lower left 
represents Separator conditions (60C and 30 bar). At both points, minimal solids are computed to form. The 
fluid traveling through the piping traverses this plot as temperature and pressure decreases. Layering 
production conditions (e.g., early to late life) over this plot provides an indication as to whether production will 
be at risk now or in the future. For example, if the pressure decline is significant (e.g., 60 bar), then the fluid will 
be unstable at the higher temperatures (bottom of well). 

 

Overview of Brine, Gas and Oils and Introducing Mixer, and Saturator Objects 

Other calculation options include the ability to mix waters at user specified ratios to find compatible waters, and 
the ability to saturate a water with respect to one or more solids to simulate reservoir conditions. 

This chapter will cover the same calculation objects using fewer instructions and will introduce Mixing, Saturator 
and Facility Calculations. Its purpose is to reinforce what was learned in the previous chapter and to promote 
anticipation of next steps when using the interface.  

Task 1 – Add a Brine 

 Add a Brine Analysis from the Action Panel 
 Rename the Brine in the Description Tab, and name it WTXWTR 
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Go to the Design Tab and enter the following composition in the Data Entry (vertical) tab: 

Name:  WTXWTR 
Type of water: Aquifer Water 
Comment: West Texas Water Supply 

Species  Concentration 
Na+  3074 mg/L 
Ca+2  910 mg/L 
Mg+2  249 mg/L 
Fe+2  0.77 mg/L 
Cl-1  4474 mg/L 
SO4

-2  2960 mg/L 
HCO3

-  439 mg/L 
HS-1  146.2 mg/L 

Check the Show non-zero Only box (under Entry Options) 
Go to the Reconcile (vertical) tab 
Select the measured pH and alkalinity Option 
Enter the following conditions (change units if necessary) 

 To change units just click on the hyperlink next to the variable that you want to change. 
  

 

 

Temperature  77 F 
Pressure  14.7 psia 
pH   7.98 
Alkalinity end Point pH 439 mg/L as HCO3- 
Titration pH  4.5 
Density   (will be estimated) 
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Click the Calculate Button 

 

Task 2 – Add a Second Brine 

Add a Brine Analysis, name it SSC-Brine 
Enter the composition given below in the Data Entry (vertical) Tab 
 

 
Go to Reconcile tab 
Select pH and Alkalinity calculation type, and enter the information provided in the figure below. 
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Click the Calculate button 

 

Task 3 – Add a Gas  

From the Actions Panel click on Add Gas Analysis 
Input the name in the Description tab. Name it LightHC 

 

Go to the Design Tab and enter the following composition in the Inflows (vertical) tab 
Enter the following composition: 

Component  Composition 

Carbon dioxide (CO2) 10 mole % 
Water  (H2O)  15 mole % 
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think simulation | getting the chemistry right will assume that all of the hydrocarbon gas is methane (CH4). So, 
in this case the software normalizes the gas adding 75 mole% of CH4.  

Go to the Reconcile (vertical) Tab 

 

Leave the default conditions for Temperature and Pressure 
Calculate 

  



 

think simulation | getting the chemistry right 423 

 

Task 4  – Add an Oil  

From the Actions Panel click Add Oil Analysis. 
Enter the name in the Description Tab. Name it OIL-1 

 

Go to the Design tab 
This tab is divided into:  
Combined Tab: Here pure components (organic and inorganic) are entered. 
Pseudocomponent Tab 
Assay Tab: Here distillation curves are entered. 
Reconcile Tab 

For this example, we will enter pure component and pseudocomponent data. 

Go to the Combined tab 
Enter the following composition: 

Methane (CH4)  20.53mole % 
Hexane (C6H14) 8.595mole % 
CO2   6.09mole % 

Note: You will have to scroll down to find the CO2 entry. 
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Go to the Pseudocomponent tab 

 

Add the following pseudocomponents: 

Name MW 
(g/mol) 

nBP (F) Thermo 
Method 

Value 
mole % 

PC1 98.43 100.21 API 27.57 
PC2 170.34 216.32 API 29.35 
PC3 282.55 343.78 API 7.19 
PC4 506.0 645.00 API 0.68 

The completed input looks like this: 

 

Go to the Reconcile (vertical) tab 
Here you will see how well the pseudocomponent will predict the phase behavior of the hydrocarbon sample.  

In the Condition option (below calculate button) enter T=204 F and P=1 atm. 
Click on the Add boiling point curve (red square shown) 
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A new calculation appears in the navigation panel below OIL1 Object. 

 

This is a survey by Pressure. Click on the specs button and specify the conditions below. Change pressure 
units if necessary. 

 

Enter a pressure range: 

Start  200 psia 
End  2000 psia 
Decrement 100 psia 

Click the Calculate button. 

Click on the plot tab, you will see the following graph: You could adjust the parameters by clicking on curves. 
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If the curve does not meet expectations, you will have to adjust the mole percentages or the pseudocomponent 
properties. This is a manual iterative approach. You can see the actual data by clicking the View data button.  

 

Frequently the hydrocarbon is saturated with water. We will simulate this part. 

Go back to OIL-1 in the Action panel 

 

Click on the Design tab 
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In the Conditions option use T= 77 F and 14.7 psia.  
 

Click on the Calculate button. 

When done, the software will create a Reconciled OIL-1 in the Navigator pane. 

The Brine, Gas and Oil that we already calculated will be used for the upcoming Mixer, Saturator and Facilities 
Calculations.  

Task 5 – Adding a Mixer Calculation 

The Mixer  calculation determines if two waters (brines) can be mixed. Frequently the mixing of two waters will 
cause precipitates to form which were not present in original brines. This can lead to the plugging of a formation 
when an injection water is mixed with the natural fluids in the formation. 

From the Actions Panel, click on the Add Mixing Water logo. 

 

After double clicking the logo, you will the object in the Navigation Panel. 

  

Click on the Design tab to enter more information. 
 

Select your Brines, Gas and Oil s as shown in the figure below. Enter the indicated brine flow rate of 1000 
bbl/day, gas flow of 230 stdMft3/day and oil flow of 7 bbl/day. 
 

Note: To change units on brine, oil and gas, click on the hyperlinked (blue) units inside of the bracket 
next to Inlets First Brine, Second Brine etc. This is under the column heading Type. 
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This should pop the following window up. Click on Inlets tab and change the units. 

Inlets tab looks like below. Changing units on Brine: 

 

 

The final Mixer with inflows entered should look like the image below: 
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Go to the Conditions tab. 
In this example, we are mixing the brines at 100 F and 200 psia. The first brine specified (WTXWTR) is 
the one we compare to when evaluating the ratios. In this case we start out with all brine WTXWTR and 
none of the SSC_Brine and end up with none of brine WTXWTR and all of the SSC_Brine. 
 

Leave the default values 

 

Go to the Solid tab 

For this calculation we are only selecting a few of the possible solids.  Mark a check box next to desired solids 
(BaSO4, CaCO3, CaSO4.2H2O, NaCl). 
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Click on the Calculate button.  

Click on the Plot tab. 

 

 

 

To study the effects better go to the variables button and eliminate other solids precipitated by the << arrow. 
Keep only one solid (in this case BaSO4). The ratio is relative to the first brine specified. This means at a ratio 
of 0.0 (all the first brine and none of the second) we have no BaSO4 scaling. As we add the second brine, the 
amount of BaSO4 increases.  These waters are perhaps incompatible. 
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Task 5 – Adding a Saturator Calculation 

Water and gas samples at the surface are not necessarily representative of conditions in the reservoir. The 
processing of the samples may involve significant changes in the chemistry.  

The Saturate option (often referred to as "Saturate at reservoir conditions") allows the user to "Back-calculate” 
the conditions downhole. 

Select Add Saturator from the Actions Panel. 

 

Rename the object in the descriptions tab. Name it Saturator-1 

 

Go to Design tab 
And go to Inlets (vertical) tab 

We will select objects that we have already defined. 
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Enter a Brine flow of 1000 bbl/day (SSC-brine) 
Enter a Gas flow of 230 std Mft3/day (LightHC) 
Enter T=77 F and P=14.7 psia 

Set these units as custom units for all new objects in Units manager.  
 

 

The window should look like the image below. 

 

Go to Solid (vertical) tab 
Check the Standard box 

We need to select solids inflow to vary for Saturator1. Under the table Select Mineral to saturrate, choose the 
solid to vary from the dropdown list. 

Select BaSO4 (solid) and hit enter. Automatically the inflow to vary BaSO4 will appear. 
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To study the Saturator-1 (Brine and Gas mix) at various locations we need to add a Scaling Scenario object. 

 

Name the new Scale Scenario as Saturator-1 Scale Scenario under the Description tab. 
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Go to the Design Tab 
Under the Inlets (vertical) tab, select Brine under the Type column 
Make sure to select Saturator-1, as is shown in the picture below: 

 

Flow will be automatically controlled. Locations can be input under the Conditions tab. 

Go to Conditions (vertical) tab, and enter the information provided in the 
figure below: 

 

Go to Solid tab and check the Standard box 
Click the Calculate Button 
Go to Plot tab 
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After the calculation is complete, the plot for scale scenario shows that other solids are appearing.  

Go to the Report tab, and look for Pre and Post Scaling Tendencies 
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Introducing the Facilities Object 

This section presents a new calculation object: Facilities. The Facilities is a simplified process simulator; it mixes 
and separates. think simulation | getting the chemistry right has the ability to link together several individual 
calculations to create a flow sheet facility.  An example of a facility calculation is shown in the figure below.  

 

It is a simple process in which two field brines mix in a skim tank. The discharge from this tank then mixes with 
a water supply in a discharge tank.   Below are the compositions and conditions of the inlet fluids. 

Name Field 1  
mg/L 

Field 2 
mg/L 

Water Supply 
mg/L 

Na+ 38209 27078 3074 

Ca+2 6600 4480 910 

Mg+2 1531 1191 249 

Fe+2 120 6.6 0.77 

Cl-1 73150 51134 4474 

SO4-2 2453 1840 2960 

HCO3- 421 677 439 

HS-1 244 146.2 0 

Conditions 

Temperature 100 F 125 F 77 F 

Pressure 100 
psia 

125 
psia 

30 psia 

pH 6.97 7.53 7.98 

Alkalinity (As HCO3 mg/L) 421 677 439 

Alkalinity End Point pH 4.5 4.5 4.5 

Follow the steps below: 

Open a new Window for Simulation 
Create the above brines: Field 1, Field 2 and Water Supply 
Use the Add Brine Analysis object as you have done before to create them. 

The Data Entry Windows should look like this: 
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Reconcile these three brines for measured pH and alkalinity. 
Make sure that the Allow solids to form box is uncheck at the bottom of the reconciliation options for all the 
brines. 

 

Select Add Facilities from the Action Panel. 

 

Go to the Description Tab and rename the object as Facilities-1 
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The facilities calculation is based upon transferring information between calculations through nodes. These 
nodes can be thought of as pseudo brines and gases. These pseudo brines are not stored as individual brine 
rather they are used internally in the calculation. The concentration and flow rates for these nodes can be 
viewed in the output. 

Go to the Design tab 
Go to the Inflow Specs (vertical tab) 

Within Inflow Specs, we can add Nodes via Node input options. There will be one default node added. 

Double click on the node name (where it says: Node 1) and type "Skim Tank".   

 

 

Enter the name, description, conditions, and streams for the Skim Tank shown in the table below:    

 Flow Temperature, F Pressure, psia 
Field 1 11000 bbl/day 100 100 
Field 2 6000 bbl/day 125 125 

Water Supply 3000 bbl/day 77 30 
Skim Tank 5000 bbl/day 110 100 

Suction Tank 5000 bbl/day 90 30 

 



 

think simulation | getting the chemistry right 439 

 

Make sure to select drop solids checkbox at the Skim Tank node. 

When complete, your screen should look like this. 

 

The output of this calculation will go to the next node.  

Next, enter the information for the second node, Suction Tank.  We will select the output brine of the Skim tank, 
which is a brine from node. The temperature and pressure as well as the flow of the brine are calculated.  

Click on the Add button to add a second Node 
Change the name of the node to Suction Tank 
Change the conditions of this node to 90 F and 30 psia. 

When complete your screen should look like the image below: 

 

When a brine is calculated in a facilities calculation, we have the option of allowing any produced solids to be 
considered (that is they traveled along with the brine) or to eliminate them as they precipitate out. We will 
eliminate the solids in this case. The orange downward arrow from Skim Tank indicate dropped solids. 

We are also adding the Water Supply to this tank.  
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In the Type column and first row select Brine from. In the Name column select Skim Tank. The Flow is 
calculated (since it comes from the Skim Tank).  
In the Type column and second row select Brine. In the Name column select Water Supply. Enter 3000 
bbl/day in the Flow column. 

When complete the screen should look like the image below. 

 

Click on the Calculate button, or press <Ctrl+F9> 
Go to the Report tab, and check for the Pre-scaling Tendencies and Scaling Tendencies 
See the Results 

 

Based on these results, it is clear to see that the software predicts the formation of several solids in this process. 
Solids with a Pre-Scaling Tendency > 1 are predicted to form.   
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Chapter VI – Scaling Inhibition 

Introduction 

OLI has developed a rigorous Nucleation and Inhibition tool for mineral scaling formation. The two tools help 
users predict the onset of precipitation in a process environment and also how to delay it.  Both tools are built 
on OLI's fundamental thermodynamic framework and extends these predictions into kinetics using the Classical 
Nucleation Theory [ref]. This theory use the energetics of the solution and the solid to predict the time needed 
for a supersaturated solution to start precipitating. This is the transition time between when a metastable 
solution finally starts to precipitate. The background and details of nucleation is offered by Wikipedia: 
https://en.wikipedia.org/wiki/Classical_nucleation_theory 

What is a mineral scale? 

Mineral scaling occurs when there are changes in process conditions, such as pressure and temperature 
changes, dissolved gases, or when mixing incompatible waters. When scales accumulate in fixed diameter 
volumes, like membrane pores, production tubing, or process piping, flow is restricted. Action is then needed 
to remove the scale and restore flow.  

A scale deposit may occur as single mineral phases, but more commonly, it is a combination of different 
elements. Common scales include CaCO3 (calcite) and BaSO4 (barite) in oil and gas production, CaCO3, 
struvite, Ca3(PO4)2, Mg-Silicates, and silica in water treatment, Jarosite, CaSO4, and CaCO3 (calcite) in mineral 
processing, and additional scale types in other chemical processes. 

Scale deposition involves two distinct steps. The first is the nucleation step, this is the time between when a 
supersaturated water goes from no solids to forming the stable, microscopic crystals. The second is the crystal 
growth step.  In this step, the microscopic crystals grow until the concentration in the water reduces to the point 
where the solution is no longer supersaturated.   

The duration of this nucleation step is known as the “induction time”. It is the time that passes from the creation 
of supersaturated solution to the detection of first solids. This time is critical, because the longer this time can 
be delayed the greater chance that the solids do not form in an area that affects operations.   

Scale formation - how OLI predicts this induction time? 

OLI has developed a state-of-the-art tool that predicts this induction time. This enables users to assess the risk 
of mineral scale forming more accurately in their process. This is a major advancement compared to existing 
technology, in which the scaling tendency value plus empirical rules of thumb are used to assess scale risk in 
a process.  

Figure 2 is a plot showing the output of the new model. The x-axis is the inverse square of the Scale Index.  
The scale index is a base-10, logarithm of the scale tendency.   

𝑆𝐼ିଶ  ൌ  ൫𝑙𝑜𝑔10ሺ𝑆𝑇ሻ൯
ଵ
ଶ 

A lower SI-2 value (left side of the plot) means a higher supersaturation.    

The Y-axis is the time it takes before stable crystals begin to form (in seconds). As the liquid supersaturation 
increases (increasing the driving force for precipitation), the time it takes for the solids to form shrinks.   
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Figure 0-1 - Calculated and experimental gypsum (CaSO4.2H2O) induction times in the CaSO4-NaCl solution at 25, 50, 

70, and 90 °C. Symbols are experimental data, whereas lines represent MSE+CNT model calculations 
 

There are two distinct slopes to the plot, the far-left slope is the Homogeneous nucleation region, while the right 
slope is the heterogeneous region. The homogeneous nucleation region represents a liquid that is highly 
supersaturated, and where little time elapses before solids start precipitating. The heterogeneous region is 
where the liquid is only slightly saturated, and solids only start to form if there is dust or other types of particles 
in the water that makes it easier for the solids to form. Both time regions are important to modeling induction 
time properly, and the OLI database contains the required parameters for these calculations.  

V11.5 Nucleation Induction Time model 

OLI Studio V11.5 is the first delivery of this new technology. We have created a database that will predict the 
induction time for four of the most common scales, calcite (CaCO3), barite (BaSO4), gypsum (CaSO4.2H2O), 
and Celestine (SrSO4). In future releases, the predictions will be extended to other solids. 

Scale Inhibition - how OLI is used to predict treatment? 

Scale inhibitors are a type of chemical that interacts with the nascent crystallites and prevents them from 
becoming stable. They effectively delay the formation of a stable crystal by poisoning its surface. Scale inhibitors 
are an essential part of engineering, because when added to the process water, they delay the formation of 
these crystals, allowing a process to remain free of solids. Scale inhibitors are used in many applications, 
including cooling tower water, as a pre-treatment to RO membranes, and oil and gas production wells. 

Because scale inhibitors represent the key solution to unwanted mineral scaling, OLI created a database that 
predicts this time delay. Thus, an OLI Studio user can now predict a more accurate scale risk analysis for their 
process and simultaneously develop a chemical treatment plan. Six of the most common scale inhibitors are 
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included in the V11.5 software; NTMP/ATMP, DTPMP, HEDP, EDTPMP, PPCSA, and PMA (see footnote for 
chemical names)11.  

Using the Nucleation Model in OLI Studio 

The nucleation model is a post-process to all OLI calculations. Therefore, the only impact on any calculation is 
that a new table will be available in the Report tab, or a new set of categories will be available in the Plots tab.  
When scale inhibitors are added, then its speciation is included in the calculation. Usually the inhibitor 
concentrations are low (in the parts per million) so there will be minimal performance difference. There will be 
the same changes to the report and plot, since the inhibitor speciation will be added to the output, and its effects 
on nucleation will also be shown. 

Performing induction time calculations in V11.5 

The V11.5 release contains nucleation induction times (tind) for four mineral phases; CaCO3 (calcite), BaSO4 
(barite), SrSO4 (celestine), and CaSO4.2H2O (Gypsum). The release also contains inhibition tind for six scale 
inhibitors, HEDP, NTMP/ATMP, DTPMP, EDTMP, PMA, and PBTC. The nucleation model is developed in the 
MSE framework (database) and its prediction range extends across the range of this framework. 

OLI Tag Name Chemical Formula IUPAC Names 

DTPMP C9H28N3O15P5 Diethylenetriamine penta(methylene phosphonic acid) 

HEDP C2H8O7P2 1-hydroxyethane 1,1-diphosphonic acid 

NTMP/ATMP C3H12NO9P3 Nitrilotris(methylenephosphoric acid) 

PMLA C40H40O40 Poly maleic acid 

PBTC C7H11O9P 2-phosphono-butane-1,2,4-tricarboxylic acid 

EDTMP C6H20N2O12P4 Ethylenediamine tetra(methylene phosphonic acid) 

 

 

11  1-hydroxyethylidene-1,1-diphosphonic acid (HEDP), amino tris (methylenephosphonic acid) (NTMP), diethylenetriamine penta 
(methylene phosphonic acid) DTPMP, ethylenediamine tetra (methylene phosphonic acid) (EDTPMP), and polymaleic acid (PMA)  
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Setting up the automatic calculation  

Induction time calculations are activated within the Calculation Options popup window (Figure 0-2). When 
checked, the model sub-routine is included as a post process to the calculation being run. The induction time 
calculation is available for the Single Point and Survey calculation of a Stream, in a Mixer calculation, and in 
the five ScaleChem calculations (Saturator, Scale Scenario, Facilities, Contour, Mixing Waters). 

Start the software.  There should be no streams or calculations in the Navigator panel 

Select Tools>Options>Calculation Options 

Check the Scaling Induction Time(s) box at the bottom of the popup window. Then press OK to close the 

window. 

 

Figure 0-2 - Calculation Options window showing the Scaling Induction Time(s) check box 

Example #1 – Induction times for CaCO3, BaSO4, and SrSO4 in a Stream 

The following stream contains low concentrations of CaCO3, BaSO4, and SrSO4 in a NaCl brine at 25°C.  We 
will use a few single point, isothermal calculations to show how the model works. 

Step #1 – Create a basic induction time calculation 

Add a stream and label it Basic Calculation (MSE model) 

Add the four inflows and mole amounts: CaCO3 – 0.001; BaSO4 – 0.00005; SrSO4 – 0.008; and NaCl – 0.1.  
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Figure 0-3 - New Stream containing low concentrations of CaCO3, BaSO4, and SrSO4 in a 0.1 NaCl electrolyte 
solution. 

Add a single point calculation and label it No Inhibitor 

When the calculation is complete, click on the Report tab. Then click on the Customize button in the upper 

right of the screen. 

Deselect all boxes and then check the Scaling Induction Time box only 

 

Figure 0-4 - The Report's Customize popup window showing where the Scaling Induction Time category is located 

Review the column data in the Scale Induction Time(s) table 
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The three solid phases are supersaturated as shown in the Scaling Tendency column, and their induction times 
vary from 0.4 to 8.7 minutes.  This means that barite will form in about 25 seconds while the other solids will 
take several minutes longer before they start to precipitate.   

Step #2 – Adding scale inhibitors 

Add a new single point calculation and label it With Inhibitor 

You may have noticed already that there are + boxes to the left of CaCO3, BaSO4 and SrSO4. These boxes 
expose a sub grid containing the available scale inhibitors for that specific mineral 

Click on the + sign adjacent to BaSO4 to expose the sub grid. 

Click on the <select to add> box and select the NTMP – C3H12NO9P3 inhibitor. It will now appear at the bottom 

of the grid 

 

Give it an amount of 2e-4 moles (this is about 60 mg/l) and calculate 

Click on the Report tab and once again, turn on only the Induction Time table using the Customize window 

 

The induction time for BaSO4 increased to 1692 minutes, a time that would likely prevent the solid from 
precipitating in the process. The calcite induction time now shows n/a, which means that the compute time 
exceeds the maximum limit of 10,000 hours. Only the SrSO4 induction time remained the same.   
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Return to the Definition tab and select the + adjacent to SrSO4.  Select the HEDP – C2H8O7P2 inhibitor and 

give it a value of 2e-4 (~41 mg/l).  

 

Re-calculate and view the Report table 

 

The SrSO4 induction time has increased to 141 minutes and both barite and calcite no longer have values (n/a).  
The HEDP inhibited both SrSO4 and BaSO4. At these concentrations, the water would now be considered 
inhibited (and possibly overdosed!). 

Step #3 – Using a concentration survey to compute the best inhibitor concentration 

In the previous steps you created a supersaturated solution and then reduced its propensity to precipitate by 
adding a scale inhibitor. The inhibitor concentrations used were not optimized. You will use the survey 
calculation to vary the inhibitor concentration and find a reasonable value. 

Add a Survey calculation and label it Inhibitor survey 

Expand the BaSO4 box and select NTMP - C3H12NO9P3 again 

Change the Survey by from Temperature to Composition 

Open the Specs window, select NTMP as the component 

Set the concentration range to star start at 0, end at 2.5e-4, and have 25 steps  
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Calculate and select the Plot tab 

The scale inhibitor has a significant impact on the pH because NTMP is a hexavalent acid.  This will affect scale 
tendencies for carbonate solids if added in this way.  Right now, we are looking at BaSO4, and so we will ignore 
the impact on calcite 

 

Click the Variables button to open the Curves window  

Remove the pH from the Y1 axis and add the BaSO4 induction time from the Scaling Induction Times category 

 

Set the y-axis to log scale 

The plot now shows the barite induction times as the inhibitor is added. The induction times increase from 1 
minute to 1692 minutes when the concentration increases from 1.3e-4 to 2.0e-4 moles (52 to 80 mg/L).  
Somewhere in this rage would be the optimal inhibitor concentration.   
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You will notice that the plot does not extend to the final concentration of 2.5e-4 NTMP. It is because at this point 
the induction time exceeded the 10,000 hr maximum value. 

Add the Minimum Induction Time variable (located under the Scaling Induction Times category) to the plot  

 

This new plot offers a different perspective to the user’s interpretation. You can now see that the two curves 
diverge at 1.8e-4 moles.  Because this inhibitor concentration barite is the solid phase that is the fastest to 
precipitate.  As more inhibitor is added, barites induction time increases and eventually becomes greater than 
the next solid that forms, which in this case is SrSO4. So, the software is computing that below 1.8e-4 moles 
inhibitor, barite will be the first solid to form.  Above this concentration SrSO4 is the first solid to form. This would 
also mean that a second scale inhibitor should be added to keep SrSO4 from nucleating. 
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Step #4 - Using a temperature survey to test induction times 

Induction times depend on both the scaling tendency of the solid (driving force for precipitation) and the 
temperature (reaction rates).  Therefore, changes to either will result in different induction times for the solid.   

Add a new Survey calculation and label it t_ind vs T  

Set the temperature range from 10 to 100 °C by 5 °C increments, click OK and then and calculate  

Select the Plot tab and plot the induction times for the three solids, CaCO3, BaSO4, and SrSO4 

The plot shows how temperature affects induction times.  At 10 °C, CaCO3 and SrCO3 induction times are at 
18 and 31 minutes, respectively.  At 100 °C, the induction times for the 3 of them are less than 1 minute.   

 

Example #2 – Using induction times in a Mixer calculation 

A common cause of scaling is when two incompatible streams are mixed together. For example, one stream 
containing a high calcium concentration and the other containing high concentrations of carbonate. The 
software will compute the induction times during the time of mixing using the Mixer block. This next example 
shows this. 

1) Add a stream and label it Cations 

2) Add CaCl2 and NaCl to the grid.  Set the values to 0.005 and 0.1 moles, respectively 

 

3) Add a second stream and label it Anions 

4) Add Na2CO3 and NaCl to the grid. Set the values at 0.005 and 0.1 moles, respectively  
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5) Add a Mixer calculation and label it Incompatibility 

6) Move the Cations and Anions streams to the Selected Section 

7) Set the Mixing Method to Ratio 

8) Open the Specs window and select Cations as the Ratio stream. 

9) Under the Survey Range tab set the steps to 20 

 

10) Calculate and go to the Plot tab 

11) Plot the CaCO3 induction times 

The plot shows that induction times are lowest (fastest to form) at a 50:50 mixture and highest at the far ends 
of the plot. In fact, at the 0 and 100% points, no induction times are shown because there is no calcium in the 
0% calculation and no carbonate in the 100% calculation.    

 

Scale inhibitors can also work in the mixer calculation but to do this, the user must create a separate stream 
and add it to the mixer like it would occur in a process. 

12) Create a new stream and label it 0.1 molal NTMP 
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Again, we are disregarding practical units in this example so that we can focus on the procedure of studying 
induction times.   

13) Add NTMP to the grid and give it a value of 0.1 mole 

14) Return to the Incompatibility mixer and add the 0.1 molal NTMP stream to the Selected window 

15) Change the mixing type from Ratio to Volume 

16) Open the Specs window and select the 0.1 molal NTMP as the adjustable stream 

17) Set the start and end to 0 L and 1e-4 L, respectively.  Set the steps to 20. 

 

18) Run the calculation and click on the Plot tab when done 

19) Add the CaCO3 induction time to the plot and click OK 

As NTMP is added to the mixture, the calcite induction time increases from less than one minute to over 1600 
minutes.  Somewhere in this addition would be the optimal treatment value, and that would depend on how long 
the solid needs to remain in solution. For example, 200 minutes is over three hours, a time that would probably 
be enough for a fluid to exit any process unit, like an RO or mixing tank. This would correlate with a 6e-5 L or 
0.060 mL dosage per the two liters of mixed material.   
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An alternative way to plot this would be to use the MBG-Liquid 1 variables. Instead of plotting the volume of the 
NTMP added, you can plot the concentration of NTMP in solution. This concentration would be the minimum 
inhibitor concentration desired, or perhaps the residual concentration that you want to keep in solution. 

20) Open the Variables button and expand the MBG Totals - Liquid 1 category 

21) Move NTMP(-6) to the X-axis 

 

22) Close the Variables window and open the Units Manager ( ) 

23) Click on the Customize button and change the Aqueous Composition from moles to Concentration 

 

24) Close the units manager and review the plot 

According to the calculation, a residual NTMP concentration of about 0.6 mg/l will keep CaCO3 from 
precipitating for 60 minutes.  A concentration of 1 mg/L will inhibit precipitation for about 6 hours (348 minutes).    

 

More Induction time options 

The induction time calculation is a post-process calculation, meaning that it calculates the scale tendencies and 
tind after the system converges to equilibrium. This means that the software will keep the target solids in solution 
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so that it can calculate its supersaturation. Competing solids that remove precipitating ions from the water can 
impact the induction times. For example, BaSO4 is supersaturated, but CaSO4 also precipitates, and in doing 
so, removes sulfate from solution. This sulfate removal affects the final BaSO4 induction time. The software 
must be able to accommodate conditions where such mass actions impact the calculation. It does this in the 
Calculation Options window. 

Click on any of the calculations you created using this chapter 

Select the Specs button and then the Calculation Options tab (or category) 

Click on the Advanced button adjacent to the Scaling Induction Times(s) check box 

 

Expand the S(+6) category in the window 

The text in the upper section of the window explains how the induction times work. It explains that the induction 
times are based on the supersaturation level of the specific solid and that for this solid to be supersaturated, it 
must not precipitate during the induction time calculation. In addition to the target solid, any competing solids 
that might change the concentration in the supersaturation equation (Ba and SO4 if the calculation is for BaSO4) 
also needs to be turned off. Otherwise, the supersaturation of the target solid will be lowered and a less accurate 
induction time value will be computed.    

So, in this case, potential competing solids for BaSO4 include three CaSO4 phases and BaCO3. These are 
turned off by default. There are many other Ba- and SO4-containing solids that can form, and if you see them 
forming in your induction time calculation, you can go to this window and turn them all off. 

    

You may also decide that these competing solid should affect the induction time of your target solid. In that 
case, you turn those solids on. When that happens, reduced concentration of the target solid’s ions will be used 
to compute the induction time.   
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Chapter VII – Naming Conventions in OLI Studio and 
Definitions 

OLI naming conventions are important to understand as they become critical in performing advanced features 
in OLI Studio. The following chapter explains OLI naming conventions, when they’re important, and provides 
key definitions for understanding these conventions.  

Naming the Phases of Species 

Let’s say for example you want to type the following reaction in the OLI reaction kinetics tool:  

2NH3(AQ)+CO2(AQ)=CH4N2O(AQ)+H2O 

Note: You must use the OLI Tag Name for this step, and additionally specify the phase of the reactants and 
products. Water is a special case; it is written only as H2O. 

As a general rule: 

For an aqueous phase: AQ 
For a vapor/gas phase: VAP 
For a solid phase: PPT 
For a hydrated solid: SOLIDNAME.nH2O, where n is the hydration number 
For an ion: ION 

You can find the OLI TAG Name of your specific species using the Component Search Tool. 

In OLI terminology the above reaction will look like:  

2NH3AQ+CO2AQ=UREAAQ+H2O 

Ionic Strength 

Ionic Strength (molal based or m-based) 

The ionic strength is a quantity representing the strength of the electric field in a solution, and it is equal to the 
sum of the molalities of each type of ion present multiplied by the square of their charges, as represented by 
the following equation: 

𝐼 ൌ
1
2
෍ሺ𝑧௜

ଶ𝑚௜ሻ

௡

௜ୀଵ

 

Where n is the number of charged species 

For example, a 1.0 molar solution of NaCl has 1.0 moles of 𝑁𝑎ାions and 1.0 moles of 𝐶𝑙ି ions in 1 kg of H2O. 
Therefore, the ionic strength is 1.0 molal. 

𝐼 ൌ
1
2
൫ሺ𝑧ே௔శሻ

ଶሺ𝑚ே௔శሻ ൅ ሺ𝑧஼௟షሻଶሺ𝑚஼௟షሻ൯ 



 

think simulation | getting the chemistry right 457 

 

𝐼 ൌ
1
2
൫ሺ1ሻଶሺ1ሻ ൅ ሺെ1ሻଶሺ1ሻ൯ ൌ 1 

Now, consider a 1.0 molal solution of CaCl2. This solution has 1.0 mole of 𝐶𝑎ାଶ ions and 2.0 moles of 𝐶𝑙ି ions 
in 1 kg of H2O. Therefore, the ionic strength is 3.0 molar, or it can be said that a 1.0 molal solution of CaCl2 
behaves similar to a 3.0 molar solution of NaCl. 

𝐼 ൌ
1
2
൫ሺ𝑧஼௔శሻ

ଶሺ𝑚஼௔శሻ ൅ ሺ𝑧஼௟షሻଶሺ𝑚஼௟షሻ൯ 
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1
2
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Ionic Strength (mole fraction based or x-based) 

In this case the ionic strength is calculated using the mole fraction rather than the molality: 

𝐼 ൌ
1
2
෍ሺ𝑧௜

ଶ𝑥௜ሻ

௡

௜ୀଵ

 

Where n is the number of charged species. 

 

Material Balance Group (MBG) 

MGB is an abbreviation for Material Balance Groups. The MGB variable is a sum of all the species with the 
same oxidation state. OLI gives this information as Total or for the specific phase requested (Aqueous, Vapor, 
Solid, and Organic) or as absorbed to the surface.  

For example, if we have the following system:  

55.5082 moles of H2O 

1 mol of NaCl 

1 mol of CaCl2 

1 mol of CaCO3 

The distribution of the elements with their respective oxidation states are given as MBG for the total system, 
and for the phases that are predicted to form, as shown in the image below. 
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Volume vs. Volume at Standard Conditions vs. Standard Liquid Volume 

Volume 

This is the volume of the system at a specified temperature, pressure, and composition. 

Volume at Standard Conditions 

It is also known as the Standard Volume. This is the calculated volume of each phase (using the composition 
of each phase) at standard conditions. The standard conditions for each phase: vapor, liquid-1, and liquid-2 are 
predefined in the software, and can be changed. 

The standards conditions are: 

Vapor: Temperature: 15⁰C and Pressure: 1.0023 atm 
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Liquid-1: Temperature: 25⁰C and Pressure: 1 atm 

Liquid-2: Temperature: 15⁰C and Pressure: 1 atm 

 

Standard Liquid Volume 

This is a transport unit. Standard liquid volume is the calculated standard liquid volume based on true species. 
You can see it as the contribution of volume of each true species to the total liquid volume.  

An example 

Standard liquid volume calculation of Liquid-1 phase (MSE), H2O: 55.5082 mole, NaCl: 1 mole, 25oC, 1 atm 
(using OLI Studio 9.5.4). 

Standard liquid volume of material balance group (MBG) (accessible through Databank > literature >Material 
codes > VOLU ). 

MBG name Standard liquid volume of MBG, VOLU (m3) 

H(+1) 1.41E-05 

Na(+1) 1.82E-05 

O(-2) -1.02E-05 

Cl(-1) 1.72E-05 

True species composition after speciation: 

True species (Name) Composition (COMP), mole 

H2O 55.5082 

Cl-1 1 

Na+1 1 

H3O+1 1.33E-07 

OH-1 1.33E-07 

NaOH 5.30E-14 

HCl 2.07E-15 

Standard liquid volume of the phase calculation, considering MBG group contribution in each true species: 

MBG 
Name 

Contribution Contribution 
Value 

H(+1) 1.41E-05×(55.5082×2 + 1.33E-07×3 + 1.33E-07×1 + 5.30E-14×1 + 2.07E-15×1) 1.57E-03 

Na(+1) 1.82E-05× (1×1 + 5.30E-14×1) 1.82E-05 

O(-2) -1.02E-05× (55.5082×1 + 1.33E-07×1 + 1.33E-07×1 + 5.30E-14×1) -5.65E-04 

Cl(-1) 1.72E-05× (1×1 + 2.07E-15×1) 1.72E-05  
Volume (m3) 0.00103827  
Volume (L) 1.03827 

Index 
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Soave Redlich Kwong 
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True Boiling Point 

TBP, 393 

Watson K, 394, 395, 397 

 


